CHAPTER 4: ASSOCIATED MODULES

I. ACCESSION RECORDS ASSOCIATED MODULE

A. Overview

When do I use the Accession Records associated module? ....................................................... 4:1
Where can I find information on accessions? ............................................................................... 4:1
How do I get to my accession records? ........................................................................................ 4:1
How many screens does an accession record have? .................................................................. 4:1
What is the Accession Objects tab? ............................................................................................. 4:1
What is the Multimedia tab used for in Accessions? .................................................................... 4:2
How will I know which data are mandatory?................................................................................. 4:2
How will I know which data are needed to complete the accession forms? ................................. 4:2
What if I have unverified data? ..................................................................................................... 4:2
Do I have to complete every field? ............................................................................................... 4:2
How do I add to or change information on an existing accession record? ................................. 4:2
How do I delete an accession record? ........................................................................................... 4:2
Can I view the catalog records for an accession? ........................................................................ 4:2
Can I edit or add a catalog record from the accession record? ................................................... 4:3
Can I print the list of catalog records associated with the accession record? .............................. 4:3

B. Adding an Accession Record

How do I add an accession record? ............................................................................................. 4:4
How do I move through the record? ............................................................................................. 4:4
How do I cancel a record? ............................................................................................................ 4:4
How do I save a record? ............................................................................................................... 4:5
How do I complete the data fields on the Main Information screen? ........................................... 4:5
How do I complete the data fields on the Extended Information screen? .................................. 4:15

C. Printing the Accession Forms

What forms and reports can I print from the Accession Records associated module? .............. 4:18
How do I print the reports and forms in the Accession Records associated module? ............... 4:18
How do I print the Accession Receiving Report? ........................................................................ 4:19
How do I print the Accession Receiving Report Continuation? .................................................. 4:20
How do I print the Accession Folder Cover Sheet? ..................................................................... 4:20
How do I print the Deed of Gift or Accession Receipt? .............................................................. 4:20
How do I print the Deed of Gift Continuation Sheet? .................................................................. 4:20
How do I print a source of accession record? ............................................................................. 4:21
How do I print an accession list? .................................................................................................. 4:21
How do I print an accession register? ........................................................................................... 4:21
How do I print a Receipt for Property (DI-105)? ......................................................................... 4:21
How do I print an accession worksheet? ..................................................................................... 4:21
How do I print the CMR accession verification reports? ............................................................. 4:22
Is there a report that will print the accession record fields that contain data? ........................ 4:22
II. CONSERVATION ASSOCIATED MODULE

A. Overview .................................................................................................................................... 4:23

When do I use the Conservation associated module? ............................................................... 4:23
Where can I find information on conservation treatment? ...................................................... 4:23
Must I use the Conservation associated module? ................................................................. 4:23
How do I get to the Conservation associated module? ......................................................... 4:23
How many screens does the Conservation associated module have? ................................ 4:23
What are the Images and Multimedia tabs used for in the Conservation associated module? 4:23
Can I access the conservation records from the catalog record screen? ............................. 4:24
What is the easiest way to include pertinent information from a conservator’s report in the Conservation associated module? ............................................................................................. 4:24
What reports can I print from the Conservation associated module? ................................ 4:24

B. Adding a Conservation Record ............................................................................................. 4:24

How do I add a conservation record? .................................................................................... 4:24
How do I move through the record? ....................................................................................... 4:25
How do I cancel a record? ...................................................................................................... 4:25
How do I save a record? ......................................................................................................... 4:25
How do I complete the data fields on the Conservation Information screen? .................... 4:26
How do I complete the data fields on the Extended Information screen? .......................... 4:29

III. EXHIBITS ASSOCIATED MODULE

A. Overview .................................................................................................................................... 4:31

When do I use the Exhibits associate module? .......................................................................... 4:31
Where can I find information on exhibits? ................................................................................ 4:31
Must I use the Exhibits associated module? ........................................................................... 4:31
How do I get to the Exhibits associated module? .................................................................... 4:31
How can I view an exhibit record attached to a catalog record? ................................................ 4:31
How many screens does the Exhibits associated module have? .............................................. 4:32
What is the Items on Exhibit tab? ............................................................................................ 4:32
What are the Images and Multimedia tabs used for in the Exhibits associated module? .......... 4:32
How do I add to or change information on an exhibit record? .................................................. 4:32
Does the program update the Object Status or Location field on the catalog record for exhibits? .................................................................................................................................................... 4:32

B. Adding an Exhibit Record ....................................................................................................... 4:33

How do I add an exhibit record? ............................................................................................ 4:33
How do I move through the record? ....................................................................................... 4:33
How do I cancel a record? ...................................................................................................... 4:33
How do I save a record? ......................................................................................................... 4:33
How do I delete an exhibit record? .......................................................................................... 4:34
How do I complete the data fields on the Main Information screen? .................................... 4:34
How do I complete the data fields on the Extended Information screen? .......................... 4:37
How do I complete the fields on the Items on Exhibit tab? .................................................. 4:39
Can I attach catalog records from the Items on Exhibit tab of the Exhibit record? .......... 4:40
How do I add, modify or delete objects on the Items on Exhibit tab? ........................................ 4:40
Can I print the list of catalog records on the Items on Exhibit tab? ....................................... 4:42
C. Exhibits Reports ....................................................................................................................... 4:43

What reports can I print from the Exhibits associated module? ................................................. 4:43
How do I print the report? ........................................................................................................... 4:43

IV. LOANS OUT ASSOCIATED MODULE

A. Overview .................................................................................................................................... 4:44

When do I use the Loans Out associated module? .................................................................... 4:44
Where can I find information on outgoing loans? ....................................................................... 4:44
Must I use the Loans Out associated module? .......................................................................... 4:44
How do I get to the Loans Out associated module? ................................................................... 4:44
How can I view the loan record attached to a catalog record?................................................... 4:44
How many screens does the Loans Out associated module have? .......................................... 4:45
What is the Items on Loan tab? .................................................................................................. 4:45
What are the Images and Multimedia tabs used for in the Loans Out associated module? ...... 4:45
How will I know which data are needed to complete the outgoing loan forms? ......................... 4:45
How do I add to or change information on an existing loan record? .......................................... 4:45
Does the program update the Object Status field on the catalog record for outgoing loans? .... 4:46

B. Adding an Outgoing Loan Record .......................................................................................... 4:46

How do I add an outgoing loan record?...................................................................................... 4:46
How do I move through the record? ........................................................................................... 4:46
How do I cancel a record? .......................................................................................................... 4:46
How do I save a record? ............................................................................................................. 4:47
How do I delete an outgoing loan record? .................................................................................. 4:47
How do I complete the data fields on the Main Information screen? ......................................... 4:47
How do I complete the data fields on the Extended Information screen? ................................. 4:54
How do I complete the fields on the Items on Loan tab? ........................................................... 4:56
Can I attach catalog records from the Items on Loan tab of the loan record? ........................... 4:57
How do I manually add, modify, or delete objects on the Items on Loan tab? ........................... 4:57
Can I print the list of catalog records on the Items on Loan tab? .............................................. 4:60

C. Printing the Outgoing Loan Forms ......................................................................................... 4:61

What forms and reports can I print from the Loans Out associated module? ............................ 4:61
How do I complete the NPS or DOI Unit section of the forms? .................................................. 4:62
How do I print the reports and forms from the Loans Out associated module? ...................... 4:62
How do I print the Outgoing Loan Agreement? ........................................................................ 4:63
How do I print the Conditions for Outgoing Loans (Form 10-127a) to attach to the outgoing loan agreement? .................................................. 4:63
How do I print the Outgoing Loan Extension? ......................................................................... 4:63
How do I print the Outgoing Loan Folder Cover Sheet? ......................................................... 4:64
How do I print the Object Condition Report to attach to the outgoing loan agreement? .......... 4:64
How do I print the List of Objects to attach to the outgoing loan agreement? .......................... 4:65
How do I print a report of the objects in the loan? .................................................................... 4:65
How do I print the Notice of Potential Hazard in Museum Collections? .................................. 4:65
How do I print a report of loan costs? ......................................................................................... 4:65

V. LOANS IN ASSOCIATED MODULE

A. Overview .................................................................................................................................... 4:67

When do I use the Loans In associated module? ...................................................................... 4:67
Where can I find information on incoming loans? ................................................................. 4:67
Must I use the Loans In associated module? ........................................................................ 4:67
How do I add an incoming loan record? ............................................................................. 4:69
How do I move through the record? .................................................................................. 4:69
How do I cancel a record? ............................................................................. 4:69
How do I save a record? ................................................................................................. 4:70
How do I delete an incoming loan record? ........................................................................ 4:70
How do I complete the data fields on the Main Information screen? ................................. 4:70
How do I complete the data fields on the Extended Information screen? ............................ 4:78
Can the information from the Loans In record be used to create the Accession record? .... 4:80
How do I complete the fields on the Items on Loan tab? ..................................................... 4:80
Can I attach catalog records from the Items on Loan tab of the loan record? .................... 4:81
How do I manually add, modify, or delete objects on the Items on Loan tab? ..................... 4:81
Can I print the list of catalog records on the Items on Loan tab? ..................................... 4:84

C. Printing the Incoming Loan Forms .................................................................................. 4:84
What forms and reports can I print from the Loans In associated module? ....................... 4:84
How do I complete the NPS or DOI Unit section of the forms? ........................................ 4:85
How do I print the reports and forms from the Loans In associated module? ..................... 4:85
How do I print the Incoming Loan Agreement? ................................................................ 4:86
How do I print the Conditions for Incoming Loans (Form 10-127a) to attach to the incoming loan agreement? ................................................................. 4:87
How do I print the Accession Receiving Report Continuation sheet (Form 10-95c)? .......... 4:87
How do I print the Object Condition Report (Form 10-637) to attach to the incoming loan agreement? ................................................................. 4:88
How do I print the List of Objects to attach to the incoming loan agreement? ........................ 4:88
How do I print the Incoming Loan Extension? ................................................................. 4:88
How do I print a report of the objects in the loan that have been cataloged? ......................... 4:89

VI. MAINTENANCE ASSOCIATED MODULE

A. Overview ................................................................................................................. 4:90
When do I use the Maintenance associated module? ............................................................ 4:90
Where can I find information on routine maintenance and MHP task sheets and schedules? 4:90
Must I use the Maintenance associated module? ............................................................ 4:90
How do I get to the Maintenance associated module? ........................................................ 4:90
How many screens does the Maintenance associated module have? ................................. 4:90
What are the Images and Multimedia tabs used for in the Maintenance associated module? .. 4:91
How do I add to or change information on an existing maintenance record? ....................... 4:91
Can I access the maintenance records from the catalog record screen? .............................. 4:91
How will I know which data are needed to complete task sheets and tracking schedules? ... 4:91

B. Adding a Maintenance Record .............................................................................. 4:91
How do I add a maintenance record? ............................................................................. 4:91
How do I move through the record? .......................................................... 4:92
How do I cancel a record? ........................................................................... 4:92
How do I save a record? ............................................................................. 4:92
How do I complete the data fields on the Maintenance Information screen? ..... 4:92
How do I complete the data fields on the Extended Information screen? .......... 4:96

C. Printing Task Sheets and Schedules ......................................................... 4:98
What reports can I print from the Maintenance associated module? .............. 4:98
How do I print the reports from the Maintenance associated module? ............. 4:98
How do I print a MHP task sheet? ............................................................... 4:99
How do I get the unit name to print on the report? ........................................ 4:100
How do I print a monthly schedule of daily maintenance tasks assigned to a staff member? .......................................................... 4:100
How do I print a quarterly schedule of weekly maintenance tasks assigned to a staff member? ......................................................... 4:100
How do I print a 3-year schedule of quarterly maintenance tasks assigned to a staff member? ........................................................ 4:100
How do I print a schedule of daily maintenance tasks by location? ..................... 4:101

VII. PREPARATION/TREATMENT ASSOCIATED MODULE
A. Overview ................................................................................................. 4:103
When do I use the Preparation/Treatment associated module? ....................... 4:103
Where can I find information on preparation and treatment of natural history specimens? ...... 4:103
Must I use the Preparation/Treatment associated module? ............................ 4:103
How do I get to the Preparation/Treatment associated module? ..................... 4:103
How many screens does the Preparation/Treatment associated module have? .......... 4:103
What are the Images and Multimedia tabs used for in the Preparation/Treatment associated module? .................................................. 4:104
How do I add to or change information on an existing preparation/treatment record? .................. 4:104
Can I access the preparation/treatment records from the catalog record screen? ........ 4:104
What reports can I print from the Preparation/Treatment associated module? ........ 4:104
How will I know which data will map to the natural history labels? ................. 4:104

B. Adding a Preparation/Treatment Record ............................................... 4:105
How do I add a preparation/treatment record? ................................................ 4:105
How do I move through the record? ............................................................. 4:105
How do I cancel a record? .......................................................................... 4:105
How do I save a record? ............................................................................ 4:106
How do I complete the data fields on the Preparation/Treatment Main Information screen? .. 4:106
How do I complete the data fields on the Extended Information screen? .......... 4:110

VIII. DEACCESSIONS ASSOCIATED MODULE
A. Overview ............................................................................................. 4:112
When do I use the Deaccessions associated module? ...................................... 4:112
Where can I find information on deaccessioning? ......................................... 4:112
Must I use the Deaccessions associated module? ......................................... 4:112
How do I get to the Deaccessions associated module? ................................. 4:112
How can I view the deaccession record attached to a catalog record? ............... 4:112
How many screens does the Deaccessions associated module have? ............... 4:113
What is the Deaccession items tab? .............................................................. 4:113
What is the Multimedia tab used for in the Deaccessions associated module? ......... 4:113
IX. RESTRICTIONS ASSOCIATED MODULE

A. Overview ........................................................................................................................................ 4:136
   When do I use the Restrictions associated module? ................................................................. 4:136
   Where can I find information on restrictions? ............................................................................... 4:136
   Must I use the Restrictions associated module? ........................................................................ 4:136
   How do I get to the Restrictions associated module? ............................................................... 4:136
   How can I view the restriction record attached to a catalog record? ........................................ 4:136
   How many screens does the Restrictions associated module have? ....................................... 4:137
   What is the Restriction Items tab? ............................................................................................... 4:137
   What is the Multimedia tab used for in the Restrictions associated module? .......................... 4:137
   How do I add to or change information on an existing restriction record? .............................. 4:137
   What reports can I print from the Restrictions associated module? .......................................... 4:138

B. Adding a Deaccession Record ....................................................................................................... 4:114
   How do I add a deaccession record? ............................................................................................ 4:114
   How do I move through the record? .......................................................................................... 4:114
   How do I cancel a record? ........................................................................................................... 4:115
   How do I save a record? ............................................................................................................. 4:115
   How do I delete a deaccession record? ........................................................................................ 4:115
   How do I complete the Main Information screen? ..................................................................... 4:115
   How do I complete the data fields on the Extended Information screen? ............................... 4:122
   How do I complete the fields on the Deaccession Items tab? .................................................... 4:123
   Can I attach catalog records from the Deaccession Items tab of the deaccession record? ........ 4:124
   How do I manually add, modify, or delete objects on the Deaccession Items tab? .................... 4:124
   Can I print the list of catalog records on the Restriction Items tab? ......................................... 4:126

C. Approving or Disapproving a Deaccession Record .................................................................... 4:127
   When do I use Approve? .............................................................................................................. 4:127
   When do I use Disapprove? ......................................................................................................... 4:128
   When do I use Copy with Items? .................................................................................................. 4:129

D. Printing the Deaccession Forms .................................................................................................. 4:130
   What forms and reports can I print from the Deaccessions associated module? ..................... 4:130
   How do I complete the NPS or DOI Unit section of the forms? ................................................. 4:130
   How do I print the reports and forms from the Deaccessions associated module? ................. 4:131
   How do I print the Deaccession Form? ...................................................................................... 4:131
   How do I print the Deaccession Folder Cover Sheet? ................................................................. 4:132
   How do I print the Deaccession Log? .......................................................................................... 4:132
   How do I print the Exchange Agreement? .................................................................................. 4:132
   How do I print the Repatriation Agreement? ............................................................................. 4:133
   How do I print the Notice of Potential Hazard in Museum Collections? .................................... 4:133
   How do I print the Conveyance Agreement? .............................................................................. 4:133
   How do I print the Transfer of Property (Form DI-104)? ............................................................ 4:134
   How do I print a Specialist Review Form? .................................................................................. 4:134
   How do I print the List of Objects to attach to the Deaccession Form? ....................................... 4:134
   How do I print the Receipt for Property (Form DI-105)? ............................................................ 4:134
B. Adding a Restrictions Record ............................................................................................... 4:138

How do I add a restriction record? ....................................................................................... 4:138
How do I move through the record? ....................................................................................... 4:138
How do I cancel a record? ....................................................................................................... 4:138
How do I save a record? .......................................................................................................... 4:139
How do I delete a restriction record? .................................................................................... 4:139
How do I complete the Main Information screen? ............................................................... 4:139
How do I complete the data fields on the Extended Information screen? ......................... 4:141

C. Attaching Catalog Records to Restrictions ......................................................................... 4:141

How do I attach catalog records to a restriction record in the Restrictions associated module? ...
Can I attach catalog records from the Restriction Items tab of the restriction record? ............ 4:142
How do I manually add, modify, or delete objects on the Restriction Items tab? ..................... 4:142
Can I print the list of catalog records on the Restriction Items tab? ......................................... 4:144
What restriction information prints on the catalog record? ....................................................... 4:144

X. LOCALITY ASSOCIATED MODULE

A. Overview .................................................................................................................................. 4:145

When do I use the Locality associated module? ...................................................................... 4:145
Must I use the Locality associated module? ............................................................................. 4:145
How do I get to the Locality associated module? ..................................................................... 4:145
How can I view the locality record from a Natural History catalog record? .............................. 4:145
How many screens does the Locality associated module have? ............................................. 4:146
What are the Images and Multimedia tabs used for in the Locality associated module? ........ 4:146
How do I add to or change information on an existing locality record? .................................... 4:146
What reports can I print from the Locality associated module? ............................................. 4:146

B. Adding a Locality Record ...................................................................................................... 4:147

How do I add a locality record? ................................................................................................ 4:147
How do I move through the record? ......................................................................................... 4:147
How do I cancel a record? ........................................................................................................ 4:148
How do I save a record? .......................................................................................................... 4:148
How do I delete a locality record? ............................................................................................ 4:148
How do I complete the data fields on the Main Information screen? ....................................... 4:148

XI. ARTIST/MAKER/EMINENT FIGURE ASSOCIATED MODULE

A. Overview .................................................................................................................................. 4:152

When do I use the Artist/Maker/Eminent Figure associated module? ..................................... 4:152
Must I use the Artist/Maker/Eminent Figure associated module? ............................................ 4:152
How do I get to the Artist/Maker/Eminent Figure associated module? .................................... 4:152
How can I view the Artist/Maker/Eminent Figure record from a catalog record? .................... 4:153
How many screens does the Artist/Maker/Eminent Figure associated module have? .............. 4:153
How do I add to or change information on an existing Artist/Maker/Eminent Figure record? .. 4:153
What reports can I print from the Artist/Maker/Eminent Figure associated module? .......... 4:154

B. Adding an Artist/Maker/Eminent Figure Record ................................................................. 4:154

How do I add an Artist/Maker/Eminent Figure record? ............................................................ 4:154
How do I move through the record? .......................................................................................... 4:155
XII. NAMES AND ADDRESSES ASSOCIATED MODULE

A. Overview ............................................................................................................................... 4:160

How do I cancel a record? ........................................................................................................ 4:155
How do I save a record? ............................................................................................................ 4:155
How do I delete an Artist/Maker/Eminent Figure record? ......................................................... 4:156
How do I complete the data fields on the Main Information screen? ....................................... 4:156
How do I complete the fields on the Extended Information screen? ........................................ 4:158
How do I add the Artist/ Maker/Eminent Figure entry to the catalog record? ........................... 4:159

B. Adding a Name and Address Record ................................................................................... 4:163

How do I add a Name and Address record? ............................................................................ 4:163
How do I move through the record? ......................................................................................... 4:164
How do I cancel a record? ........................................................................................................ 4:164
How do I save a record? ............................................................................................................ 4:164
How do I delete a Names and Addresses record? ................................................................... 4:164
How do I complete the data fields on the Contact Information screen? ................................... 4:165
What is the Log Address link? .................................................................................................. 4:167
How do I complete the fields on the Extended Information screen? ........................................ 4:169

C. Printing Access and Use Forms ........................................................................................... 4:172

What forms can I print from the Names and Addresses associated module? ......................... 4:172
How do I print the forms from the Names and Addresses associated module? ....................... 4:172
How do I print the Duplication Form? ....................................................................................... 4:173
How do I print the Researcher Registration Form? .................................................................... 4:173
How do I print the Copyright and Privacy Notice? .................................................................... 4:173
How do I print the Notice of Potential Hazard in Museum Collections? ................................. 4:174
How do I print the Collection or Archival Use Record? ............................................................ 4:174
How do I print the Visitor Log? ................................................................................................ 4:174
How do I print the Visitor Log Conditions? ............................................................................... 4:174
How do I print BOR contact information forms? ....................................................................... 4:175
Can I print mailing labels from the Names and Addresses associated module? ....................... 4:175

XIII. NAGPRA ASSOCIATED MODULE

A. Overview ..................................................................................................................................... 176

What is the NAGPRA associated module? ............................................................................... 176
When do I use the NAGPRA associated module? ..................................................................... 176
Will running the NAGPRA associated module change any of my catalog or accession data? ... 176
Do I need special security rights to run the NAGPRA associated module? ............................. 176
Can I run the NAGPRA associated module for more than one unit? .......................................................... 176
Must I create a NAGPRA associated module record? .................................................................................. 176
How do I get to the NAGPRA associated module? .................................................................................... 177
How many screens does a NAGPRA record have? .................................................................................... 177
What is the Supplemental Information tab? .................................................................................................. 177
How do I add to or change information on an existing NAGPRA record? .................................................. 177
Can I view the deaccession records related to the NAGPRA record? ......................................................... 178

B. Adding a NAGPRA Record .......................................................................................................................... 178
How do I add a NAGPRA record? .................................................................................................................. 178
How do I move through the record? .................................................................................................................. 178
How do I cancel a record? ................................................................................................................................. 179
How do I save a record? .................................................................................................................................. 179
How do I delete a record? .................................................................................................................................. 179
How do I complete the data fields on the Main Information screen? .............................................................. 179
How do I complete the data fields on the Extended Information screen? ....................................................... 182
How do I access the Supplemental Information tab? ...................................................................................... 182
How do I complete the fields for the Administrative Action supplemental? .................................................. 183
How do I complete the fields for the Evidence supplemental? ....................................................................... 184
How do I complete the fields for the Objects supplemental? ........................................................................ 184
How do I associate an object with a human remains catalog record? .............................................................. 185

C. Printing NAGPRA Inventory Reports ........................................................................................................ 188
What reports can I print from the NAGPRA associated module? ................................................................. 188
How do I print the reports? ............................................................................................................................... 188

D. Submitting Updated Inventories .................................................................................................................. 189
Do I have to print an inventory? ....................................................................................................................... 189
Do I have to submit the inventory electronically? ............................................................................................. 189
How do I create an electronic copy of the inventory for submission? ............................................................. 189
I. ACCESSION RECORDS ASSOCIATED MODULE

A. Overview

1. When do I use the Accession Records associated module?
   Use the Accession Records associated module to document and track accessions and print accession forms.

   **You must complete an accession record for each accession in the collection.**

2. Where can I find information on accessions?
   Refer to the *Museum Handbook*, Part II (MH-II), Chapter 2, Accessioning, or the *Museum Property Handbook*, Volume II (MPH-II), Chapter 2, Accessioning, for general information and procedures for documenting an accession. Refer to your site-specific cataloging procedures, if available.

3. How do I get to my accession records?
   To go to your accession records:
   - from the Home page, select your Cultural Resources or Natural History directory by double-clicking, then double-click Accessions, or
   - from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Accessions, or
   - from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Accessions.

   You can also access the accession record for each catalog record if you click on the accession link on the catalog record screen.

4. How many screens does an accession record have?
   The accession record consists of 4 screens:
   - Accession information (for basic accession data)
   - Extended information (for additional data)
   - Accession Objects
   - Multimedia

5. What is the Accession Objects tab?
   The Accession Objects tab lists all of the objects for the accession cataloged in the current directory. The program links the accession record to the object record via the accession number field on both screens.
Note: This list does not show catalog records from more than one directory. If an accession contains both cultural resources and natural history objects, you will have to go to the other directory to view the associated objects from that directory.

6. **What is the Multimedia tab used for in Accessions?**

The Multimedia tab allows you to attach media files such as video and sound clips, documents, spreadsheets, PDF files, etc.

Refer to Appendix G in this manual for information on Multimedia.

7. **How will I know which data are mandatory?**

The instructions in this manual and the on-line field help will indicate which fields are mandatory. The program will not allow you to save an accession record if you do not have data in the mandatory fields.

8. **How will I know which data are needed to complete the accession forms?**

The instructions in this manual and the on-line field help will indicate which fields are needed to complete the accession receiving report, deed of gift, and source of accession.

9. **What if I have unverified data?**

It is important to distinguish between unverified data and documented fact. Use a question mark “?” or “(att)” for attributed, to indicate data that are probable but not certain.

10. **Do I have to complete every field?**

Not every accession will be sufficiently documented to allow completion of all fields. If information is not known, leave the field blank. You may want to insert “UNKNOWN” into user-built tables to indicate that there is no available information.

11. **How do I add to or change information on an existing accession record?**

From the accession screen:

- click on the modify icon on the button bar, or

- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or

- press the F10 key

The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

12. **How do I delete an accession record?**

From the accession record screen:

- Go to Edit on the menu bar and then to Delete Record(s), choose Delete This Record.

- Choose “Yes” when the program asks you if you’re sure you want to delete the record.

The system will delete the record from the database.

13. **Can I view the catalog records for an accession?**

Yes. Click on the Accession Objects tab on the accession record. Or press Ctrl-N until the Accession Objects tab is selected. All cataloged records from the current directory that are associated with the current accession will appear in the list. Select a catalog record and click View or click the link icon next to the catalog number. The catalog record will open in a separate window in View Mode.
14. Can I edit or add a catalog record from the accession record?

Yes, you can modify and add catalog records while on the accession record.

To modify a catalog record, on the Accession Objects tab for the accession, select a catalog record from the current directory and click Edit. The selected catalog record will open in a new window in Modify Mode. Click Save and Close when done.

To add a new catalog record, click Add from the Accession Objects tab. A new catalog record window will open in Add Mode for you to enter a new catalog record. Click Save and Close when done. This will add the record to the current directory. The record will then appear in the Accession Objects list.

Note: You can also delete catalog records. Select the catalog record and click Delete. This deletes the entire record from the directory, not just the accession list.

15. Can I print the list of catalog records associated with the accession record?

Yes, you can print the list of catalog records that appear on the Accession Objects tab.

To print the list of catalog records, click Print on the Accession Objects tab. A print preview window will open.
To print the report, choose Print on the File menu, or click one of the print buttons on the button bar. You can also export or email this document using the options on the File menu or button bar.

B. Adding an Accession Record

1. How do I add an accession record?

   From the accession record screen:
   - click on the add icon on the button bar, or
   - go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
   - press the F9 key

   A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

2. How do I move through the record?

   Within the Field
   Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

   Field to Field
   Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

   Page to Page
   Click on the Extended Information tab or press Ctrl-N.

3. How do I cancel a record?

   To cancel the record without saving the data:
   - click the Cancel link on the bottom right of the screen, or
   - click the Cancel button on the button bar, or
4. How do I save a record?

To save the entire record:

- go to File on the menu bar and select ✖ Cancel

- click the Save and Close link at the bottom right of the screen, or

- click the Save and Close icon on the button bar, or

- go to File on the menu bar and select ☐ Save and Close

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

If you have not entered data in all the mandatory fields, the program will prompt you to enter the data.

Click OK and you will be returned to the accession record to complete the fields. The mandatory fields without data will be indicated by the ☐ icon at the beginning of the field. Either complete the information in these fields or cancel the record until you can complete all mandatory fields before saving. Partial records will not be saved.

After saving the data, the program will close the window and return to the Record Pane.

5. How do I complete the data fields on the Main Information screen?

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press the Tab key to move out of a field.

**Note:** Fields marked with a ! are mandatory fields. You must complete these fields to save the record.

**Accession Number** (Accession #)

For NPS, this is a 3-part 10-character field. For DOI, this is a regular, unedited, 60-character field. This field maps to the accession receiving report, the deed of gift, and the source of accession. **To save the record, you must complete this field.**

**NPS Accession Number format:**

| Accession # | PARK | - | 00000 |

Enter the number for the accession using the NPS format.

a. The first part is the four-letter park acronym, in the form of “AAAA.”  
   (Note: The acronym will autofill from the record you were viewing when you began to Add a new record)

b. The second part is a hyphen, which distinguishes the accession number from the catalog number.  
   (Note: The hyphen will also autofill from the previous record.)
If the park has different units with separate accession and catalog systems, enter a collection designation in the form of a letter, for example, A, B, C, in place of the hyphen. Only a few parks will use a collection designation.

The Chief Curator must approve the designation. Review requests to use a designation with the regional curator. Send requests in writing to the Chief Curator, WASO.

c. The third part is the 5-digit identification number assigned to an accession, for example, 99999. The program automatically pads the number with zeroes.

Example: YOSE-00021
JELAB00272 [The Jean Lafitte NHP accession number contains a B as a designation for the Barataria collection.]

DOI Accession Number format:

```
| Accession # |
```

Enter the number for the accession using a standard format. The first part of the accession number should be your unit acronym.

Example: BLM 1989.05

```
To use the Get function with the NPS accession number format, you must enter the acronym, include the dash, and pad the number with zeroes.
```

<table>
<thead>
<tr>
<th>Acquisition Type (Acq Type)</th>
</tr>
</thead>
</table>

Bureau controlled table (F5). This field maps to the accession receiving report. To save the record, you must complete this field. You may not add to, delete, or modify terms in this table.

Enter the type of accession. The accession type refers to how the unit acquired the objects. Choose one of the terms from the table:

- Exchange
- Field Collection
- Gift
- Incoming Loan
- Purchase
- Transfer from DOI
- Transfer from NPS
- Transfer from Other Federal Agency

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Note: For purchases, enter the cost in the Acquisition Cost field on this screen.

<table>
<thead>
<tr>
<th>Acquisition Date (Acq Date)</th>
</tr>
</thead>
</table>

Flexible date field. To save the record, you must complete this field.

Enter the date that the object was acquired. This is the date that the unit legally acquired the object. It should be the same date you entered into the accession book. Enter a two-digit month, a two-digit day, and the full year. A zero precedes single digits.
Example: 02/09/2014

If you do not have a full date for past accessions, enter the known or partial date (such as May 1980) or press F12 or click the calendar icon to open the flexible date entry screen. The flexible date entry allows you to enter a beginning and ending date by century or year, month, and day. It includes a user-built table of modifiers, for entries such as "circa." Refer to Chapter 1, System Basics, for additional instructions on flexible date fields. Use of the flexible date screen is optional.

Note: For gifts, enter the date that you have scheduled for the Deed of Gift to be signed. If the Deed of Gift is signed on a different date, correct the date in the program.

For NPS, accessions made after 1985 should have a full date (day, month, and year).

**Field Collection Type**

Bureau controlled authority table (F5). You may not add to, delete, or modify terms in this table.

Active only when Acq Type (Acquisition Type) is FIELD COLLECTN (Field Collection). After entering FIELD COLLECTN in Acq Type and tabbing out of that field, Field Collection Type will be active.

For Field Collections, enter the type of field collection. As you type, the program will autofill the term from the table. Press F5 to select from the table. To choose an entry from the table, highlight the entry and press Enter. Choose one of the terms from the table:

**ARPA Investigation:** Objects resulting from an Archaeological Resources Protection Act (ARPA) investigation and determined to be worthy of inclusion in the unit's museum collection.

**Found in Collection:** Objects discovered in or nearby the collection without documentation. For example, an object is found in the collection storage area during an inventory and is identified to be a museum object, but it has no label or catalog record.

**Manufactured By or For the Unit:** Objects manufactured on-site for inclusion in the unit museum collection by unit staff or a volunteer. For example, an object, such as a piece of artwork, is made during a cultural demonstration.

**Newly Identified:** Bureau/office personal property identified as appropriate for inclusion in the museum collection when an object is discovered in an obscure place within a bureau/office unit, or the significance of an object has changed over time and is suitable to be designated as museum property. For example, a signed photo of FDR and several CCC boys was on the wall in the maintenance office for 75 years and thought to be a reproduction. It was discovered to be an original when it was taken down to be reframed. The photo wasn't "Found in Collection" since many knew about it for 75 years, although it was "newly identified" as museum property.

**Permitted Activity:** Objects resulting from planned and authorized surveys, excavations, or other activities primarily on Federal lands or in Federal waters by bureau/office staff or by non-bureau permittees.
Unauthorized Collection: Objects resulting from collecting that is not authorized by Federal statute, Departmental or bureau policy, or permit on Federal lands or in Federal waters by an unauthorized person, such as a visitor.

**Acquisition Cost (Acq Cost)**  
Numeric field.  
Enter the purchase price for items that have been purchased with bureau funds. The field includes two decimal places.

**Catalog Status**  
Bureau controlled table (F5). You may not add to, delete, or modify terms in this table.  
Enter the cataloging status of the accession. The cataloging status indicates how much of the accession has been cataloged or whether the accession has been deaccessioned. The Automated Inventory Program uses this information in the accessions inventory. Choose one of the terms from the table:  
- Deaccessioned  
- Fully Cataloged  
- Not Cataloged  
- Partially Cataloged (Part. Cataloged)

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

**Note:** The program doesn’t automatically update this field as you catalog the accession. Modify the data in this field as needed.

**Date Received**  
Flexible date field (F12) (not available in NPS directories). To save the record, you must complete this field.  
Enter the date that the object or collection was received. Enter a two-digit month, a two-digit day, and the full year. A zero precedes single digits.  
Example: 02/03/2014  
If you do not have a full date, enter the known or partial date (such as May 1980) or press F12 or click the calendar icon to open the flexible date entry screen. The flexible date entry allows you to enter a beginning and ending date by century or year, month, and day. It includes a user-built table of modifiers, for entries such as "circa." Refer to Chapter 1, System Basics, for additional instructions on flexible date fields. Use of the flexible date screen is optional.

**Location**  
Memo field (F12)  
(needed for the Automated Inventory Program)  
Enter the location where the object(s) in the accession are stored. Be brief and descriptive.

Example: STORAGE ROOM A
Click on the CR Totals button, or tab to the button and press the Enter key to expand the field. The field will expand into sixteen subfields. The subfields are grouped by discipline: archeology, history, archives, ethnology and art. There is an estimate, actual, bulk, and unit subfield for each discipline. If possible, enter the actual or estimated item count.

Enter the estimated or actual number of objects per discipline. If you cannot count the objects, enter the number of bulk units and the type of unit, such as 5 bags. (The Bulk subfields allow two decimal places.) However, the Collections Management Report (CMR) doesn’t count bulk units except for archives. For archives, if the Archives Unit is cubic feet (CF) or linear feet (LF), and the Archives Estimate and Archives Actual are both blank, then the number entered in the Archives Bulk field is multiplied by 1600 for the CMR.

**Archeology Estimate (Archeology Est.) (numeric field):**

Enter the estimated number of archeology objects in the accession.

**Archeology Actual (numeric field):**

Enter the actual number of archeology objects in the accession.

**Archeology Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing archeology objects in the accession.

**Archeology Unit (straight entry field):**

Enter the container type, such as Bag or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 50 boxes, 75 bags. (The number in the Archeology Bulk field would then be 125.)

**History Estimate (History Est.) (numeric field):**

Enter the estimated number of history objects in the accession.

**History Actual (numeric field):**

Enter the actual number of history objects in the accession.

**History Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing history objects in the accession.

**History Unit (straight entry field):**

Enter the container type, such as Bag or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 3 boxes, 5 bags. (The number in the History Bulk field would then be 8.)

**Archives Estimate (Archives Est.) (numeric field):**

Enter an estimated number for the archival material in the accession.
**Archives Actual (numeric field):**

Enter an actual number for the archival material in the accession.

**Archives Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing archival material in the accession.

**Archives Unit (straight entry field):**

Enter LF (linear feet) or CF (cubic feet) for bulk units.

**Ethnology Estimate (Ethnology Est.) (numeric field):**

Enter the estimated number of ethnology objects in the accession.

**Ethnology Actual (numeric field):**

Enter the actual number of ethnology objects in the accession.

**Ethnology Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing ethnology objects in the accession.

**Ethnology Unit (straight entry field):**

Enter the container type, such as Bag or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 3 boxes, 5 bags. (The number in the Ethnology Bulk field would then be 8.)

**Art Estimate (Art Est.) (numeric field):**

Enter the estimated number of art objects in the accession.

**Art Actual (numeric field):**

Enter the actual number of art objects in the accession.

**Art Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing art objects in the accession.

**Art Unit (straight entry field):**

Enter the container type, such as Bag or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 3 boxes, 5 bags. (The number in the Art Bulk field would then be 8.)

**Natural History Totals (NH Totals):**

Formatted memo field.

Click on the NH Totals button, or tab to the button and press the Enter key to expand the field. The field will expand into twelve subfields. The subfields are grouped by discipline: biology, geology, and paleontology. There is an estimate, actual, bulk, and unit subfield for each discipline. If possible, enter the actual or estimated item count.

Enter the estimated or actual number of specimens per discipline. If you cannot count the specimens, enter the number of bulk units and the type of
unit, such as 5 vials. (The Bulk subfields allow two decimal places.) However, the Collections Management Report (CMR) doesn’t count bulk units.

**Biology Estimate (Biology Est.) (numeric field):**

Enter the estimated number of biology specimens in the accession.

**Biology Actual (numeric field):**

Enter the actual number of biology specimens in the accession.

**Biology Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing biology specimens in the accession.

**Biology Unit (straight entry field):**

Enter the container type, such as Vial or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 3 vials, 1 box. (The number in the Biology Bulk field would then be 4.)

**Paleontology Estimate (Paleontology Est.) (numeric field):**

Enter the estimated number of paleontology specimens in the accession.

**Paleontology Actual (numeric field):**

Enter the actual number of paleontology specimens in the accession.

**Paleontology Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing paleontology specimens in the accession.

**Paleontology Unit (straight entry field):**

Enter the container type, such as Vial or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 3 vials, 1 box. (The number in the Paleontology Bulk field would then be 4.)

**Geology Estimate (Geology Est.) (numeric field):**

Enter the estimated number of geology specimens in the accession.

**Geology Actual (numeric field):**

Enter the actual number of geology specimens in the accession.

**Geology Bulk (numeric field with two decimal places):**

Enter the number of bulk units containing geology specimens in the accession.
**Geology Unit (straight entry field):**

Enter the container type, such as Vial or Box, for bulk units. If you have more than one container type, you can enter the number before the unit, such as 3 vials, 1 box. (The number in the Geology Bulk field would then be 4.)

**Item Total**

System generated.

The program automatically completes this field. It contains totals for the estimated, actual, and bulk items. The program totals all disciplines from both cultural resources and natural history. The total is not separated by discipline.

Example: Estimate: 5 Actual: 6 Bulk: 10

You cannot edit this field.

**Source Individual (Source Ind)**

User-built, stacked table (F5, Ctrl-F5, F12 to expand) that links to the Names and Addresses associated module. This field maps to the accession receiving report, the deed of gift, and the source of accession. **To save the record, you must complete this field or the Source Institution field.**

Enter the full name of the person(s) from whom the unit acquired the items in the accession. Enter the last name first in order to more easily find the name in the table.

Example: PETERS, JASON T.

Complete either the Source Individual or the Source Institution, not both. If you don’t know the source, enter Unknown in one of these fields in order to save the record.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

**Note:** Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash - - separates entries.
Click **Delete** or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon (£) next to the person icon allows you to view the Names and Addresses record for your entry.

The program uses information from the Names and addresses associated module to complete the accession forms.

**Note:** You must complete the following fields on the Names and Addresses screen for the source individual:

- **Name ID** - enter the name of the individual(s) as, last name first and in all caps. This entry will appear on the accession receiving report and/or source of accession.
- **First and Last Name and Title** - enter the name and title of the individual(s) as you want them to appear on the deed of gift.
- **Address 1 and 2** - enter the address of the individual(s).
- **City/St/Zip** - enter the city, state and zip code of the individual(s).
- **Phone** - enter the phone number of the individual(s).
- **NPS** - enter NPS or non-NPS (or DOI - enter DOI or non-DOI).

To save the record, you must complete this field or the Source Individual field.

Enter the name of the institution from which the unit acquired the items in the accession.

Example: MONTANA UNIVERSITY

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon (£) to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table. Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

**Note:** Enter the Name ID in all caps.
Refer to Section XII of this chapter for information on the Names and Addresses associated module.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash - - separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

The program uses information from the Names and Addresses associated module to complete the accession forms.

**Note:** You must complete the following fields on the Names and Addresses screen for the source institution:

- **Name ID** - enter the name of the institution in all caps as you want it to appear on the accession receiving report, deed of gift, and/or source of accession.

- **First and Last Name and Title** - enter the name and title of the responsible official or contact person for the accession. For field collections, enter the name of the authorized collector or Bureau employee.

- **Address 1 and 2** - enter the address of the institution.

- **City/St/Zip** - enter the city, state and zip code of the institution.

- **Phone** - enter the phone number of the institution.

- **NPS** - enter NPS or non-NPS (or DOI - enter DOI or non-DOI).

**Note:** The institutional source for field collections is the Bureau.

**Source Official**

User-built table (F5, Ctrl-F5).

Complete this field when the source of accession is an institution. Enter the full name, last name first, of the responsible official or contact person at the institution from which the unit acquired the accession. The person's name should be part of the Names and Addresses entry for the institution (see Source Institution).

Example: Gonzalez, Anna M.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field. Press Ctrl-Delete to remove unwanted entries.
Description

Formatted memo field. Press F12, or right click and select zoom from the menu to expand the field, or click the formatted memo icon located in the field. The field will also expand as you begin to type. **To save the record, you must complete this field.**

The field will expand into two subfields: Description and List of Objects. An underline separates the subfield entries on the screen.

**Description (memo field)**
Maps to the accession receiving report. Provide a brief description, identification, and history of the collection. Note the provenience, including site names and numbers if appropriate. This information is provided by the source of accession only.

**List of Objects (memo field)**
Maps to the accession receiving report list of objects, deed of gift, and the source of accession card. List the objects in the accession, noting specific object condition.

**Note:** You can also cut and paste an inventory list in this field.

6. **How do I complete the data fields on the Extended Information screen?**

Use this screen to document additional information about an accession.

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press the Tab key to move out of a field.

**Note:** None of the fields on this screen are mandatory for accession records.

**Related Accessions (Related Acc)**

Memo field (F12 to expand).

Enter the accession number and a brief description of any related accessions.
Example: WASO-00023 contains 3 dinner plates that were purchased to make a complete set of 6 to be used for the dining room exhibit. The dinner plates in WASO-00023 are identical to the ones in this accession.

**Comments**

Formatted memo field. Press F12 or click the formatted memo icon to expand the field. The field will also expand as you begin to type. The field will expand into three subfields: Condition, Other Comments, and Custody Document. An underline separates the subfield entries on the screen. All of the subfields map to the accession receiving report.

**Condition (memo field):**

Describe the overall condition of the accession at the time of receipt. Note specific object condition with the list of objects that you enter in the Description field.

Example: Other than being dusty, the objects were in good condition upon receipt.

**Other Comments (memo field):**

Enter any additional comments about the accession. If the accession is a field collection, note whether there is a Receipt for Property (DI-105).

Example: These objects were delivered by the Madison Arts Shipping Company.

**Custody Document (Custody Doc) (Bureau controlled table – F5):**

Enter the type of custody document that was used to transfer title of the objects to the Bureau. Choose one of the terms from the table. You may not add to, delete from, or change the table.

Choose from the following documents:

- Copy of purchase contract
- Deed of Gift (10-830)
- Exchange Agreement
- Incoming Loan Agreement (Form 10-98)
- Receiving Report copy of Field Purchase Order (SF-44)
- Receiving Report copy of Order for Supplies or Services (OF-347)
- Requisition (DI-1)
- Transfer of Property (DI-104)

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

**Publication**

Memo field (F12 to expand).

If any items from the accession have been used in a publication, enter the publication, date, and object name. You can also enter a standard bibliographic reference.


**Permit Number**

Memo field (F12 to expand).

Enter the permit number assigned to the project through the unit permit granting process.
This could be a natural history permit number or an archeology ARPA number or an Antiquities Act permit number.

The number should contain the fiscal year, unit acronym, and a number. If the year is part of the overall number, then the number portion should start at the beginning of each new fiscal year. This allows you to track how many permits were assigned in each fiscal year.

Example: ACAD-1998-008
          BLRI-2005-SCI-0123

Other Archeology Information

Formated memo field. Press F12 or click the paper icon to expand the field. The field will also expand as you begin to type. The field will expand into five subfields: State Site Number, Phase Type, Project Date, Project Title, and Project Director. An underline separates the subfield entries on the screen.

State Site Number (State Site No) (memo field):

Enter the number that the state assigned to the site.

Example: 46JF100. [Smithsonian trinomial composed of the state number, county code, and registration number for the particular site.]

Phase Type (user-built stacked table – F5, Ctrl-F5, Ctrl-F12):

Enter the phase(s) or level(s) the project has reached.

Example: I - Walking survey
          II - Shovel Test Pits
          III - Units (Going into portions of the grid, as in going down into 5'x 5' sections)

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table. You can enter multiple terms. Press F12 to expand the field and select more terms. Press Enter or the down arrow key, or click Add, to select additional terms for this record. Click Save to save and return to the main window. Multiple terms are separated by double dashes (--).

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

Project Date (flexible date field):

Enter the beginning and ending dates for the project. Enter a two-digit month, a two-digit day, and the full year.

Example: 12/12/1997 - 12/12/1998

Project Title (memo field):

Enter the name assigned to the project.
C. Printing the Accession Forms

1. What forms and reports can I print from the Accession Records associated module?

You can print the following forms and reports from the Accession Records associated module:

- Accession Folder Cover Sheet.docx (10-255)
- Deed of Gift (10-830)
- Deed of Gift – Blank.docx (10-830)
- Deed of Gift Continuation Sheet (10-830c)
- Deed of Gift Continuation Sheet - Blank.docx (10-830c)
- Accession Receiving Report (10-95)
- Accession Receiving Report – Blank.docx (10-95)
- Accession Receiving Report Continuation (10-95c)
- Accession Receiving Report Continuation – Blank.docx (10-95c)
- Accession List
- Accession Worksheet.docx
- BOR Accession Folder.docx (7-2513)
- BOR Accession List.docx
- BOR Accession Receipt
- BOR Accession Receiving Report
- BOR Accession Receiving Report Continuation
- BOR Accession Register
- BOR Deed of Gift Continuation
- CMR Accession Verification
- CMR Accession Verification - Count by Accession
- Receipt for Property (DI-105) (blank only)
- DOI Accession Receiving Report
- DOI Accession Receiving Report Continuation
- DOI Deed of Gift
- Source of Accession
- USGS Accession Receipt
- USGS Accession Register

Note: The ACCCAT report has been moved to Catalog Records.

For additional information, refer to Chapter 5, Reports and Forms.

Note: The program will complete the forms or allow you to print blank forms. Use acid-free paper for printing forms.

2. How do I print the reports and forms in the Accession Records associated module?

To access the list of forms to print:

- click on the Proficio Reports icon on the button bar, or
- go to Record on the menu bar, select Reports → Proficio Reports → Proficio Reports.
The list of reports will appear. Select the desired report as indicated below.

**Note:** For the forms to print correctly, you must enter data in the fields on the accession screens that are mapped to the forms. The manual and on-line help will tell you which fields map to the reports.

The Accession Receiving Report and Deed of Gift pull the unit address and superintendent information from the Names and Addresses associated module. You must have a record in Names and Addresses with the Name ID of “NPS UNIT” or “UNIT” for other bureaus with your unit information filled in for the unit address and superintendent or designated authority to print on the forms. Refer to Chapter 5, Section II, Reports and Forms for information on the NPS Unit or Unit records.

3. **How do I print the Accession Receiving Report?**

To print the accession receiving report for your unit, in the Proficio Reports window, select

- **10-95 Accession Receiving Report**
- **BOR Accession Receiving Report**
- **DOI Accession Receiving Report**

The program will complete all sections of the form except the signature and date sections.

**Note:** To print a blank version, choose the 10-95 Accession Receiving Report – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on the computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of this form when using this option.
<table>
<thead>
<tr>
<th></th>
<th>How do I print the Accession Receiving Report Continuation?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you have over six lines in the Description field, you must print the Accession Receiving Report Continuation.</td>
</tr>
<tr>
<td></td>
<td>To print the accession receiving report continuation sheet, in the Proficio Reports window, select</td>
</tr>
<tr>
<td></td>
<td>10-95c Accession Receiving Report Continuation</td>
</tr>
<tr>
<td></td>
<td>BOR Accession Receiving Report Continuation</td>
</tr>
<tr>
<td></td>
<td>DOI Accession Receiving Report Continuation</td>
</tr>
<tr>
<td></td>
<td>The program will complete all sections of the form.</td>
</tr>
<tr>
<td></td>
<td>Note: To print a blank version, choose the 10-95 Accession Receiving Report Continuation – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.</td>
</tr>
<tr>
<td></td>
<td>You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of this form when using this option.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>How do I print the Accession Folder Cover Sheet?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To print an accession folder cover sheet, in the Proficio Reports window, select</td>
</tr>
<tr>
<td></td>
<td>10-255 Accession Folder Cover Sheet.docx</td>
</tr>
<tr>
<td></td>
<td>BOR Accession Folder.docx</td>
</tr>
<tr>
<td></td>
<td>Note: The program prints the accession folder cover sheet from a separate Microsoft Word window. You can complete the form manually or on the computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>How do I print the Deed of Gift or Accession Receipt?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To print a deed of gift or accession receipt, in the Proficio Reports window, select</td>
</tr>
<tr>
<td></td>
<td>10-830 Deed of Gift</td>
</tr>
<tr>
<td></td>
<td>DOI Deed of Gift</td>
</tr>
<tr>
<td></td>
<td>BOR Accession Receipt</td>
</tr>
<tr>
<td></td>
<td>USGS Accession Receipt</td>
</tr>
<tr>
<td></td>
<td>The program will complete all sections of the form except the signature and date entries. You must obtain original signatures from the donor(s) and superintendent.</td>
</tr>
<tr>
<td></td>
<td>Note: To print a blank version, choose the 10-830 Deed of Gift – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.</td>
</tr>
<tr>
<td></td>
<td>You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of this form when using this option.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>How do I print the Deed of Gift Continuation Sheet?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you have over twelve lines in the Description field, you must print the Deed of Gift Continuation Sheet.</td>
</tr>
</tbody>
</table>
To print the deed of gift continuation sheet, in the Proficio Reports window, select

10-830c Deed of Gift Continuation
BOR Deed of Gift Continuation

The program will complete all sections of the form.

Note: To print a blank version, choose the 10-830 Deed of Gift Continuation – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of this form when using this option.

8. **How do I print a source of accession record?**

To print the source of accession record, in the Proficio Reports window, select

**Source of Accession**

The program will complete all sections of the record.

9. **How do I print an accession list?**

To print an accession list which includes the list of objects for an accession from the current directory, in the Proficio Reports window, select

**Accession List**
BOR Accession List.docx

Note: The BOR Accession List.docx is a blank form that prints from a separate Microsoft Word window. You can complete the form manually or on the computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

10. **How do I print an accession register?**

To print an accession register, in the Proficio Reports window, select

**BOR Accession Register**
USGS Accession Register

11. **How do I print a Receipt for Property (DI-105)?**

You can only print a blank Receipt for Property from the accession record. To print a blank receipt for property, in the Proficio Reports window, select

**DI-105 Receipt for Property**

Note: You can print a receipt for property with object information filled in by running the report from the catalog records. Use a tag set, filter or selected records in the List Pane to limit the visible data. Then run the report on all visible data.

12. **How do I print an accession worksheet?**

The accession worksheet is a word document that prints as a blank form for you to complete accession information before entering it into the program. To print an accession worksheet, in the Proficio Reports window, select

**Accession Worksheet.docx**
13. How do I print the CMR accession verification reports?

The CMR accession verification report shows how the CMR arrives at the numbers in Section II.A. Accessions.

**CMR Accession Verification:** First, create and activate a tag set for new accession records added during the fiscal year. Then select this report in the Proficio Reports window. The total for each discipline for the year is shown.

**CMR Accession Verification – Count by Accession:** First, create and activate a tag set for new accession records added during the fiscal year. Then select this report in the Proficio Reports window. The count by discipline and the total are shown for each accession.

Both of these reports provide estimated and actual numbers of items by acquisition type and by discipline. They ignore data entered in the bulk field, except for Archives when the Actual and Estimated fields are empty and Unit is LF or CF. In that case, the Bulk is multiplied by 1600.

These reports show Estimated numbers only for records with no Actual numbers.

Refer to Appendix H: CMR for additional information on the CMR.

14. Is there a report that will print the accession record fields that contain data?

Yes. Use the Full View report to print all the fields of the accession record that contain data.

Select Full View from the Record menu or click the Full View button on the button bar. You can print a single record or all visible. See Chapter 5, Section IV for more information on Full View.

15. How can I print a list of catalog records that are associated with an accession?

There are two ways to print a list of the catalog records that are associated with an accession.

a. From the Catalog Records screen, use a tag set, filter or selected records in the List Pane to limit the visible data to the catalog records in the accession. Go to the Proficio Reports window and select ACCCAT

Select Run for All Visible. Enter a subtitle for the report (if desired) and click Submit.

This report prints the accession number, source, and acquisition type with a list of catalog numbers that includes the object name, item count and object status.

**Note:** If the accession contains catalog records from both cultural resources and natural history, you will have to go to the catalog records in the other directory, limit your visible data as above and print the same report.

b. On the Accession Objects tab, click the Print link to print the list of objects. A Print Preview window will open. From the File menu, select Print.

**Note:** If the accession contains catalog records from both cultural resources and natural history, you will have to go to the other directory, choose the same accession record and print the list of catalog records from that directory.
II. CONSERVATION ASSOCIATED MODULE

A. Overview

1. **When do I use the Conservation associated module?**
   Use the Conservation associated module to document and track the conservation treatment an object has received. You can also use this module to document conservation work that an object needs, as noted on a conservation survey or report.

2. **Where can I find information on conservation treatment?**
   For specific conservation treatments and needs, refer to conservation treatment reports, condition reports, or surveys for your collection.

3. **Must I use the Conservation associated module?**
   No. Use of this feature is optional. Taking advantage of this feature in the program is recommended so that conservation information is readily available.

4. **How do I get to the Conservation associated module?**
   To go to the Conservation associated module records:
   - from the Home page, select your Cultural Resources of Natural History directory by double-clicking, then double-click Conservation,
   - from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Conservation,
   - from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Conservation.

5. **How many screens does the Conservation associated module have?**
   The conservation associated module consists of 4 screens:
   - Main Information
   - Extended Information
6. What are the Images and Multimedia tabs used for in the Conservation associated module?

You can attach multiple digital images to conservation records, such as before and after treatment photos of the object. The Multimedia tab allows you to attach other media files such as video and sound clips, conservation reports, spreadsheets, pdf files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

7. How do I add to or change information on an existing conservation record?

From the conservation screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

8. Can I access the conservation records from the catalog record screen?

Yes. You can add, view, edit and delete conservation associated module records through the conservation supplemental in the catalog record. On the catalog record, go to the Supplemental Information tab and select the Conservation supplemental. Click add, or select an existing conservation supplemental and click edit, view, or delete. The Conservation associated module screen will appear in the mode you selected (add, modify, view).

If you are adding or modifying a conservation record, complete the conservation screen as described below.

If you are deleting the conservation record, the system will ask you if you are sure you want to delete the selected conservation record, which includes both the supplemental and the Conservation associated module record.

9. What is the easiest way to include pertinent information from a conservator’s report in the Conservation associated module?

The easiest way to include information from a conservator's report is to copy and paste the information into the appropriate fields. To assist this process, request a copy of your conservator's report in an electronic format. Scan hard copy reports into electronic format when the information is lengthy and you can't obtain the reports in electronic format. You can also attach the report to the Multimedia tab.

10. What reports can I print from the Conservation associated module?

There are no reports related to the Conservation associated module.

B. Adding a Conservation Record

1. How do I add a conservation record?

From the conservation record screen:

- click on the add icon on the button bar, or
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
• press the F9 key

A new window will open and you will see “Add Mode” in the lower right corner. You can then add and save a record.

Note: To add a conservation record from the catalog record screen, refer to Section A.8 above.

2. How do I move through the record?

Within the Field
Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

Field to Field
Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

Page to Page
Click on the Extended Information tab or press Ctrl-N.

3. How do I cancel a record?

To cancel the record without saving the data:

• click the Cancel link on the bottom right of the screen, or

• click the Cancel button on the button bar, or

• go to File on the menu bar and select Cancel

4. How do I save a record?

To save the entire record:

• click the Save and Close link at the bottom right of the screen, or

• click the Save and Close icon on the button bar, or

• go to File on the menu bar and select Save and Close

Note: You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.
5. How do I complete the data fields on the Conservation Information screen?

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press the Tab key to move out of a field.

**Note:** None of the fields in the Conservation associated module are mandatory.

**Catalog Number**

(*Catalog #*)

For NPS, this is a 3-part, 12 character field. For DOI, this is a regular, unedited, 60-character field. **To save the record, you must complete this field.**

**NPS Catalog Number format:**

- **Catalog #**
  - **PARK**
  - **PC**
  - **9999999**

  Example: SHEN 190
  COLOY3456 [The Colonial NHP number contains a Y as a designation for the Yorktown collection.]

**DOI Catalog Number format:**

- **Catalog #**

  Enter a catalog number for an existing catalog record.

  Example: BLM 1968.03.015

  The catalog number field links the conservation record to the corresponding catalog record.

  After you enter the catalog number, the program displays the catalog and accession numbers, object name, and a brief description of the object in the memo field below the catalog number. You cannot modify this field.

  **Note:** After you have saved the record, you cannot edit this field. The catalog number links the conservation treatment record to the catalog record. You cannot change the catalog number because you would lose the relationship between the object and the treatment record. Be sure to check the catalog number and make any corrections to the number before you save the record. If you save an incorrect catalog number, you can delete the record, by going to Edit on the menu bar and choosing Delete Record(s) from the pull-down menu. Then choose Delete This Record.
**Conservation Due**
(Cons Due)

Date field.

Enter the date the conservation treatment is due for completion. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2006

**Note:** The program uses the catalog number and due date fields together to create a unique record. You cannot have two conservation records for the same catalog number if they both have the same due dates or blank due dates.

**Estimated Hours**
(Est Hours)

Numeric field.

Enter an estimate of the number of hours needed to complete the conservation treatment. A conservator should provide the estimate. The field includes two decimal places.

**Conservation Description**
(Cons Descrip)

Memo field (F12 to expand).

Enter a description of the conservation treatment that the object received or needs. You can cut and paste this entry from a conservator's survey or report. Note whether the treatment has been received or is needed.

This can be a general statement of work. Enter more detailed procedures in the Work Order field.

**Approved**

User-built table (F5, Ctrl-F5).

Enter the name of the person who approved the conservation treatment. This is usually the superintendent.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Approval Date**

Date field.

Enter the date that the conservation treatment was approved. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2004

**Work Order**

Memo field (F12 to expand).

Describe the statement of work for the conservation treatment. You can cut and paste this from a conservator's report.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Original Conservation</strong></td>
<td>Memo field (F12 to expand). Describe any previous conservation treatments performed on the object. You can cut and paste this from a conservator's report.</td>
</tr>
<tr>
<td><strong>Conservation Materials</strong></td>
<td>Memo field (F12 to expand). Enter the materials that the conservator used to complete conservation treatment of the object. You can cut and paste this from the conservator's report.</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td>Memo field (F12 to expand). Describe the treatment. Summarize or cut and paste the conservator's object treatment report. Use this field for completed treatments. Include any comments about subsequent treatment of the object.</td>
</tr>
<tr>
<td><strong>Medium</strong></td>
<td>Memo field (F12 to expand). Record the nature of storage media or supports, if applicable.</td>
</tr>
<tr>
<td><strong>Conservation Hours</strong></td>
<td>Numeric field. Enter the number of hours needed to complete the conservation treatment. The field includes two decimal places.</td>
</tr>
<tr>
<td><strong>Complete?</strong></td>
<td>Bureau controlled table (F5). Type &quot;Y&quot; (Yes) if the conservation treatment is complete. Type &quot;N&quot; (No) if the conservation treatment has not yet been completed.</td>
</tr>
<tr>
<td><strong>Storage Date</strong></td>
<td>Date field. Enter the date that the object was placed in the storage medium. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.</td>
</tr>
<tr>
<td><strong>Conservation Cost</strong></td>
<td>Numeric field. Enter the cost (dollar value) of the treatment. The field includes two decimal places.</td>
</tr>
<tr>
<td><strong>Conservation By</strong></td>
<td>User-built, stacked table (F5, Ctrl-F5, F12 to expand) that links to the Names and Addresses associated module. Enter the name of the conservator(s) who treated the object.</td>
</tr>
</tbody>
</table>

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select
Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

**Note:** Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash - - separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

**Conservation Date**

(Cons Date)

Flexible date field.

Enter the date of conservation treatment or the period of time over which the treatment was performed.

Example: 11/18/1996 - 12/08/1996

Enter a two-digit month, a two-digit day, and the full year. A zero precedes single digits. You can enter the date or press F12 or click the calendar icon for the flexible date entry screen. The flexible date entry allows you to enter a beginning and ending date. It also includes a user-built table of modifiers, such as "circa." Refer to Chapter 1, System Basics, for additional information on flexible date fields. Use of the flexible date screen is optional.

6. **How do I complete the data fields on the Extended Information screen?**

To access the fields on the extended information screen, single-click on the Extended Information tab or press Ctrl-N until the tab is selected.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.
These are user-defined fields for conservation treatment. Use these fields to enter unit-specific conservation data that do not fit on the Conservation Information screen.

Users with the appropriate security may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change.
III. EXHIBITS ASSOCIATED MODULE

A. Overview

1. **When do I use the Exhibits associated module?**
   
   Use the Exhibits associated module to document and track objects placed on exhibit.

2. **Where can I find information on exhibits?**
   
   Refer to the Museum Handbook, Part III (MH-III), Chapter 7, Using Museum Objects in Exhibits, for general information and procedures for exhibits.

3. **Must I use the Exhibits associated module?**
   
   No. Use of this feature is optional. Taking advantage of this feature in the program is recommended so that information about exhibits is readily available.

4. **How do I get to the Exhibits associated module?**
   
   To go to the Exhibits associated module records:
   - from the Home page, select your Cultural Resources or Natural History directory by double-clicking, then double-click Exhibits, \( \text{or} \)
   - from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Exhibits, \( \text{or} \)
   - from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Exhibits

5. **How can I view an exhibit record attached to a catalog record?**
   
   To view an exhibit for a specific object through the catalog record, go to the catalog record, select the Supplemental Information tab in the Record Pane and choose the Exhibits supplemental.

   Select the specific Exhibits supplemental record and click View. A new window will open displaying the Exhibits supplemental information.
6. **How many screens does the Exhibits associated module have?**

The Exhibits associated module consists of 5 screens:

- Main Information
- Extended Information
- Items on Exhibit
- Images
- Multimedia

7. **What is the Items on Exhibit tab?**

The Items on Exhibit tab allows you to view and attach objects to an exhibit record. When you attach objects, the program automatically creates an Exhibits supplemental record for each object.

8. **What are the Images and Multimedia tabs used for in the Exhibits associated module?**

The Images tab allows you to attach digital images to the Exhibit record. You may want to photograph exhibit cases and layout for reference. The Multimedia tab allows you to attach other media files such as video and sound clips, documents, spreadsheets, pdf files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

9. **How do I add to or change information on an exhibit record?**

From the exhibit screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click **Save and Close** at the bottom right or press the F2 key to save the changes.

**Note:** You cannot modify the exhibit ID on an existing exhibit record.

10. **Does the program update the Object Status or Location field on the catalog record for exhibits?**

Yes. When you attach catalog records to an exhibit record, the Object Status, Location and Status Date fields are included in the Mass Supplemental Update process. Refer to Chapter 3, Supplemental Records for information on the Mass Supplemental Update.
B. Adding an Exhibit Record

1. How do I add an exhibit record?

   From the exhibit record screen:
   
   - click on the add icon on the button bar, or
   - go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
   - press the F9 key

   A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

2. How do I move through the record?

   Within the Field
   Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

   Field to Field
   Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

   Page to Page
   Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. How do I cancel a record?

   To cancel the record without saving the data:
   
   - click the Cancel link on the bottom right of the screen, or
   - click the Cancel button on the button bar, or
   - go to File on the menu bar and select Cancel

4. How do I save a record?

   To save the entire record:
• click the Save and Close link at the bottom right of the screen, or

• click the Save and Close icon on the button bar, or

• go to File on the menu bar and select Save and Close

Note: You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. *How do I delete an exhibit record?*

From the Exhibits screen:

• Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.

• Choose Delete This Record

• Click Yes when the program asks if you are sure you want to delete the record.

6. *How do I complete the data fields on the Main Information screen?*

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Exhibit ID**

Straight entry field.

Enter the unique identifying number of the exhibit. Choose this number locally. The park should maintain a log of exhibit identification numbers. You can see a list of exhibit IDs in the List Pane. **To save a record, you must complete this field.**

Note: Once you have saved the record and attached catalog records to the exhibit, you cannot edit this field. The catalog records (for the objects in the exhibit) relate to the exhibit record through the exhibit ID. You cannot change the exhibit ID because you would lose the relationship between the objects and the exhibit. Be sure to check the exhibit ID and make any corrections to the number before you save the exhibit record and attach any catalog records. If you save an incorrect number, you can either delete the record and add a new one or copy the record first (changing the exhibit number) and then deleting the incorrect record.

**Exhibit Type**

User-built table (F5, Ctrl-F5).

Enter the type of exhibit, such as temporary, permanent, or traveling.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.
Exhibit Status

Bureau controlled table (F5). You may not add to, modify, or delete terms in this field.

Enter the status of the exhibit. Choose between active, pending, or ended.

As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Start Date

Date field.

Enter the opening date of the exhibit. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2005

End Date

Date field.

Enter the ending date of the exhibit. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 12/1/2006

Title

Straight entry field.

Enter the title of the exhibit.

Example: Women of the West: Myth and Reality

Description

Memo field (F12 to expand).

Enter a description of the themes and sub-themes in the exhibit.

Example: The exhibit is about family farms in the Shenandoah Valley. It includes sections on farm buildings, livestock, crops, family chores, and home entertainment.

Directory

Stacked table of directories (F5, F12 to expand) that are available on your system.

Choose the directory or directories that contain(s) the catalog records for the objects in the exhibit.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

If you need to attach catalog records from more than one directory, you can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.
Note: Choose a directory in order to attach the catalog records to the exhibit record.

Preparation

Memo field (F12 to expand).

Enter additional information about the preparation of the objects for the exhibit. Include notes on conservation work, contractors, special mounts and cases, and installation.

Prepared By

User-built table (F5, Ctrl-F5) that links to the Names and Addresses associated module.

Enter the name of the chief exhibit preparator.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table.

Note: Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

Press Ctrl-Delete to remove unwanted entries.

Note: The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

Cost

Numeric field.

Enter the total cost of preparing objects for the exhibit, if applicable. The field includes two decimal places.

Designer

User-built table (F5, Ctrl-F5) that links to the Names and Addresses associated module.

Enter the name of the chief designer or design company.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table.

Note: Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select...
Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

Press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

**Manager**

User-built table (F5, Ctrl-F5).

Enter the name of the Bureau project manager for the exhibit.

Example: Rook, Ernie

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Web Ready**

Y/N logical field

Select "Y" (Yes) if the exhibit record is ready for publication on the Web Catalog.

Records published on the Web Catalog should be accurate and complete. Check the records for typographical errors, and include enough detail in the Title and Description fields to allow the general public to understand the themes of the exhibit.

The Web Catalog will publish only Web Ready records. You can update the Web Ready field for groups of records by selecting the records and using the Modify All option on the Edit menu.

Refer to Appendix X for further information on the Web Catalog and how to prepare your exhibit records for submission.

7. **How do I complete the data fields on the Extended Information screen?**

To access the fields on the extended information screen, click on the Extended Information tab or press Ctrl-N to go to the next screen.
Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Maintenance**

Memo field (F12 to expand).

Enter routine and special maintenance instructions for the objects on exhibit.

Example: Remove dust weekly. Check light levels monthly. Examine the stability of exhibit mounts bi-annually.

**Note:** Information in this field does not link to the Maintenance associated module.

**Location/Layout (Loc./Layout)**

Memo field (F12 to expand).

Enter the physical location of the exhibit and describe its layout.

Example: The exhibit is on the first floor of the Byrd Jones Visitor Center. It consists of two rooms with cases of objects and a historic furnished room.

**Comments**

Memo field (F12 to expand).

Enter any additional information about the exhibit, such as the location of the exhibit plan and the emergency operations plan.

Example: Blueprints and exhibit plan housed in the exhibit files in library annex. Upright and flat case borrowed from the ranger station.

**User 1 – User 2**

These are a user-defined fields for exhibits. Use these fields to enter park-specific exhibits data that do not fit on the Main Information screen.

Users with the appropriate security rights may modify the field label, type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save.
and Close when finished. Click the refresh button 🔄 on the Button bar to see the label change.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.

8. **How do I complete the fields on the Items on Exhibit tab?**

The program will automatically complete the fields on the Items on Exhibit tab when you attach catalog records to the exhibit. To use this feature on a group of catalog records:

- Go to the catalog records and select a catalog record or create a tag set of all the objects in the exhibit. See Section XI of Chapter 6 for information on creating tag sets. You can also set a filter or select multiple items in the List Pane of the catalog records.

- Go to Edit on the menu bar and select Mass Supplemental Update. Refer to Section I of Chapter 3 for further information on Mass Supplemental Update.

- You can attach the catalog records to an existing Exhibit record or create a new Exhibit record during the Mass Supplemental Update.

When you re-enter the Exhibits associated module, the Items on Exhibit tab will include the objects. The program automatically completes the Directory, Status, Start and End Date columns using data from the exhibit record. The catalog number, object name, and value are filled in from the catalog record. Refer to Section B.10 below for information on how to change the data in the list.

![Image of Exhibit Information]

**Note:** The program also creates an Exhibits supplemental record for each object on the list. The supplemental record attaches exhibit information to the catalog record for each object in the exhibit. Refer to Section VIII of Chapter 3 for information on the Exhibits supplemental record.

**During the Mass Supplemental Update process, you will also be able to update the Location, Object Status and Status Date fields for the catalog records at the same time. The Location and Object Status supplementals will be updated from this information as well.**
Can I attach catalog records from the Items on Exhibit tab of the Exhibit record?

Yes, if there are only a few records to attach. For a large exhibit, it is much easier to use the Mass Supplemental Update from the catalog records on a tag set or group of records.

However, you may want to make manual additions, modifications, or deletions to an existing list.

9. How do I add, modify or delete objects on the Items on Exhibit tab?

To add, modify or delete objects from an exhibit record:

- First, add and save an exhibit record. You cannot attach objects to an exhibit record until it is saved.

- Go to the Items on Exhibit tab of the exhibit record. You can be in any mode to add, modify and delete items from the list.

Add an item

Click on Add above the item list on the right. The Mass Supplemental Update window for the associated module will open.

- If you have listed more than one directory in the Exhibit record’s Directory field, select the directory where the catalog record is found.

- Then choose a catalog record by clicking the catalog icon and typing the catalog number in the Term Selector or selecting the record from the list. Click Select.

- Note: The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number.
of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data. **The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.**

- Click Next after selecting the catalog record.

- The fields for the supplemental and object record are autofilled from the Exhibit record. You can keep these automatic values and click Next. Or to modify any of these fields, select the “Manually update value” option on the pull down menu next to the field.

![Image](image.png)

- Complete the fields for the supplemental and catalog record as follows:

  **Exhibits Supplemental Update**
  - **Status**: Choose the status from the list. Press F5 or click the down arrow icon to access the list.
  - **Start Date**: Enter the beginning date for the exhibit.
  - **End Date**: Enter the ending date for the exhibit.
  - **Notes**: Enter any additional information about the Exhibit.

  **Note**: The information entered in the Exhibits Supplemental Update does not transfer back to the Exhibit record.

  **Catalog Records Update**
  - **Object Status**: enter the object status from the list.
  - **Location**: enter a new location. You can maintain the original location instead by selecting “Keep original value” from the pull-down menu.
  - **Status Date**: Enter the 4-digit fiscal year for when the status began.
**Note:** You cannot insert a value from this screen. The information in the value column is pulled from the Appraisal supplemental on the catalog record. To change this value, go to the catalog record Supplemental Information tab and choose the Appraisal supplemental. Add or edit an appraisal supplemental record to reflect the current value.

- When finished editing the fields, click Next.
- On the report window of how many will be added or updated (it will only add or update 1 record at a time), click Finish to make the changes.

**Modify an Item**

On the Items on Exhibit tab, select an object in the list and click Edit above the list on the right. The Mass Supplemental Update window for the associated module will appear. It will already be on the Exhibit Supplemental and Catalog Records data entry screen (see above). Modify the information on any fields as described above. Click Next and then Finish to save the modifications.

**Delete an Item**

On the Items on Exhibit tab, select an object in the list and click Delete. A similar Mass Supplemental Update window will appear. Click Next and then Finish to delete the object from the list. This will remove an item from the exhibit list but not from the catalog database.

**View the catalog record for the item**

On the Items on Exhibit tab, select an object in the list and click View above the list, or click the link icon next to the catalog number in the list. The catalog record will open in a new window. Close the window by clicking the X in the upper right corner when finished viewing.

**11. Can I print the list of catalog records on the Items on Exhibit tab?**

Yes, you can print the list of catalog records that appear on the Items on Exhibit tab.

To print the list of catalog records, click Print on the Items on Exhibit tab. A print preview window will open.

To print the report, choose Print on the File menu, or click one of the print buttons on the button bar. You can also export or email this document using the options on the File menu or button bar.
C. Exhibits Reports

1. What reports can I print from the Exhibits associated module?
   You can print a copy of the exhibit record that includes a list of objects in the exhibit.

2. How do I print the report?
   To print an exhibit report:
   
   • Select the exhibit record you want to print a report.
   
   • Click on the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.
   
   • Select the Exhibit List report.
   
   • Click Run for Current Record Only
IV. LOANS OUT ASSOCIATED MODULE

A. Overview

1. When do I use the Loans Out associated module? Use the Loans Out associated module to document and track outgoing loans and print loan forms.

| For NPS, you must complete an Outgoing Loan Agreement, Form 10-127, for all outgoing loans. You cannot substitute a non-NPS form for Form 10-127. |

2. Where can I find information on outgoing loans? Refer to the Museum Handbook, Part II (MH-II), Chapter 5, Outgoing Loans, or the Museum Property Handbook, Volume II (MPH-II), Chapter 5, Incoming and Outgoing Loans, for general information and procedures for outgoing loans. Refer to your site-specific procedures, if available.

3. Must I use the Loans Out associated module? Yes. You are required to document and track all outgoing loans, and use of this module meets that requirement. Using this module also makes your loan information readily available and links it to your catalog data.

4. How do I get to the Loans Out associated module? To go to the Loans Out associated module records:
   - from the Home page, select your Cultural Resources or Natural History directory by double-clicking, then double-click Loans Out, or
   - from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Loans Out, or
   - from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Loans Out

5. How can I view the loan record attached to a catalog record? To view a loan for a specific object through the catalog record, go to the catalog record, select the Supplemental Information tab in the Record Pane and choose the Loans Out supplemental.

Select the specific loans out supplemental record and click View. A new window will open displaying the Loans Out supplemental information.
Click on the link icon on the Loan ID field and the Loans Out associated module record will open in a new window.

6. **How many screens does the Loans Out associated module have?**

The Loans Out associated module consists of 5 screens:

- Main Information
- Extended Information
- Items on Loan
- Images
- Multimedia

7. **What is the Items on Loan tab?**

The Items on Loan tab allows you to view and attach objects to an outgoing loan record. When you attach objects, the program automatically creates a Loans Out supplemental record for each object.

8. **What are the Images and Multimedia tabs used for in the Loans Out associated module?**

The Images tab allows you to attach digital images of the loan items. You may want to photograph the items before loaning them. The Multimedia tab allows you to attach other media files such as video and sound clips, condition report documents, spreadsheets, pdf files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

9. **How will I know which data are needed to complete the outgoing loan forms?**

The instructions in this manual and the on-line help will indicate which fields are needed to complete the loan forms.

10. **How do I add to or change information on an existing loan record?**

From the Loans Out screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see “Modify Mode” in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

**Note:** You cannot modify the loan ID on existing loan records.
11. *Does the program update the Object Status field on the catalog record for outgoing loans?*

Yes. When you attach catalog records to an outgoing loan record, the Object Status, Location and Status Date fields are included in the Mass Supplemental Update process. Refer to Chapter 3, Supplemental Records for information on the Mass Supplemental Update.

**B. Adding an Outgoing Loan Record**

1. *How do I add an outgoing loan record?*

From the Loans Out record screen:

- click on the add icon on the button bar, *or*
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, *or*
- press the F9 key

A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

2. *How do I move through the record?*

**Within the Field**

Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

**Field to Field**

Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

**Page to Page**

Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. *How do I cancel a record?*

To cancel the record without saving the data:

- click the Cancel link on the bottom right of the screen, *or*
- click the Cancel button on the button bar, *or*
4. **How do I save a record?**

To save the entire record:

- go to File on the menu bar and select ✗ Cancel

- click the Save and Close link at the bottom right of the screen, or

- click the Save and Close icon on the button bar, or

- go to File on the menu bar and select ✗ Save and Close

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. **How do I delete an outgoing loan record?**

From the Loans Out screen:

- Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.

- Choose Delete This Record.

- Click Yes when the program asks if you are sure you want to delete the record.

6. **How do I complete the data fields on the Main Information screen?**

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Loan ID**

Straight entry field. This field maps to all outgoing loan forms. **To save the record, you must complete this field.**

**NPS Loan ID format:**

```
Loan ID L....
```

The number consists of four parts:

- L (outgoing loan indicator)

- calendar year (four digits indicating the calendar year)

- outgoing loan transaction number (sequential transaction number within the calendar year, such as 12 for the twelfth outgoing loan transaction in the calendar year)

- (optional) unit indicator for use by Centers and sites that manage multiple units (e.g., L.2006.24.PARK).

**Example:** L.2006.12

**Note:** Once you have saved the record and attached catalog records to it, you cannot edit this field. The catalog records (for the objects in the loan) relate to the loan record through the loan ID. You cannot change the loan ID because you would lose the relationship between the objects and the loan. Be sure to check the loan ID and make any corrections to the number before you save the loan record and attach any catalog records. If you save an
incorrect number, you can either delete the record and add a new one, or copy the record first (changing the loan number) and then deleting the incorrect record.

**DOI Loan ID format:**

Enter the number for the outgoing loan using a standard format. This is a regular, unformatted, 60-character field.

Example: L2015.01

**Purpose**

User-built table (F5, Ctrl-F5). This field maps to the outgoing loan agreement and folder cover sheet.

Enter the purpose for the loan. Preferred entries are: exhibition, research, exhibit preparation, conservation, storage, and collections management.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Loan Status**

Bureau controlled table (F5). You may not add to, delete, or modify terms in this table.

Enter the status of the loan. Choose one of the terms from the table: active, converted to gift, pending, or returned.

As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

**Start Date**

Date field. This field maps to the outgoing loan agreement, extension, and folder cover sheet.

Enter the starting date for the loan. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2006

**End Date**

Date field. This field maps to the outgoing loan agreement, extension, and folder cover sheet.

Enter the termination date for the loan. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2007
Loan Description
(Loan Desc)

Straight entry field.

Enter a brief description of the loan. This information will appear in the Notes field of the Loans Out supplemental record.

Example: Ten powder horns loaned to the Smithsonian for a temporary exhibit on accoutrements.

Loan Memo

Memo field (F12 to expand).

Use this field to enter any additional information about the loan, such as background information about the borrower or notes on correspondence.

Directory
(required to attach object catalog records to the loan)

Stacked table of directories (F5, F12 to expand) that are available on your system.

Choose the directory or directories that contain(s) the catalog records for the objects in the loan.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Note: You must choose a directory in order to attach the catalog records to the outgoing loan record.

If the catalog records in the loan come from more than one directory, you can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

Borrower Information

This is the first tab on the lower half of the Main Information screen.

Borrower

User-built table (F5, Ctrl-F5) that links to the Names and Addresses associated module. This field maps to the outgoing loan agreement, extension, and folder cover sheet. To save the record, you must complete this field.

Enter the name of the institution that is borrowing the material.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon 🧑‍⚕️ to view and select names from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. The entry you add will appear in the table. You can then select it from the table.

Note: Enter the Name ID in all caps.
Refer to Section XII of this chapter for information on the Names and Addresses associated module.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

**Note:** You must complete the following fields on the Names and Addresses screen for the borrower. These will print on the outgoing loan agreement and loan extension:

- **Name ID** - enter the name of the borrowing institution in all caps
- **First and Last Name and Title** - enter the name and title of the responsible official
- **Division/Unit** - enter the name of the department within the institution, if appropriate
- **Phone** - enter the borrower's phone number
- **Fax** - enter the borrower's fax number
- **Primary Address**
  - **Address 1 and 2** - enter the borrower's address
  - **City/St/Zip** - enter the borrower's city, state and zip code
- **Alternate Address**
  - **Complete these fields if the shipping address is different from the mailing address**
  - **Type** - enter Borrower
  - **NPS** - enter NPS or non-NPS
  - **(DOI** - enter DOI or non-DOI)

### Responsible Official (Resp. Official)

Formatted Memo field. Press F12 or click the formatted memo icon to expand the field. The field will also expand as you begin to type.

The field will expand into two subfields: Responsible Official, and Title. An underline separates the subfield entries on the screen.

Enter the name and title of the responsible official. This is the person who is responsible for the loan at the borrowing institution.

### Phone

Straight entry field.

Enter the area code and phone number of the responsible official on behalf of the borrower.

### Credit Line

Memo field (F12 to expand). This field maps to the outgoing loan agreement.

Record the credit line as it is to appear in exhibit graphics, publications, or other media. If a credit line is not applicable, enter N/A.

Example: Courtesy of the Bureau of Indian Affairs.
**Shipping Information**

To access the shipping information fields click on the Shipping Information tab or press Ctrl-N until the tab is selected.

![Image of Shipping Information field](image.png)

**Insurance Paid By**

*(Insur. Pd By)*

User-built table (F5, Ctrl-F5). This field maps to the outgoing loan agreement.

Enter one of the following: Borrower, Lender, or Waived, or add an entry of your choice. This is the party who will pay the costs of insurance.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Shipping Paid By**

*(Ship Pd By)*

User-built table (F5, Ctrl-F5). This field maps to the outgoing loan agreement.

Enter one of the following: Borrower or Lender, or add an entry of your choice.

This is the party who will pay the costs of shipping.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Insurer**

User-built table (F5, Ctrl-F5) that links to the Names and Addresses associated module. This field maps to the outgoing loan agreement.

Enter the name of the insurance company that is insuring the objects in the loan, if applicable.
As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon 🔄 to view and select names from the table.

Note: Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right-click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. The entry you add will appear in the table. You can then select it from the table.

Click Delete or press Ctrl-Delete to remove unwanted entries.

Note: The record link icon 🔄 next to the person icon allows you to view the Names and Addresses record for your entry.

**Policy**

Straight entry field. This field maps to the outgoing loan agreement.

Enter the policy number for the insurance, if applicable.

**Special**

Memo field (F12 to expand). This field maps to the outgoing loan agreement.

Indicate whether a facilities report is required. Enter special instructions or conditions concerning the loan. This information will appear under "Additional Loan Conditions" on the outgoing loan agreement.

**Loan Administration**

To access the loan administration fields, click on the Loan Administration tab or press Ctrl-N until the tab is selected.

**Loan Approval**

(User-built table (F5, Ctrl-F5).

Enter the superintendent's name.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After
entering the term, click **Save Change**, then click **Select** to enter the term in
the field.

Press Ctrl-Delete to remove unwanted entries.

**Only the superintendent or unit’s designated authority can approve a loan.**

**Approval Date**

Date field.

Enter the date that the superintendent or designated authority signed the
outgoing loan agreement. The program will autofill as you type. To view a
calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2006

**Value**

Numeric field.

Enter the total value of the objects in the loan. The field includes two
decimal places.

**Loan Preparator**

(User-built table (F5, Ctrl-F5)).

Enter the name of the person who processed the loan.

As you type, the word will complete from an authority table of acceptable
terms. Press the F5 key or click the down arrow icon to view and select
terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in
the table. To add an entry to the table, right-click in the field and select
Browse Authority Table or press Ctrl-F5, then click **Add Term**. After
entering the term, click **Save Change**, then click **Select** to enter the term in
the field.

Press Ctrl-Delete to remove unwanted entries.

**Preparation Date**

Date field.

Enter the date that the loan was processed. The program will autofill as you
type. To view a calendar and select the date, click the calendar icon and
click on the day.

Example: 2/1/2006

**Loan Cost**

Numeric field.

Enter the total cost of the loan. The field includes two decimal places.
Include insurance costs and costs for packing and shipping the loan.

**Packer**

(User-built table (F5, Ctrl-F5). This field maps to the outgoing loan
agreement).

Enter the name of the person or company that packed the objects in the loan.

As you type, the word will complete from an authority table of acceptable
terms. Press the F5 key or click the down arrow icon to view and select
terms from the table.
Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Ship Date**

Date field.

Enter the shipping date. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/10/2006

**Received By (Recv By)**

User-built table (F5, Ctrl-F5).

Enter the name of the person who received the objects at the borrowing institution.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Received Date**

Date field.

Enter the date on which the borrower received the loan. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/15/2006

7. **How do I complete the data fields on the Extended Information screen?**

To access the fields on the extended information screen, click on the Extended Information tab or press Ctrl-N to go to the next screen.

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.
**Objects**

Memo field (F12 to expand). This field maps to the outgoing loan agreement and extension.

Enter "See attached list" for large loans. For loans of a few objects, enter a list of objects in this field. For each object, include the catalog and accession numbers, the object name, a brief description, the item count or quantity, the condition, and, if applicable, the value.

**Note:** For large loans, attach a List of Objects (Form 10-417 or DOI List of Objects).

**Shipping Method**  
*(Ship Method)*

Memo field (F12 to expand). This field maps to the outgoing loan agreement.

Enter the method of shipping.

Example: U.S. Mail  
Art Transport

**Return Method**

Memo field (F12 to expand). This field maps to the outgoing loan agreement.

Enter the name of the person or company who will pack the objects to return the loan. Enter the method of shipping that the borrower will use to return the loan.

Example: Borrower will pack objects for return in the same way the objects were sent or will improve the packing. Return shipping will be by an art transport company.

**Return Status**

Memo field (F12 to expand). This field maps to the outgoing loan agreement.

Enter "Complete" if the borrower has returned the entire loan. If the borrower has returned only part of the loan, list the catalog numbers for the returned objects and the date of return.

**Extension**

Formatted memo field. Press F12 or click the formatted memo icon to expand the field. The field will also expand as you begin to type. The field will expand into six subfields: Requested Extension Length, Extension Length, Extension Not Granted, Previous Extensions, Date Extended, and Comments. An underline separates the subfield entries on the main screen. All the subfields map to the outgoing loan extension.
All the subfields are memo fields. Press F12 to expand the field.

**Note:** Some loans are extended numerous times. The data in the Extension field should reflect the most recent extension. Enter documentation about previous extensions in the Previous Extension and Comments fields.

**Requested Extension Length (Request Len Ext) (memo field):**

Enter the length of the extension requested by the borrower.

Example: 3 years

**Extension Length (Length of Ext) (memo field):**

Enter the length of the extension granted by the lender.

Example: 2 years

**Extension Not Granted (Ext Not Granted) (memo field):**

Enter an explanation for why the extension was not granted, if applicable.

**Previous Extensions (memo field):**

Enter the dates for previous extensions. Use a beginning and ending year. Separate entries with a comma.


**Date Extended (memo field):**

Enter the date to which the loan was extended. This becomes the new termination date for the loan. This date is also displayed next to the original End Date on the Main Information screen of the loan record.

**Comments (memo field):**

Enter comments or additional conditions concerning the extension.

8. **How do I complete the fields on the Items on Loan tab?**

The program will automatically complete the fields on the Items on Loan tab when you attach catalog records to the loan. To use this feature on a group of catalog records:

- Go to the catalog records and create a tag set of all the objects in the loan. See Section XI of Chapter 6 for information on creating tag sets. You can also set a filter or select multiple items in the List Pane of the catalog records.

- Go to Edit on the menu bar and select Mass Supplemental Update. Refer to Section I of Chapter 3 for further information on Mass Supplemental Update.

- You can attach the catalog records to an existing outgoing loan record or create a new outgoing loan record during the Mass Supplemental Update.
When you re-enter the Loans Out associated module, the Items on Loan tab will include the objects. The program automatically completes the Status, Directory, Start and End Date columns using data from the loan record. The catalog number, object name, and value are filled in from the catalog record. Refer to Section B.10 below for information on how to change the data in the list.

Note: The program also creates a Loans Out supplemental record for each object on the list. The supplemental record attaches loan information to the catalog record for each object in the loan. Refer to Section XI of Chapter 3 for information on the Loans Out supplemental record.

During the Mass Supplemental Update process, you will also be able to update the Location, Object Status and Status Date fields for the catalog records at the same time. The Location and Object Status supplementals will be updated from this information as well.

9. Can I attach catalog records from the Items on Loan tab of the loan record?

Yes, if there are only a few records to attach. For a large loan, it is much easier to use the Mass Supplemental Update from the catalog records on a tag set or group of records.

However, you may want to make manual additions, modifications, or deletions to an existing list.

10. How do I manually add, modify, or delete objects on the Items on Loan tab?

To add, modify or delete objects from a loan record:

- First, add and save an outgoing loan record. You cannot attach objects to a loan record until it is saved.

- Go to the Items on Loan tab of the loan record. You can be in any mode to add, modify and delete items from the list.

Add an Item

Click on Add above the item list on the right. The Mass Supplemental Update window for the associated module will open.

- If you have listed more than one directory in the loan record’s Directory field, select the directory where the catalog record is found.
• In the Choose a catalog record field click the catalog icon or press F5 to access the list of catalog records. Type the catalog number in the Term Selector or select the record from the list. Click Select.

Note: The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data in the list. The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.

• Click Next after you have selected the catalog record.

• You will be asked what type of loan this is. Choose either NPS, Non-NPS - Federal, or Non-NPS - Non-Federal (Bureau, Non-Bureau - Federal, or Non-Bureau - Non-Federal) by clicking the appropriate button – i.e., is it going to another NPS/Bureau unit or outside the NPS/Bureau but another Federal unit, or a non-federal entity? This determines the Object Status for the catalog record (Loan Out – NPS, Loan Out – Non-NPS - Federal, Loan Out - Non-NPS - Non-Federal, Loan Out - Bureau, Loan Out - Non-Bureau - Federal, Loan Out - Non-Bureau - Non-Federal).
• The fields for the supplemental and object record are autofilled from the loan record. You can keep these automatic values and click Next. Or to modify any of these fields, select the “Manually update value” option on the pull down menu next to the field.

• Complete the fields for the supplemental and catalog record as follows:

Loans Out Supplemental Update

Status: This is the loan status autofilled from the loan record. To choose a different status for this record only, press F5 or click the down arrow icon to access the list.

Start Date: Enter the beginning date for the loan.

End Date: Enter the ending date for the loan.

Notes: The Loan Description autofills into the Notes field. Enter any additional information about the loan.

Note: The information entered in the Loans Out Supplemental Update does not transfer back to the loan record.

Catalog Records Update

Object Status: enter the object status from the list.

Location: enter a new location. Or you can maintain the original location by selecting “Keep original value” from the pull-down menu.
**Status Date:** Enter the 4-digit fiscal year for when the object status began.

**Note:** You cannot insert a value from this screen. The information in the value column is pulled from the Appraisal supplemental on the catalog record. To change this value, go to the catalog record Supplemental Information tab and choose the Appraisal supplemental. Add or edit an appraisal supplemental record to reflect the current value.

- When finished editing the fields, click Next.
- On the report window of how many will be added or updated (it will only add or update 1 record at a time), click Finish to make the changes.

**Modify an Item**

On the Items on Loan tab, select an object in the list and click Edit above the list on the right. The program will ask what type of loan this is – choose either NPS or Non-NPS. Then the Mass Supplemental Update window for the associated module will appear. It will already be on the Loans Out Supplemental and Catalog Records data entry screen (see above). Modify the information on any field as described above. Click Next and then Finish to save the modifications.

**Delete an Item**

On the Items on Loan tab, select an object in the list and click Delete. The program will ask what type of loan this is – choose either NPS or Non-NPS. Then a similar Mass Supplemental Update window will appear. Click Next and then Finish to delete the object from the list. This will remove an item from the loan list but not from the catalog database.

**View the Catalog Record for the Item**

On the Items on Loan tab, select an object in the list and click View on the left above the list or click the link icon next to the catalog number in the list. The catalog record will open in a new window. Close the window by clicking the X in the upper right corner when finished viewing.

**11. Can I print the list of catalog records on the Items on Loan tab?**

Yes, you can print the list of catalog records that appear on the Items on Loan tab.

To print the list of catalog records, click Print on the Items on Loan tab. A print preview window will open.
To print the report, choose Print on the File menu, or click one of the print buttons on the button bar. You can also export or email this document using the options on the File menu or button bar.

C. Printing the Outgoing Loan Forms

1. What forms and reports can I print from the Loans Out associated module?

You can print the following forms and reports from the Loans Out associated module:

- Blank Outgoing Loan Agreement.docx (10-127)
- Outgoing Loan Agreement (10-127)
- Conditions for Outgoing Loans.docx (10-127a) (2 pages)
- Outgoing Loan Agreement Continuation (10-127c)
- Outgoing Loan Folder Cover Sheet (10-640)
- Outgoing Loan Folder Cover Sheet – Blank.docx (10-640)
- Outgoing Loan Extension (10-641)
- Outgoing Loan Extension – Blank.docx (10-641)
- BOR Outgoing Loan Agreement
- BOR Outgoing Loan Agreement Continuation
- BOR Outgoing Loan Extension
- BOR Outgoing Loan Folder.docx
- BOR Outgoing Loan List.docx
- DI-3220 Notice of Potential Hazard in Museum Collections.docx
- DOI Outgoing Loan Agreement
- DOI Outgoing Loan Agreement Continuation
- DOI Outgoing Loan Extension
- Loan Cost
- Outgoing Loan List (selected fields from the loan record that includes a list of objects in the loan)
- USGS Outgoing Loan Agreement
- USGS Outgoing Loan Agreement Continuation

You will also use the Object Condition Report (Form 10-637 or DOI Object Condition Report) and the List of Objects (Form 10-417, BOR or DOI List of Objects) when documenting loans. You must access these forms from the catalog record screen.

For additional information, refer to Chapter 5, Reports and Forms.

Note: The program will complete the forms or allow you to print blank forms. Use acid-free paper for printing forms.
2. How do I complete the NPS or DOI Unit section of the forms?

Many forms contain a section for the name and address of the unit. To have the program print this information on the forms, you must complete an entry in the Names and Addresses associated module. See Section XII of this chapter. Enter “NPS UNIT” or “UNIT” for other bureaus in all caps in the Name ID field. Enter the superintendent’s or designated authority’s name and title on this screen.

You only have to enter the NPS Unit or Unit record once. You can modify the record as needed when changes occur at the unit.

For additional information on the NPS Unit and Unit record, also see Section II.B of Chapter 5.

3. How do I print the reports and forms from the Loans Out associated module?

To print any of the loan report forms:

- Go to the loan record in the Record Pane.

- Click on the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- Select the report name.

- Click Run for Current Record Only

Note: For the forms to print correctly, you must enter data in the fields in the Loans Out associated module that are mapped to the forms. The manual and on-line help will tell you which fields map to the reports.
4. **How do I print the Outgoing Loan Agreement?**

   To print the outgoing loan agreement, in the Proficio Reports window, select the form appropriate for your unit:

   - 10-127 Outgoing Loan Agreement
   - BOR Outgoing Loan Agreement
   - DOI Outgoing Loan Agreement
   - USGS Outgoing Loan Agreement

   This is the first page of the report. After printing this page, select the continuation form appropriate for your unit:

   - 10-127c Outgoing Loan Agreement Continuation
   - BOR Outgoing Loan Agreement Continuation
   - DOI Outgoing Loan Agreement Continuation
   - USGS Outgoing Loan Agreement Continuation

   The program will complete all sections of the form except the signature and date sections and the Extension Termination Date field. You must obtain original signatures from the superintendent and the borrower.

   **Note:** To print a blank version of this report, choose the 10-127 Blank Outgoing Loan Agreement.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

   You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of the form when using this option.

5. **How do I print the Conditions for Outgoing Loans (Form 10-127a) to attach to the outgoing loan agreement?**

   To print the NPS conditions for outgoing loans, in the Proficio Reports window, select:

   - 10-127a Conditions for Outgoing Loans.docx

   This is a 2-page Word document. When you click Run for Current Record Only, the conditions for outgoing loans document will open in a separate Microsoft Word window. Print the form as you would any other Word document.

   **For the NPS, the conditions must be attached to the loan agreement.**

6. **How do I print the Outgoing Loan Extension?**

   To print an outgoing loan extension, in the Proficio Reports window, select the form appropriate for your bureau:

   - 10-641 Outgoing Loan Extension
   - BOR Outgoing Loan Extension
   - DOI Outgoing Loan Extension

   The program will complete all sections of the form except the signature and date sections. You must obtain original signatures from the superintendent and the borrower.

   **Note:** To print a blank version of this report, choose the 10-641 Outgoing Loan Extension – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you
complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of the form when using this option.

7. How do I print the Outgoing Loan Folder Cover Sheet?

To print an outgoing loan folder cover sheet, in the Proficio Reports window, select the form appropriate for your bureau:

**10-640 Outgoing Loan Folder Cover Sheet**

For form 10-640, the program will complete Sections A-C. You must complete Sections D and E manually.

**Note:** To print a blank version of form 10-640, choose the 10-640 Outgoing Loan Folder Cover Sheet – Blank.docx or instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of the form when using this option.

**BOR Outgoing Loan Folder.docx**

This is a Word document. When you click Run for Current Record Only, the loan folder cover sheet will open in a separate Microsoft Word window. Print the form as you would any other Word document. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

8. How do I print the Object Condition Report to attach to the outgoing loan agreement?

To print an object condition report, you must go to the catalog records.

You can print the form for an individual catalog record or a group of catalog records by creating a tag set, filter or selecting multiple records in the List Pane.

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports ➔ Proficio Reports ➔ Proficio Reports.

- In the list of reports, select the 10-637 Object Condition Report or DOI Object Condition Report.

- Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.

The program will complete all sections of the form except the signature and date sections and the Condition on Return.

**Note:** Refer to Chapter 5, Reports and Forms, for additional information about the Object Condition Reports.
9. **How do I print the List of Objects to attach to the outgoing loan agreement?**

From the Loans Out record, you can print a blank BOR outgoing loan list that you can complete manually or on your computer.

From the Proficio Reports window, select **BOR Outgoing Loan List.docx**

The form will open in a separate Microsoft Word window. The program does not complete any sections of this form.

To print a list of objects, you must go to the catalog records.

You can print the form for an individual catalog record or a group of catalog records by creating a tag set, filter or selecting multiple records in the List Pane.

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- In the list of reports, select the **10-417 List of Objects, BOR List of Objects, or DOI List of Objects.**

- Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.

The program will complete all sections of the form except the number at the top right of the form (enter the outgoing loan number in this space) and the Comments column.

**Note:** Refer to Chapter 5, Reports and Forms, for additional information about the List of Objects reports.

10. **How do I print a report of the objects in the loan?**

To print a list of objects in the loan, in the Proficio Reports window, select:

**Outgoing Loan List**

The program will complete all sections of the report including a list of the objects associated with the loan.

11. **How do I print the Notice of Potential Hazard in Museum Collections?**

To print the notice of potential hazard in museum collections, in the Proficio Reports window, select:

**DI-3220 Notice of Potential Hazard in Museum Collections.docx**

This form acknowledges receipt of information on potentially toxic substances in museum collections. It is completed manually.

This is a Word document. When you click Run for Current Record Only, the notice will open in a separate Microsoft Word window. Print the form as you would any other Word document.

12. **How do I print a report of loan costs?**

To print a report showing loan costs for an individual loan or group of loans, first, create a tag set, filter or select multiple records in the List Pane. Then,

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- In the list of reports, select **LOANCOST.**

- Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.
The program will complete all sections of the report including a total cost for all listed loans.

**Note:** You must have completed the Value and Loan Cost fields on the Loan Administration tab located on the Main Information tab.
V. LOANS IN ASSOCIATED MODULE

A. Overview

1. **When do I use the Loans In associated module?**

   Use the Loans In associated module to document and track incoming loans and print loan forms.

   *For NPS, You must complete an Incoming Loan Agreement, Form 10-98, for all incoming loans. You cannot substitute a non-NPS form for Form 10-98.*

   **NPS Note:** You do not have to complete an Incoming Loans Agreement, Form 10-98, for loans from other NPS units. The Outgoing Loan Agreement, Form 10-127, from the other unit serves as the loan document.

2. **Where can I find information on incoming loans?**

   Refer to the *Museum Handbook*, Part II (MH-II), Chapter 2, Accessioning, or the *Museum Property Handbook*, Volume II (MPH-II), Chapter 5, Incoming and Outgoing Loans, for general information and procedures for incoming loans. Refer to your site-specific procedures, if available.

3. **Must I use the Loans In associated module?**

   Yes. You are required to document and track all incoming loans, and use of this module meets that requirement. Using this module also makes your loan information readily available and links it to your catalog data.

4. **How do I get to the Loans In associated module?**

   To go to the Loans In associated module records:
   - from the Home page, select your Cultural Resources or Natural History directory by double-clicking, then double-click Loans In, or
   - from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Loans In, or
   - from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Loans In

5. **How can I view the loan record attached to a catalog record?**

   To view a loan for a specific object through the catalog record, go to the catalog record, select the Supplemental Information tab in the Record Pane and choose the Loans In supplemental.

   Select the specific loans in supplemental record and click View. A new window will open displaying the Loans In supplemental information.
Click on the link icon on the Loan ID field and the Loans In associated module record will open in a new window.

6. **How many screens does the Loans In associated module have?**

   The Loans In associated module consists of 5 screens:
   - Main Information
   - Extended Information
   - Items on Loan
   - Images
   - Multimedia

7. **What is the Items on Loan tab?**

   The Items on Loan tab allows you to view and attach objects to an incoming loan record. When you attach objects, the program automatically creates a Loans In supplemental record for each object.

   **Note:** You must catalog the objects to use this feature.

8. **What are the Images and Multimedia tabs used for in the Loans In associated module?**

   The Images tab allows you to attach digital images of the incoming loan items. You may want to photograph the items when they are received – especially if you will not be cataloging them. The Multimedia tab allows you to attach other media files such as video and sound clips, incoming condition report documents, spreadsheets, PDF files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

9. **How will I know which data are needed to complete the incoming loan forms?**

   The instructions in this manual and the on-line help will indicate which fields are needed to complete the loan forms.

10. **How do I add to or change information on an existing loan record?**

    From the Loans In screen:
    - click on the modify icon on the button bar, or
    - go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
    - press the F10 key
The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

**Note:** You cannot modify the Loan ID number.

### B. Adding an Incoming Loan Record

1. **How do I add an incoming loan record?**

   From the Loans In record screen:
   - click on the add icon on the button bar, or
   - go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
   - press the F9 key

   A new window will open and you will see “Add Mode” in the lower right corner. You can then add and save a record.

   ![Image of the Loans In record screen](image)

2. **How do I move through the record?**

   **Within the Field**
   Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

   **Field to Field**
   Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

   **Page to Page**
   Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. **How do I cancel a record?**

   To cancel the record without saving the data:
   - click the Cancel link on the bottom right of the screen, or
   - click the Cancel button on the button bar, or
4. **How do I save a record?**

To save the entire record:

- click the **Save and Close** link at the bottom right of the screen, *or*
- click the Save and Close icon on the button bar, *or*
- go to File on the menu bar and select Save and Close

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. **How do I delete an incoming loan record?**

From the Loans In screen:

- Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.
- Choose Delete This Record
- Click Yes when the program asks if you are sure you want to delete the record.

6. **How do I complete the data fields on the Main Information screen?**

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Loan ID**

Straight entry field. This field maps to all incoming loan forms. **To save the record, you must complete this field.**

**NPS Loan ID format:**

```
NPS Loan ID format:

<table>
<thead>
<tr>
<th>Loan ID</th>
<th>PARK</th>
<th>-</th>
<th>00000</th>
</tr>
</thead>
</table>
```

**The NPS treats incoming loans as accessions. You must assign an accession number to the loan and complete an accession record for the loan in the Accession Records associated module (Section I). The accession number serves as the loan identification number.**

The NPS Loan ID has three parts:

a. The first part is the four-letter park acronym, in the form of “AAAA.” *(Note: The acronym will autofill from the record you were viewing when you began to Add a new record.)*

b. The second part is a hyphen, which distinguishes the accession number from the catalog number. *(Note: The hyphen will also autofill from the record you were viewing.)*

c. The third part is the 5-digit identification number assigned to an accession, for example, 99999. The program automatically pads the number with zeroes.

Example: WASO-00010

DOI Loan ID format:

Enter the number for the incoming loan using a standard format. The first part of the Loan ID number should be your unit acronym. This is a regular, unedited, 60-character field.

Example: BLM 2007.05

Note: Once you have saved the record and attached catalog records to it, you cannot edit this field. The catalog records (for the objects in the loan) relate to the loan record through the Loan ID number. You cannot change this number because you would lose the relationship between the objects and the loan. Be sure to check the Loan ID number and make any corrections to the number before you save the loan record and attach any catalog records. If you save an incorrect number, you can either delete the record and add a new one, or copy the record first (changing the number) and then delete the incorrect record.

Loan In Status

Bureau-controlled table (F5). You may not add to, delete, or modify terms in this table.

Enter the status of the incoming loan. Choose one of the terms from the table: active, converted to gift, pending, or returned.

As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Purpose

User-built table (F5, Ctrl-F5). This field maps to the incoming loan agreement.

Enter the purpose for the loan. Preferred entries are: exhibition, research, and storage.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

Start Date

Date field. This field maps to the incoming loan agreement.

Enter the starting date for the loan. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2006

End Date

Date field. This field maps to the incoming loan agreement.
Enter the termination date for the loan. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2007

**Loan Description (Loan Desc)**

Enter a brief description of the loan. This information will appear in the Notes field of the Loans In supplemental record.

Example: Two prints of Civil War battles loaned to the park for a temporary exhibit.

**Loan Memo**

Memo field (F12 to expand).

Use this field to enter any additional information about the loan, such as background information about the lender or notes on correspondence.

**Directory (required to attach object catalog records to the loan)**

Stacked table of directories (F5, F12 to expand) that are available on your system.

Choose the directory or directories that contain(s) the catalog records for the objects in the loan.

**Note:** You can only use this function if you have entered cataloged records for the objects in the loan into the database.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

**Note:** You must choose a directory in order to attach the catalog records to the incoming loan record.

If the catalog records in the loan come from more than one directory, you can make multiple entries from the expanded field (F12). After entering the first directory, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another directory from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Lender Information**

This is the first tab on the lower half of the Main Information screen.

**Lender Individual (Lender Ind.) or Lender Institution (Lender Inst.)**

If the lender is an individual, use the Lender Individual field. If the lender is an institution, use the Lender Institution field. **Do not use both fields in the same record.**

User-built table (F5, Ctrl-F5) that links to the Names and Addresses associated module. These fields map to the incoming loan agreement. **To save the record, you must complete one of these fields.**

Enter the name of the individual or institution that is lending the material.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the
person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. After entering the name and address information of the individual or institution, click Save and Close. The entry you add will appear in the table. You can then select it from the table.

Press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

**Note:** You must complete the following fields on the Names and Addresses screen for the lender. These will print on the incoming loan agreement:

- **Name ID** - enter the name of the lender in all caps
- **First and Last Name and Title** - enter the name and title of the responsible official, if the lender is an institution
- **Division/Unit** - enter the name of the department within the institution, if appropriate
- **Phone** - enter the lender's phone number
- **Fax** - enter the lender's fax number
- **Primary Address:**
  - **Address 1 and 2** - enter the lender's address
  - **City/St/Zip** - enter the lender's city, state and zip code
- **Alternate Address:**
  - Complete these fields if the shipping address is different from the mailing address.
- **Type** - enter Lender
- **NPS** - enter NPS or non-NPS
- **(DOI - enter DOI or non-DOI)**

**Formatted Memo field.** Press F12 or click the formatted memo icon to expand the field. The field will also expand as you begin to type.

The field will expand into two subfields: Responsible Official, and Title. An underline separates the subfield entries on the screen.

For loans from institutions, enter the name and title of the person or official responsible for the loan on behalf of the lender.
**Phone**

Straight entry field.

Enter the area code and phone number of the person or official responsible for the loan on behalf of the lender.

**Credit Line**

Memo field (F12 to expand). This field maps to the incoming loan agreement.

Record the lender’s credit line as it is to appear in exhibit graphics, publications, or other media. If a credit line is not applicable, enter N/A.

Example: Courtesy of the Strong Museum.

**Shipping Information**

To access the shipping information fields click on the Shipping Information tab or press Ctrl-N until the tab is selected.

**Insurance Paid By**  
*(Insur. Pd By)*

User-built table (F5, Ctrl-F5). This field maps to the incoming loan agreement.

Enter one of the following: Borrower, Lender, or Waived, or add an entry of your choice. This is the party who will pay the costs of insurance.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click **Save Change**, then click **Select** to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Shipping Paid By**  
*(Ship Pd By)*

User-built table (F5, Ctrl-F5). This field maps to the incoming loan agreement.

Enter one of the following: Borrower or Lender, or add an entry of your choice.

This is the party who will pay the costs of shipping.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.
Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Insurer**

User-built table (F5, Ctrl-F5) that links to the Names and Addresses associated module. This field maps to the incoming loan agreement.

Enter the name of the insurance company that is insuring the objects in the loan, if applicable.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. After entering the name and address information of the individual or institution, click Save and Close. The entry you add will appear in the table. You can then select it from the table.

**Note:** Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

Press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

**Policy**

Straight entry field. This field maps to the incoming loan agreement.

Enter the policy number for the insurance, if applicable.

**Special**

Memo field (F12 to expand). This field maps to the incoming loan agreement.

Indicate whether a facilities report is required. Enter special instructions or conditions concerning the loan. This information will appear under "Additional Loan Conditions" on the incoming loan agreement.

**Loan Administration**

To access the loan administration fields, click on the Loan Administration tab or press Ctrl-N until the tab is selected.
**Loan Approval**

(Loan Appr)

User-built table (F5, Ctrl-F5).

Enter the superintendent's or designated authority’s name.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Approval Date**

Date field.

Enter the date that the designated authority signed the incoming loan agreement. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2006

**Value**

Numeric field.

Enter the total value of the objects in the loan. The field includes two decimal places.

**Loan Preparator**

(Loan Prep)

User-built table (F5, Ctrl-F5).

Enter the name of the person who processed the loan.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.
Press Ctrl-Delete to remove unwanted entries.

**Preparation Date**

Date field.

Enter the date that the loan was processed. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/1/2006

**Loan Cost**

Numeric field.

Enter the total cost of the loan. The field includes two decimal places. Include insurance costs and costs for packing and shipping the loan.

**Packer**

User-built table (F5, Ctrl-F5). This field maps to the incoming loan agreement.

Enter the name of the person or company that packed the objects in the loan.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Ship Date**

Date field.

Enter the shipping date. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/10/2006

**Received By**

User-built table (F5, Ctrl-F5). (Recv By)

Enter the name of the person who received the objects at the site.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.
**Received Date**

Date field.

Enter the date on which you received the loan. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/15/2006

**7. How do I complete the data fields on the Extended Information screen?**

To access the fields on the Extended Information screen, click on the Extended Information tab or press Ctrl-N to go to the next page.

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Objects**

Memo field (F12 to expand). This field maps to the incoming loan agreement and extension.

For loans of a few objects, enter a list of objects in this field. For each object, include the object name, a brief description, the item count or quantity, the condition, and value, if applicable.

**Note:** For large loans, for NPS enter "See Accession Receiving Report Continuation Sheet". For DOI, enter “See DOI Incoming Loan List” for large loans. Then attach a copy of the NPS Accession Receiving Report Continuation Sheet (Form 10-95c) which lists the objects in the incoming loan, or the DOI Incoming Loan List to the loan agreement which includes the entire text of the Objects field.

**Shipping Method**  
*(Ship Method)*

Memo field (F12 to expand). This field maps to the incoming loan agreement.

Enter the method of shipping.

Example: U.S. Mail  
Art Transport

**Return Method**

Memo field (F12 to expand). This field maps to the incoming loan agreement.
Enter the name of the person or company who will pack the objects to return the loan. Enter the method of shipping you will use to return the loan.

Example: Borrower will pack objects for return in the same way the objects were sent or will improve the packing. Return shipping will be by an art transport company.

**Return Status**

Memo field (F12 to expand). This field maps to the incoming loan agreement.

Enter "Complete" if the unit has returned the entire loan. If the unit has returned only part of the loan, list the returned objects and the date of return.

**Extension**

Formatted memo field. Press F12 or click the formatted memo icon to expand the field. The field will also expand as you begin to type. The field will expand into six subfields: Requested Extension Length, Extension Length, Extension Not Granted, Previous Extensions, Date Extended, and Comments. An underline separates the subfield entries on the main screen.

All the subfields are memo fields. Press F12 to expand the field.

**Note:** Some loans are extended numerous times. The data in the Extension field should reflect the most recent extension. Enter documentation about previous extensions in the Previous Extensions and Comments fields.

**Requested Extension Length (Request Len Ext) (memo field):**

Enter the length of the extension you are requesting.

Example: 3 years

**Extension Length (Length of Ext) (memo field):**

Enter the length of the extension granted by the lender.

Example: 2 years

**Extension Not Granted (Ext Not Granted) (memo field):**

Enter an explanation for why the extension was not granted, if applicable.

**Previous Extensions (memo field):**

Enter the dates for previous extensions. Use a beginning and ending year. Separate entries with a comma.


**Date Extended (memo field):**

Enter the date to which the loan was extended. This becomes the new termination date for the loan. This date is also displayed next to the original End Date on the Main Information screen of the loan record.

**Comments (memo field):**

Enter comments or additional conditions concerning the extension.
8. Can the information from the Loans In record be used to create the Accession record?

Yes, you can transfer the Loans In information to the Accession associated module after you save the Loans In record.

- On the main information screen while in View Mode, click the Transfer to Accessions link next to the Loan ID field. A transfer window will open.

- Choose the scope:
  - **Selected Item(s)** – will transfer the current Loans In record or several if you have multiple records selected in the List Pane, or
  - **All Visible Items** – will transfer all Loans In records in the visible data. You can limit the visible data by creating and activating a tag set or filter.

- Choose what to do if a duplicate accession record already exists:
  - **Ignore the duplicate record** – does not transfer records that have matching accession numbers.
  - **Update the target record** – updates the matching accession record with information from the Loans In record.
  - **Add a duplicate record** – adds another accession record with the same accession number so that you may compare the entries (this option is not recommended).

- Click **Transfer** and then Yes to the “Are you sure…” question.

**Note:** You can view the related accession record of an incoming loan by clicking the Loan ID link on the Loans In record. The accession record will open in a separate window.

9. How do I complete the fields on the Items on Loan tab?

**To use the Items on Loan tab, you must catalog the objects in the incoming loan.**

If you catalog the objects, the program will automatically complete the fields on the Items on Loan tab when you attach catalog records to the loan. To use this feature on a group of catalog records:

- Go to the catalog records and create a tag set of all the objects in the loan. See Section XI of Chapter 6 for information on creating tag sets.
You can also set a filter or select multiple items in the List Pane of the catalog records.

- Go to Edit on the menu bar and select Mass Supplemental Update. Refer to Section I of Chapter 3 for further information on Mass Supplemental Update.

- You can attach the catalog records to an existing incoming loan record or create a new incoming loan record during the Mass Supplemental Update.

When you re-enter the Loans In associated module, the Items on Loan tab will include the objects. The program automatically completes the Directory, Table, Status, Start and End Date columns using data from the loan record. The catalog number, object name, and value are filled in from the catalog record. Refer to Section B.11 below for information on how to change the data in the list.

**Note:** The program also creates a Loans In supplemental record for each object on the list. The supplemental record attaches loan information to the catalog record for each object in the loan. Refer to Section X of Chapter 3 for information on the Loans In supplemental record.

10. **Can I attach catalog records from the Items on Loan tab of the loan record?**

Yes, if there are only a few records to attach. For a large loan, it is much easier to use the Mass Supplemental Update from the catalog records on a tag set or group of records.

However, you may want to make manual additions, modifications, or deletions to an existing list.

11. **How do I manually add, modify, or delete objects on the Items on Loan tab?**

To add, modify or delete objects from a loan record:

- First, add and save an incoming loan record. You cannot attach objects to a loan record until it is saved.

- Go to the Items on Loan tab of the loan record. You can be in any mode to add, modify and delete items from the list.

**Add an Item**

Click on Add above the item list on the right. The Mass Supplemental Update window for the associated module will open.
• If you have listed more than one directory in the loan record’s Directory field, select the directory where the catalog record is found.

![Image of Mass Supplemental Update - Catalog Record Selection](image)

• In the Choose a catalog record field click the catalog icon or press F5 to access the list of catalog records. Type the catalog number in the Term Selector or select the record from the list. Click Select.

![Image of Term Selector](image)

Note: The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data in the list. The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.

• Click Next after you have selected the catalog record.

• The fields for the supplemental are autofilled from the loan record. You can keep these automatic values and click Next. Or to modify any of these fields, select the “Manually update value” option on the pull down menu next to the field.
• Complete the fields for the supplemental record as follows:

Loans In Supplemental Update

**Status:** This is the loan status autofilled from the loan record. To choose a different status for this catalog record only, press F5 or click the down arrow icon to access the list.

**Start Date:** Enter the beginning date for the loan.

**End Date:** Enter the ending date for the loan.

**Notes:** The Loan Description autofills into the Notes field. Enter any additional information about the loan.

**Note:** The information entered in the Loans In Supplemental Update does not transfer back to the loan record.

**Note:** You cannot insert a value from this screen. The information in the value column is pulled from the Appraisal supplemental on the catalog record. To change this value, go to the catalog record Supplemental Information tab and choose the Appraisal supplemental. Add or edit an appraisal supplemental record to reflect the current value.

• When finished editing the fields, click Next.

• On the report window of how many will be added or updated (it will only add or update 1 record at a time), click Finish to make the changes.

*Modify an Item*

On the Items on Loan tab, select an object in the list and click Edit above the list on the right. The Mass Supplemental Update window for the associated module will appear. It will already be on the Loans In Supplemental data entry screen (see above). Modify the information on any field as described above. Click Next and then Finish to save the modifications.

*Delete an Item*

On the Items on Loan tab, select an object in the list and click Delete. A similar Mass Supplemental Update window will appear. Click Next and then Finish to delete the object from the list. This will remove an item from the loan list but not from the catalog database.
**Note:** The program also creates a Loans In supplemental record for each object on the list. Any changes you make on the item list screen appear in the supplemental record. If you delete an item from the list, the corresponding Loans In supplemental is also deleted. Refer to Section X of Chapter 3 for information on the Loans In supplemental record.

**View the Catalog Record for the Item**

On the Items on Loan tab, select an object in the list and click View above the list or click the link icon next to the catalog number in the list. The catalog record will open in a new window. Click Close when finished viewing.

**12. Can I print the list of catalog records on the Items on Loan tab?**

Yes, you can print the list of catalog records that appear on the Items on Loan tab.

To print the list of catalog records, click Print on the Items on Loan tab. A print preview window will open.

To print the report, choose Print on the File menu, or click one of the print buttons on the button bar. You can also export or email this document using the options on the File menu or button bar.

**C. Printing the Incoming Loan Forms**

**1. What forms and reports can I print from the Loans In associated module?**

You can print the following forms and reports from the Loans In associated module:

- Blank Incoming Loan Agreement.docx (10-98) (2 pages)
- Incoming Loan Agreement (10-98)
- Conditions for Incoming Loans.docx (10-98a) (2 pages)
- Incoming Loan Extension (10-98b)
- Incoming Loan Extension – Blank.docx (10-98b)
- Incoming Loan Agreement Continuation (10-98c)
- BOR Incoming Loan Agreement
- BOR Incoming Loan Agreement Continuation
- BOR Incoming Loan Extension
- BOR Incoming Loan Extension-Blank.docx
- BOR Incoming Loan Folder.docx
- BOR Incoming Loan List
- BOR Incoming Loan List.docx
For NPS, you will also use the Accession Receiving Report Continuation Sheet (Form 10-95c), the Object Condition Report (Form 10-637) and the List of Objects (Form 10-417) when documenting loans. You must access these forms from the accession or catalog record screen.

For additional information, refer to Chapter 5, Reports and Forms.

Note: The program will complete the forms or allow you to print blank forms. Use acid-free paper for printing forms.

2. How do I complete the NPS or DOI Unit section of the forms?

Many forms contain a section for the name and address of the unit. To have the program print this information on the forms, you must complete an entry in the Names and Addresses associated module. See Section XII of this chapter. Enter “NPS UNIT” or “UNIT” for other bureaus in all caps in the Name ID field. Enter the superintendent’s or designated authority’s name and title on this screen.

You only have to enter the NPS Unit or Unit record once. You can modify the record as needed when changes occur at the unit.

For additional information on the NPS Unit and Unit record, also see Section II.B of Chapter 5.

3. How do I print the reports and forms from the Loans In associated module?

To print any of the loan report forms:

- Go to the loan record in the Record Pane.

- Click on the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- Select the report name.

- Click Run for Current Record Only

Note: For the forms to print correctly, you must enter data in the fields in the Loans In associated module that are mapped to the forms. The manual and on-line help will tell you which fields map to reports.
4. **How do I print the Incoming Loan Agreement?**

To print the incoming loan agreement, in the Proficio Reports window, select the form appropriate for your unit:

- **10-98 Incoming Loan Agreement**
- **BOR Incoming Loan Agreement**
- **DOI Incoming Loan Agreement**
- **USGS Incoming Loan Agreement**

This is the first page of the report. After printing this page, select the continuation form appropriate for your unit:

- **10-98c Incoming Loan Agreement Continuation**
- **BOR Incoming Loan Agreement Continuation**
- **USGS Incoming Loan Agreement Continuation**

**Note:** The DOI Incoming Loan Agreement does not have a continuation page.

The program will complete all sections of the form except the signature and date sections. You must obtain original signatures from the superintendent or designated authority and the lender.

**Note:** To print a blank version of this report, choose the 10-98 Blank Incoming Loan Agreement.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of the form when using this option.
5. **How do I print the Conditions for Incoming Loans (Form 10-98a) to attach to the incoming loan agreement?**

To print the conditions for incoming loans, in the Proficio Reports window, select:

*10-98a Conditions for Incoming Loans.docx*

This is a 2-page Word document. When you click Run for Current Record Only, the conditions for incoming loans document will open in a separate Microsoft Word window. Print the form as you would any other Word document.

| For NPS, the conditions must be attached to the loan agreement. |

6. **How do I print the Accession Receiving Report Continuation sheet (Form 10-95c)?**

**Note:** Use NPS Form 10-95c to attach to the incoming loan agreement for large loans that have not been cataloged.

To print an accession receiving report continuation sheet, you must go to the corresponding accession record screen:

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.
- In the list of reports, select the *10-95c Accession Receiving Report Continuation Sheet*.
- Click Run for Current Record Only.

The program will complete all sections of the form.

**Note:** Refer to Chapter 5, Reports and Forms, for additional information about the Accession Receiving Report Continuation sheet (Form 10-95c).

7. **How do I print the Incoming Loan List for incoming loans that have not been cataloged?**

**Note:** Use the Incoming Loan List to attach to the incoming loan agreement for large loans that have not been cataloged.

The Incoming Loan List is printed from the Loans In associated module record. To print the Incoming Loan List, in the Proficio Reports window, select the form appropriate for your unit:

*BOR Incoming Loan List*
*DOI Incoming Loan List*

The program will complete all sections of the form. The entire contents of the Objects field on the Loans In record will appear.

**Note:** To print a blank version of this report, choose the *DOI Incoming Loan List.docx* or *BOR Incoming Loan List.docx* instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.
8. **How do I print the Object Condition Report (Form 10-637) to attach to the incoming loan agreement?**

To print an object condition report, you must go to the catalog records.

You can print the form for an individual catalog record or a group of catalog records by creating a tag set, filter or selecting multiple records in the List Pane.

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.
- In the list of reports, select the **10-637 Object Condition Report**.
- Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.

The program will complete all sections of the form except the signature and date sections and the Condition on Return.

**Note:** Refer to Chapter 5, Reports and Forms, for additional information about the Object Condition Report (Form 10-637).

9. **How do I print the List of Objects to attach to the incoming loan agreement?**

To print a list of objects, you must go to the catalog records screen.

You can print the form for an individual catalog record or a group of catalog records by creating a tag set, filter or selecting multiple records in the List Pane.

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.
- In the list of reports, select the **10-417 List of Objects** or **DOI List of Objects** or **BOR List of Objects**.
- Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.

The program will complete all sections of the form except the number at the top right of the form (enter the accession number in this space) and the Comments column.

**Note:** Refer to Chapter 5, Reports and Forms, for additional information about the List of Objects forms.

10. **How do I print the Incoming Loan Extension?**

To print the incoming loan extension, in the Proficio Reports window, select the form appropriate for your unit:

**10-98b Incoming Loan Extension**
**BOR Incoming Loan Extension**

The program will complete all sections of the form except the signature and date sections. You must obtain original signatures from the superintendent or designated authority and the lender.

**Note:** To print a blank version of this report, choose the **10-98b Incoming Loan Extension - Blank.docx** or **BOR Incoming Loan Extension-Blank.docx** instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the
11. **How do I print a report of the objects in the loan that have been cataloged?**

   form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

   **Note:** You must catalog the objects in the loan before you use this report.

   To print an incoming loan report from the loan record, in the Proficio Reports window, select:

   **Incoming Loan List**

   The program will complete all sections of the report.
VI. MAINTENANCE ASSOCIATED MODULE

A. Overview

1. When do I use the Maintenance associated module?

Use the Maintenance associated module to document and track routine maintenance tasks and schedules. Maintenance records can be associated with specific object records, staff members, locations, and/or tasks.

You can also print Museum Housekeeping Plan (MHP) task sheets and tracking schedules from this module.

2. Where can I find information on routine maintenance and MHP task sheets and schedules?

Refer to the Museum Handbook, Part I (MH-I), Chapter 13, Museum Housekeeping, or the Museum Property Handbook, Volume I (MPH-I), Chapter 7, Housekeeping: Preventative Conservation, for general information and procedures on museum housekeeping. These chapters contain information on task sheets and tracking schedules. Refer to your site-specific maintenance procedures, if available.

3. Must I use the Maintenance associated module?

No. Use of this feature is optional but recommended. The NPS requires a written housekeeping plan for every space that houses museum collections. Use of this module will assist you with creating and implementing housekeeping plans. Using this module also makes your maintenance information readily available and links it to your catalog data.

4. How do I get to the Maintenance associated module?

To go to the Maintenance associated module records:

- from the Home page, select your Cultural Resources directory by double-clicking, then double-click Maintenance, or
- from the Navigation Pane, expand the Cultural Resources directory tree and select Maintenance, or
- from your Cultural Resources directory, go to View on the menu bar, select Go To at the bottom, then choose Maintenance.

5. How many screens does the Maintenance associated module have?

The maintenance associated module consists of 4 screens:

- Main Information
- Extended Information
6. **What are the Images and Multimedia tabs used for in the Maintenance associated module?**

The Images tab allows you to attach before and after images of the object or area referenced in the maintenance record. The Multimedia tab allows you to attach other media files such as video and sound clips, documents, spreadsheets, PDF files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

7. **How do I add to or change information on an existing maintenance record?**

From the maintenance screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

8. **Can I access the maintenance records from the catalog record screen?**

Yes. You can add, view, edit and delete Maintenance associated module records through the Maintenance supplemental in the catalog record. On the catalog record, go to the Supplemental Information tab and select the Maintenance supplemental. Click add, or select an existing maintenance supplemental and click edit, view, or delete. The Maintenance associated module screen will appear in the mode you selected (add, modify, view).

If you are adding or modifying a maintenance record, complete the maintenance screen as described below.

If you are deleting the maintenance record, the system will ask you if you are sure you want to delete the selected maintenance record which includes both the supplemental and the Maintenance associated module record.

9. **How will I know which data are needed to complete task sheets and tracking schedules?**

The instructions in this manual and the on-line help will indicate which fields are needed to complete task sheets and schedules.

---

**B. Adding a Maintenance Record**

1. **How do I add a maintenance record?**

From the maintenance record screen:

- click on the add icon on the button bar, or
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
- press the F9 key

A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.
2. How do I move through the record?

Within the Field
Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

Field to Field
Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

Page to Page
Click on the Extended Information tab or press Ctrl-N.

3. How do I cancel a record?

To cancel the record without saving the data:

- click the Cancel link on the bottom right of the screen, or
- click the Cancel button on the button bar, or
- go to File on the menu bar and select Cancel

4. How do I save a record?

To save the entire record:

- click the Save and Close link at the bottom right of the screen, or
- click the Save and Close icon on the button bar, or
- go to File on the menu bar and select Save and Close

5. How do I complete the data fields on the Maintenance Information screen?

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press the Tab key to move out of a field.

Note: None of the fields in the Maintenance associated module are mandatory.
Catalog Number
(Catalog #)

For NPS, this is a 3-part, 12 character field.
For DOI, this is a regular, unedited, 60-character field.

NPS Catalog Number format:

- The first part is the four-letter park acronym, in the form of "AAAA."
- Leave this space blank if the park has only one collection.
- If the park has different units that have separate accession and catalog systems, enter a collection designation in the form of a letter, for example, A, B, C. Only a few parks will use this designation.
- The third part is the unique sequential number assigned to an object, for example, 9999999.

Example: SHEN 190
COLOY3456 [The Colonial NHP number contains a Y as a designation for the Yorktown collection.]

DOI Catalog Number format:

Enter a catalog number for an existing object.

Example: BIA 1988.01.33

The catalog number field links the maintenance record to the corresponding catalog record.

After you enter the catalog number, the program displays the catalog and accession numbers, object name, and a brief description of the object in the memo field below the catalog number. You cannot modify this field.

Due Date

Date field.

Enter the date you must perform the maintenance. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day. Remember to update this date regularly.

Example: 2/9/2015

Note: The program uses the catalog number and due date fields together to create a unique record. You cannot have two maintenance records for the same catalog number if they both have the same due dates or blank due dates.

Purpose

Memo field (F12 to expand).

Enter an explanation for the maintenance.
Example: To prevent dust and dirt accumulation that would require washing and to prevent stress on fabric from folds.

**Task**

Memo field (F12 to expand). This field maps to the MHP task sheet and tracking schedules.

Enter the name of the maintenance task that you will do.

Example: Inspect for insect infestation
Refold
Vacuum if needed

**Note:** Describe tasks concisely so that they will fit on the schedules. Enter each task on a separate line and double-space between lines.

**If...**

you perform the same task throughout the year but at different frequencies throughout the seasons

**Then...**

you may want to create multiple records for the task.

Give the task a different name for each season and adjust the frequency field to allow for the different time intervals. This will assist you in printing MHP tracking schedules.

For example, you may want to create records for winter dusting, summer dusting, and spring and fall dusting. The records might be identical except for the frequency field.

**Frequency**

User-built table (F5, Ctrl-F5). This field maps to the MHP task sheet and tracking schedules.

Enter a term that describes how often you should perform the task.

Example: Weekly Day 1

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Equipment/Supplies (Equip/Suppl)**

User-built, stacked table (F5, Ctrl-F5, F12 to expand). This field maps to the MHP task sheet.

Enter the type of tools/equipment you will need to perform the maintenance.

Example: vacuum cleaner --screen --magnifying glass

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select
terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field. The expanded field (F12) also allows users to add, delete, and edit.

You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Procedure**

Memo field (F12 to expand). This field maps to the MHP task sheet.

Enter the procedures you will follow to perform the maintenance. Describe how you will accomplish the task safely, appropriately, and effectively.

Example: Place vacuum on lowest suction level. Vacuum small areas at a time through the screen. Do not let the screen touch the fabric.

**Caution**

Memo field (F12 to expand). This field maps to the MHP task sheet.

Enter any physical hazards associated with the task, such as the use of a toxic substance. If applicable, state the location of the related Material Safety Data Sheet (MSDS).

Example: Lid on stein has become loose; handle top and base separately.

Mouse traps were placed in southwest corner of Visitor Center on May 31. If a mouse has been caught, remove, reset trap, and notify IPM Coordinator. Use respiratory mask in this area.

MSDS located in Room 4, Cabinet 3, Arsenic Folder.

**Authorized By**

User-built table (F5, Ctrl-F5). This field maps to the MHP task sheet.

Enter the name of the person who authorized the work.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Authorized By Title**

Straight entry field. This field maps to the MHP task sheet.

Enter the title of the person who authorized the work.
**Authorized Date**  
*Auth Date)*  
Date field. This field maps to the MHP task sheet.  
Enter the date the work was authorized. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.  
Example: 2/9/2015

**Assigned To**  
User-built table (F5, Ctrl-F5). This field maps to the MHP task sheet and tracking schedules.  
Enter the name of the person who was assigned to do the work.  
As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.  
Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select *Browse Authority Table* or press Ctrl-F5, then click *Add Term*. After entering the term, click *Save Change*, then click *Select* to enter the term in the field.  
Press Ctrl-Delete to remove unwanted entries.

**Assigned To Title**  
*Assign Title)*  
Straight entry field. This field maps to the MHP task sheet.  
Enter the title of the person who was assigned to do the work.

**Completion Date**  
*Comp Date)*  
Date field.  
Enter the date work was completed. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.  
Example: 2/9/2015

6. **How do I complete the data fields on the Extended Information screen?**  
To access the fields on the extended information screen, single-click on the **Extended Information** tab or press Ctrl-N until the tab is selected.
**Special Skills & Training**

User-built, stacked table (F5, Ctrl-F5, F12 to expand). This field maps to the MHP task sheet.

Enter the special skills and training required to perform the maintenance task. If the task requires no special skills or training, enter “None”.

Example: Familiarity with security plan. Familiarity with handling techniques for museum collections.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field. The expanded field (F12) also allows users to add, delete, and edit.

You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Sources**

Memo field (F12 to expand). This field maps to the MHP task sheet.

Enter a list of sources of information that you used to develop the procedures for the task. Include published works and personal communications.

Example: HOCU IPM plan
“The Air Buster” User Manual
Housekeeping Plan for Officer’s Quarters #14
Sagamore Hill NHS Interpretive Prospectus

**Maintenance Location**

User-built, stacked table (F5, Ctrl-F5, F12 to expand). This field maps to the MHP task sheet and tracking schedules.

Enter a short description of the location where you will perform the maintenance.

Use this field if:

- the location where you perform the maintenance is different from the location of the object(s), or
- there are no objects specifically associated with this task.

Example: Visitor Center, Exhibit Space, Storage, Officer’s Quarters #14.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.
Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field. The expanded field (F12) also allows users to add, delete, and edit.

You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

Notes

Memo field (F12 to expand).

Enter any additional notes about the maintenance.

Example: Small hole noted near upper left corner at last inspection.

User 1

This is a user-defined field for maintenance. Use this field to enter unit-specific maintenance data that do not fit on the other fields.

Users with appropriate security rights may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change. Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.

C. Printing Task Sheets and Schedules

1. What reports can I print from the Maintenance associated module?

You can print the following reports from the Maintenance associated module:

Daily Tasks (by month)
Location Schedule (daily tasks by location)
Quarterly Tasks (by year)
Tasks (MHP task sheet)
taskststr (MHP task sheet – full description)
Weekly Tasks (by quarter)

Note: The program will complete the reports or allow you to print blank reports.

2. How do I print the reports from the Maintenance associated module?

To print any of the maintenance report forms:

- Go to the maintenance record in the Record Pane.

- Click on the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- Select the report name.
• Click **Run for Current Record Only**

**Note:** For the forms to print correctly, you must enter data in the fields in the Maintenance associated module that are mapped to the forms. The manual and on-line help will tell you which field maps to the reports.

3. **How do I print a MHP task sheet?**

To use this report, you must add and save a maintenance record that contains information on the task. Do not enter a catalog number on the maintenance record.

The fields map to the MHP Task Sheet as follows:

<table>
<thead>
<tr>
<th>Maintenance Screen Field</th>
<th>MHP Task Sheet Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance Location</td>
<td>Location</td>
</tr>
<tr>
<td>Task</td>
<td>Task</td>
</tr>
<tr>
<td>Frequency</td>
<td>Frequency</td>
</tr>
<tr>
<td>Procedure</td>
<td>Procedure</td>
</tr>
<tr>
<td>Caution</td>
<td>Cautions</td>
</tr>
<tr>
<td>Assigned To and Assigned Title</td>
<td>Currently Assigned To</td>
</tr>
<tr>
<td>Special Skills</td>
<td>Special Skills/Training</td>
</tr>
<tr>
<td>Equipment/Supplies</td>
<td>Supplies/Equipment</td>
</tr>
<tr>
<td>Sources</td>
<td>Sources</td>
</tr>
<tr>
<td>Authorized By</td>
<td>Authorized By</td>
</tr>
<tr>
<td>Authorized By Title</td>
<td>Title</td>
</tr>
<tr>
<td>Authorized Date</td>
<td>Date</td>
</tr>
</tbody>
</table>

To print a MHP task sheet, in the Proficio Reports window, select **Tasks**

The program will complete all sections of the report.

**Note:** If your Procedure and Caution fields contain more text than will print on the Tasks report, choose the **tasksstr** report instead. The tasksstr report allows the Procedure and Caution fields to stretch to include all text in these two fields.
4. **How do I get the unit name to print on the report?**

Each unit must complete an entry for the unit in the Names and Addresses associated module. See Section XII of this chapter. Enter “NPS UNIT” or “UNIT” for other bureaus in all caps in the Name ID field. Enter the superintendent’s or designated authority’s name and title on this screen. The program uses the NPS Unit or Unit entry to print the name of the unit at the top of MHP task sheets and schedules.

You only have to enter the NPS Unit or Unit record once. You can modify the record as needed when changes occur at the unit.

5. **How do I print a monthly schedule of daily maintenance tasks assigned to a staff member?**

To use this report, you must add and save a maintenance record that contains:

- No catalog number
- A list of tasks in the Task field (enter each task on a separate line, and double-space between lines)
- “DAILY” in the Frequency field
- A staff member’s name in the Assigned To field
- A location in the Maintenance Location field

To print the report, in the Proficio Reports window, select **Daily Tasks**

**Note:** Enter the month and year in the subtitle field in the Parameters panel on the left side of the Preview window. Then click Submit to preview the report.

The program will complete all sections of the report except the Comments section.

6. **How do I print a quarterly schedule of weekly maintenance tasks assigned to a staff member?**

To use this report, you must add and save a maintenance record that contains:

- No catalog number
- A list of tasks in the Task field (enter each task on a separate line, and double-space between lines)
- “WEEKLY” in the Frequency field
- A staff member’s name in the Assigned To field
- A location in the Maintenance Location field

To print the report, in the Proficio Reports window, select **Weekly Tasks**

**Note:** Enter the year and quarter in the subtitle field in the Parameters panel on the left side of the Preview window. Then click Submit to preview the report.

The program will complete all sections of the report except the Conditions section.

7. **How do I print a 3-year schedule of quarterly maintenance tasks assigned to a staff member?**

To use this report, you must add and save a maintenance record that contains:

- No catalog number
- A list of tasks in the Task field (enter each task on a separate line, and double-space between lines)
- “QUARTERLY” in the Frequency field
- A staff member’s name in the Assigned To field

**Note:** Enter the year and quarter in the subtitle field in the Parameters panel on the left side of the Preview window. Then click Submit to preview the report.

The program will complete all sections of the report except the Conditions section.
• A location in the Maintenance Location field

To print the report, in the Proficio Reports window, select

**Quarterly Tasks**

**Note:** Enter the year in the subtitle field in the Parameters panel on the left side of the Preview window. Then click Submit to preview the report.

The program will complete all sections of the report except the Comments section.

8. **How do I print a schedule of daily maintenance tasks by location?**

To use this report, you must add and save seven maintenance records that contain:

• No catalog numbers
• A list of tasks in the Task field (enter each task on a separate line, and double-space between lines)
• A day of the week in the Frequency field, using the following entries:
  - Weekly Day 1 [use this entry for Sunday]
  - Weekly Day 2 [use this entry for Monday]
  - Weekly Day 3 [use this entry for Tuesday]
  - Weekly Day 4 [use this entry for Wednesday]
  - Weekly Day 5 [use this entry for Thursday]
  - Weekly Day 6 [use this entry for Friday]
  - Weekly Day 7 [use this entry for Saturday]

  **Note:** Enter one record for each day of the week.

• A specific location, such as Exhibit Area, in the Maintenance Location field (the location must be the same on all seven records)

To print a daily schedule for a specific location, you must set a filter to include all the records from Weekly Day 1 to Weekly Day 7. To set the filter:

• Click on the Advanced Filter button 🚀 on the button bar, or go to Record on the menu bar and select Advanced Filter.
• In the Advanced Filter window, select Frequency (Fast Compare) in the Field pull down menu.
• For the Comparison, select Greater Than or Equal (Above) from the pull down menu.
• For the Value, type: Weekly Day 1.
• Click Add a New Filter Item at the lower left of the window and a new field entry line will appear.
• For the Field, select Frequency (Fast Compare) again from the pull down menu.
• For the Comparison on this line, select Less Than or Equal (Below) from the pull down menu.
• For the Value, type: Weekly Day 7.

Your filter window should look like this:
• Click Activate to set the filter.

“Filter” will appear on the status bar at the bottom left of the window.

Note: If you have multiple locations with weekly tasks, you can select a third filter item and choose Maintenance Location as the field, Contains (Has) as the comparison and enter the location for the value.

Refer to Section XI of Chapter 6 for information on setting a filter.

To print the report, in the Proficio Reports window, select

Location Schedule

Click Run for All Visible Records for this report.

The program will complete all sections of the report. The location will print below the unit name at the top center of the report.
VII. PREPARATION/TREATMENT ASSOCIATED MODULE

A. Overview

1. When do I use the Preparation/Treatment associated module?
Use the Preparation/Treatment associated module to document and track preparation/treatment of specimens that are part of the museum collection.

2. Where can I find information on preparation and treatment of natural history specimens?
Refer to the following appendices of the Museum Handbook, Part I (MH-I):
- Appendix Q: Curatorial Care of Natural History Collections
- Appendix T: Curatorial Care of Biological Collections
- Appendix U: Preventive Conservation of Paleontological and Geological Collections

Refer to the Conserve O Gram series for new titles relating to natural history collections.

Preparing and treating specimens is the job of a specialist. Do not attempt to prepare or treat specimens without training or consultation with a specialist. Refer to your site-specific procedures, if available.

3. Must I use the Preparation/Treatment associated module?
No. Use of this feature is optional but recommended. Using this module makes your preparation/treatment information readily available and links it to your catalog data. Some of the data in this module will print on the natural history labels.

4. How do I get to the Preparation/Treatment associated module?
To go to the Preparation/Treatment associated module records:
- from the Home Page, select your Natural History directory by double-clicking, then double-click Preparation/Treatment, or
- from the Navigation Pane, expand the Natural History directory tree and select Preparation/Treatment, or
- from your Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Preparation/Treatment.

The Preparation/Treatment associated module is not available for cultural resources records.

5. How many screens does the Preparation/Treatment associated module have?
The preparation/treatment associated module consists of 4 screens:
- Main Information
6. **What are the Images and Multimedia tabs used for in the Preparation/Treatment associated module?**

The Images tab allows you to attach images of the specimen referenced in the preparation/treatment record. You may wish to document the preparation or treatment process with before and after pictures. The Multimedia tab allows you to attach other media files such as video and sound clips, documents, spreadsheets, PDF files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

7. **How do I add to or change information on an existing preparation/treatment record?**

From the Preparation/Treatment screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see “Modify Mode” in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

8. **Can I access the preparation/treatment records from the catalog record screen?**

Yes. You can add, view, edit and delete Preparation/Treatment associated module records through the preparation/treatment supplemental in the catalog record. On the catalog record, go to the Supplemental Information tab and select the Preparation/Treatment supplemental. Click add, or select an existing Preparation/Treatment supplemental and click edit, view, or delete. The Preparation/Treatment associated module screen will appear in the mode you selected (add, modify, view).

If you are adding or modifying a preparation/treatment record, complete the Preparation/treatment screen as described below.

If you are deleting the preparation/treatment record, the system will ask you if you are sure you want to delete the selected preparation/treatment record which includes both the supplemental and the Preparation/Treatment associated module record.

9. **What reports can I print from the Preparation/Treatment associated module?**

There are no reports related to the Preparation/Treatment associated module. The reports listed under Re:discovery Reports relate to the Maintenance associated module, which is the cultural resources counterpart to the Preparation/Treatment associated module. You cannot run these reports from the Preparation/Treatment associated module.

10. **How will I know which data will map to the natural history labels?**

The data entry instructions in Section B below indicate which fields map to which labels.
B. Adding a Preparation/Treatment Record

1. How do I add a preparation/treatment record?

From the preparation/treatment record screen:

- click on the add icon on the button bar, or
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
- press the F9 key

A new window will open and you will see “Add Mode” in the lower right corner. You can then add and save a record.

Note: To add a preparation/treatment record from the catalog record screen, refer to Section A.7 above.

2. How do I move through the record?

Within the Field
Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

Field to Field
Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

Page to Page
Click on the Extended Information tab or press Ctrl-N (next).

3. How do I cancel a record?

To cancel the record without saving the data:

- click the Cancel link on the bottom right of the screen, or
- click the Cancel button on the button bar, or
- go to File on the menu bar and select Cancel
4. **How do I save a record?**

To save the entire record:

- click the **Save and Close** link at the bottom right of the screen, *or*
- click the Save and Close icon on the button bar, *or*
- go to File on the menu bar and select **Save and Close**

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. **How do I complete the data fields on the Preparation/Treatment Main Information screen?**

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press the Tab key to move out of a field.

**Note:** None of the fields in the Preparation/Treatment associated module are mandatory.

### Catalog Number (Catalog #)

For NPS, this is a 3-part, 12 character field.
For DOI, this is a regular, unedited, 60-character field.

**NPS Catalog Number format:**

<table>
<thead>
<tr>
<th>Catalog #</th>
<th></th>
<th></th>
</tr>
</thead>
</table>

a. The first part is the four-letter park acronym, in the form of "AAAA."

b. Leave this space blank if the park has only one collection.

If the park has different units that have separate accession and catalog systems, enter a collection designation in the form of a letter, for example, A, B, C. Only a few parks will use this designation.

c. The third part is the unique sequential number assigned to an object, for example, 9999999.

**Example:** SHEN 190  
COLOY3456 [The Colonial NHP number contains a Y as a designation for the Yorktown collection.]

**DOI Catalog Number format:**

<table>
<thead>
<tr>
<th>Catalog #</th>
</tr>
</thead>
</table>

Enter the catalog number for an existing object record.

**Example:** BLM 1967.03.37

The catalog number field links the preparation/treatment record to the corresponding catalog record. After you enter the catalog number, the program displays the catalog and accession numbers, specimen name, and a brief description of the specimen in the memo field below the catalog number. You cannot modify this field.

**Due Date**

Date field.

Enter the date for the next routine preparation/treatment, such as checking the fluid levels in containers. The program will autofill as you type. To view a
calendar and select the date, click the calendar icon and click on the day. Remember to update this date regularly.

Example: 2/9/2015

Note: The program uses the catalog number and due date fields together to create a unique record. You cannot have two preparation/treatment records for the same catalog number if they both have the same due dates or blank due dates.

Field Observation (Field Observ.)

Memo field (F12 to expand).

Enter pertinent notes about the specimen as recorded in the collector's field notes or other sources. You can cut and paste these from other electronic sources.

Example: information concerning the specimen's stability suggested procedures based on rock types or substrate

Condition on Receipt (Receipt Cond)

Memo field (F12 to expand).

Enter the condition of the material when it was received in the preparation or conservation laboratory. This provides a baseline description of the specimen prior to treatment.

Example: the specimen was in a plaster jacket the specimen was soaked with shellac the specimen was disarticulated

Development Notes (Devel Notes)

Memo field (F12 to expand).

Enter in journal-style format the step-by-step procedures taken during work on the piece. Record explanations (not justifications) of actions taken, mishaps, and repairs performed on the material.

Example: list the steps and tools used to remove the matrix from the piece, including use of hand tools, chisels, airabrasive (what powder at what pressure), airscribe, ultrasonic, sandblast, or whatever techniques were employed

Materials (Equip/Suppl)

Formatted memo field. Press F12 to expand or click the formatted memo icon. The field will also expand as you begin to type. The field expands into four subfields: Original Consolidant/Fixative, Adhesive, Stabilizer/Filler, and Notes. An underline separates the subfield entries on the main screen.

The first three subfields are user-built, stacked tables (F5, Ctrl-F5, F12 to expand). As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field. The expanded field (F12) also allows users to add, delete, and edit.
You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Original Consolidant/Fixative (Fixative) (user-built, stacked table):**
This field maps to the invertebrate label, invertebrate specimen label, vertebrate wet specimen label, and wet plant specimen label.

Enter the names of consolidants and fixatives that were used on the specimen. Enter proprietary and/or chemical names, if known. Include area-specific names.

Example: Picric Acid
         Formalin
         Glacial Acetic Acid
         Bouin’s fluid

**Adhesive (user-built, stacked table):**
Enter the names of adhesives that were used on the specimen. Enter proprietary and/or chemical names, if known. Include area-specific names.

**Stabilizer/Filler (user-built, stacked table):**
Enter the names of stabilizers and fillers that were used on the specimen. Include the proprietary and/or chemical names, if known. Include area-specific names.

**Notes (memo field):**
Enter comments about the materials. Note where the materials were used, if known.

Example: Note if any treatment has been undertaken to fortify the filler (such as mache soaked in butvar, etc.) Specify if "friendly plastic," melted vinyl, or other components have been added to the fillers.

**Comments**
Memo field (F12 to expand).

Enter the preparer's remarks or thoughts about the preparation/treatment. Describe the situation or the problem and the events that followed leading to the elimination of the problem. Include any prognoses, or suggested course(s) of action for future work.

**Storage Media (Strg Media)**
Memo field (F12 to expand). This field maps to the invertebrate label, invertebrate specimen label, vertebrate wet specimen label, and wet plant specimen label.

Enter the formula or media in which the specimen is stored.

Example: 70% ethanol, 5% formalin stored in the freezer

For paleontology specimens, record the nature of storage containers, if relevant.
**Preparator (Auth By)**

User-built, stacked table (F5, Ctrl-F5, F12 to expand) that links to the Names and Addresses associated module. This field maps to the vertebrate specimen label.

Enter, last name first, the full name of the preparator or person initiating the treatment. This can be the person who performed the work or the person responsible for oversight of the project.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

**Note:** Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash - - separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

**Preparation Date (Prep Date)**

Flexible date field.

Enter the date or period of time over which the treatment was performed. This may be the period of time in which the material was in the laboratory. Enter the most complete date possible and the full year.

Example: 11/18/2014 – 12/08/2014

You can enter the date directly or press F12 or click the calendar icon for the flexible date entry screen. The flexible date entry allows you to enter a beginning and ending date by century or year, month, and day. It includes a user-built table of modifiers, for entries such as "circa." Refer to Chapter 1, System Basics, for additional instructions on flexible date fields. Use of the flexible date screen is optional.
**Storage Media Date**  
*(Stg Media Dte)*  
Date field.  
Enter the date that the specimen was placed in the storage media. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day. Remember to update this date regularly.  
Example: 11/18/2014

**Hours**  
Straight entry field.  
Enter the number of hours workers used, or will need to prepare or treat the specimen.

6. **How do I complete the data fields on the Extended Information screen?**  
To access the fields on the extended information screen, single-click on the Extended Information tab or press Ctrl-N until the tab is selected.

**Casting and Molding**  
*(Cast Mold)*  
Memo field (F12 to expand).  
Record the nature of casts and the kinds of molding compounds used to make study or exhibit copies of the original material. Provide a complete description of the separator materials, types of epoxy, plaster, or other cast constituents, and the number of casts made from the mold.

**Treatment Concerns**  
*(Treat Concern)*  
Memo field (F12 to expand).  
Enter special instructions to be followed as a result of past treatments, such as special handling instructions. Enter potential problems to watch for, such as changes in color or brittleness.  
Example: hazardous for interpretive use  
watch for recurrence of bacterial infection

**User 1 – User 3**  
These are user-defined fields for preparation/treatment. Use these fields to enter unit-specific preparation/treatment data that do not fit in the other fields.
Users with the appropriate security rights may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.
VIII. DEACCESSIONS ASSOCIATED MODULE

A. Overview

1. **When do I use the Deaccessions associated module?**
   
   If your bureau has deaccessioning authority, use the Deaccessions associated module to document and track deaccessions and print deaccession forms.

   *For NPS, you must complete a deaccession form, Form 10-643, for all deaccessions. You cannot substitute a non-NPS form for Form 10-643.*

2. **Where can I find information on deaccessioning?**
   
   Refer to the *Museum Handbook*, Part II (MH-II), Chapter 6, Deaccessioning, or the *Museum Property Handbook*, Volume II (MPH-II), Chapter 6, Deaccessioning, for general information and procedures for deaccessioning. Refer to your site-specific procedures, if available.

3. **Must I use the Deaccessions associated module?**
   
   Yes. You are required to document and track all deaccessions, and use of this module meets that requirement. Using this module also makes your deaccession information readily available and links it to your catalog data.

   *Authority to deaccession museum property varies from bureau to bureau. In cases where regulations granting bureau disposal authority conflict with these guidelines, the bureau’s regulations take precedence.*

4. **How do I get to the Deaccessions associated module?**
   
   To go to the Deaccessions associated module records:
   
   - from the Home Page, select your Cultural Resources or Natural History directory by double-clicking, then double-click Deaccessions, or
   
   - from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Deaccessions, or
   
   - from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Deaccessions

5. **How can I view the deaccession record attached to a catalog record?**
   
   To view a deaccession for a specific object through the catalog record, go to the catalog record, select the Supplemental Information tab in the Record Pane and choose the Deaccessions supplemental.
   
   Select the specific deaccessions supplemental record and click View. A new window will open displaying the Deaccessions supplemental information.
Click on the link icon on the Deacc # field and the Deaccessions associated module record will open in a new window.

6. **How many screens does the Deaccessions associated module have?**
   The Deaccessions associated module consists of 4 screens:
   - Main Information
   - Extended Information
   - Deaccession Items
   - Multimedia

7. **What is the Deaccession Items tab?**
   The Deaccession Items tab allows you to view and attach objects to a deaccession record. When you attach objects, the program automatically creates a Deaccessions supplemental record for each object.

8. **What is the Multimedia tab used for in the Deaccessions associated module?**
   The Multimedia tab allows you to attach media files such as video and sound clips, supporting documents for the deaccession, spreadsheets, PDF files, etc. You may wish to attach an electronic copy of the files you list in the Attachments field.

   Refer to Appendix G in this manual for information on Multimedia.

9. **How will I know which data are needed to complete the deaccession forms?**
   The instructions in this manual and the on-line help will indicate which fields are needed to complete the deaccession forms.

10. **How do I add to or change information on an existing deaccession record?**
    From the Deaccessions screen:
    - click on the modify icon on the button bar, or
    - go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
    - press the F10 key

    The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

   **Note:** You cannot modify the deaccession number. If the deaccession has
11. **Does the program update the Object Status field on the catalog record for deaccessions?**

Yes. When you attach catalog records to a deaccession record, the Object Status, Location and Status Date fields are updated in the Mass Supplemental Update process. Refer to Chapter 3, Supplemental Records for information on the Mass Supplemental Update.

**Note:** The superintendent or designated authority must approve the deaccession before you can approve the deaccession in the associated module.

12. **When do I use the Disapprove, Approve and Copy with Items links next to the Deaccession Number?**

Use these links when the superintendent or designated authority approves or disapproves a pending deaccession. See Section C.

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>you want to make changes to a disapproved deaccession in order to resubmit it,</td>
<td>use the Copy with Items link to make a copy of the disapproved record, and modify the record for reconsideration.</td>
</tr>
</tbody>
</table>

B. **Adding a Deaccession Record**

1. **How do I add a deaccession record?**

From the Deaccessions record screen:

- click on the add icon on the button bar, or

- go to Edit on the menu bar and choose Add New Record from the pull-down menu, or

- press the F9 key

A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

2. **How do I move through the record?**

**Within the Field**

Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

**Field to Field**

been approved, you cannot attach additional catalog records to it.
Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

**Page to Page**
Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. **How do I cancel a record?**
To cancel the record without saving the data:

- click the **Cancel** link on the bottom right of the screen, *or*
- click the **Cancel** button on the button bar, *or*
- go to File on the menu bar and select **Cancel**

4. **How do I save a record?**
To save the entire record:

- click the **Save and Close** link at the bottom right of the screen, *or*
- click the Save and Close icon on the button bar, *or*
- go to File on the menu bar and select **Save and Close**

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

If you have not entered data in all the mandatory fields, the program will prompt you to enter the data. For example, a message will tell you which fields must be entered.

Click OK and you will be returned to the record to complete the fields. The mandatory fields that are empty will have an *X* next to the field. You cannot save a record without completing these fields.

5. **How do I delete a deaccession record?**
From the Deaccessions screen:

- Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.

- Choose Delete This Record.

- Click Yes when the program asks if you are sure you want to delete the record.

6. **How do I complete the Main Information screen?**
Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.
**Deaccession Nbr**

*Deac Nbr*

- **Note:** Fields marked with a ! in this manual are mandatory fields. You must complete these fields.

- Straight entry field. This field maps to all deaccession forms. **To save the record, you must complete this field.**

- Enter the proposed deaccession number. The proposed deaccession number begins with a P. The program supplies the P automatically.

- Example: P.12

  - The number consists of two parts:
    - P (proposed deaccession indicator)
    - proposed deaccession transaction number

  - When the deaccession is approved, the program changes the proposed deaccession number to an approved deaccession number. If the proposed deaccession is not approved, the number does not change. The program retains the proposed deaccession record to document that the objects were once part of a proposed deaccession.

  - **Note:** Once you have saved the record and attached catalog records to it, you cannot edit this field. The catalog records (for the objects in the deaccession) relate to the deaccession record through the deaccession number. You cannot change the deaccession ID because you would lose the relationship between the objects and the deaccession. Be sure to check the deaccession number and make any corrections to the number before you save the deaccession record and attach any catalog records.

  - **Pad deaccession numbers with zeroes if you want to sort by deaccession number. For example, use D.03 rather than D.3.**

**Deaccession Type**

*Deac Type*

- Bureau-controlled table (F5). This field maps to the deaccession form and the specialist review form. **To save the record you must complete this field.** You may not add to, delete, or modify terms in this table.

- Enter the type of deaccession.

- You must choose one of the following types:
  - Destructive Analysis
  - Involuntary Destruction
  - Loss
  - Native American Graves and Repatriation Act [NAGPRA] Compliance
  - Outside Scope of Collection
  - Return to Rightful Owner
  - Theft
  - Voluntary Destruction/Abandonment

  - As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

**Disposition of Objects Outside Scope of Collection**

*Non SOC*

- Bureau-controlled table (F5). This field maps to the deaccession form and the specialist review form. You may not add to, delete, or modify terms in this table.
Enter the type of disposition for deaccessions that are outside the unit’s Scope of Collection Statement.
Choose from the dispositions in the table:

Abandonment
Conveyance-Non-Federal Government
Conveyance-Private Institution
Exchange-DOI
Exchange-Federal
Exchange-Individual
Exchange-Non-Federal Government
Exchange-Non-Institutional Entity
Exchange-Private Institution
Transfer-DOI
Transfer-NPS
Transfer-Other Federal Agency
Voluntary Destruction

As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Disposition Document (Disp Doc)

Bureau-controlled, stacked table (F5, F12). This field maps to the deaccession form. You may not add to, delete, or modify terms in this table.

Enter the disposition document(s) for the deaccession. For some deaccessions, such as voluntary destruction, you will have more than one disposition document (Report of Survey and witness statement).

Choose from the documents in the table:

Conveyance Agreement
Exchange Agreement
Memorandum for Destructive Analysis
Receipt for Property
Repatriation Agreement
Report of Survey
Transfer of Property
Witness Statement for Destruction or Abandonment

As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

Deaccession Status (Deac Status)

Bureau-controlled table (F5). You may not add to, delete, or modify terms in this table.
The program automatically completes this field for you. For a new deaccession record, ‘Pending’ is inserted. When a deaccession is approved, the program changes this entry to ‘Deaccessioned’. If a deaccession is disapproved, the program changes this entry to ‘Disapproved’.

**Total Deaccession (Total Deac)**

Numeric field. This field maps to the deaccession form.

Enter the total number of museum objects in the deaccession.

Example: 5

**Value**

Numeric field. This field maps to the deaccession form.

Enter the total value of the objects in the deaccession. The field includes two decimal places.

**Objects**

Memo field (F12 to expand). This field maps to the deaccession form and the conveyance agreement.

Enter "See attached list." for large deaccessions. For deaccessions of a few objects, enter a list of objects in this field. For each object, include the catalog and accession numbers, the object name, a brief description, the item count or quantity, the condition, and, if applicable, the value.

**Attachments**

Memo field (F12 to expand). This field maps to the deaccession form.

Enter the attachments that you have included in the deaccession package. These must include copies of the catalog records and justification for the deaccession. Include the collections advisory committee review comments, if the deaccession requires the committee's review. Preferred entries are:

- justification
- copies of catalog records
- photographs
- appraisals
- solicitor's opinion/court order
- correspondence
- comments from reviewers
- documentation re: advertising and response
- justification for disposition out of order of preference
- NAGPRA consultation notes
- NAGPRA cultural affiliation documentation

**Recipient**

User-built, stacked table (F5, Ctrl-F5, F12 to expand) that links to the Names and Addresses associated module. This field maps to the deaccession form, the transfer of property, the conveyance agreement, and the exchange and repatriation agreements. To save the record, you must complete this field.

Enter the name of the institution or individual who received the objects in the deaccession.

Example: Museum of the Desert
Thompson County Historical Society

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.
Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

**Note:** Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

---

**The program automatically enters N/A in the Recipient field for the following deaccession types: destructive analysis, involuntary destruction, loss, theft, and voluntary destruction/abandonment.**

**Note:** You must complete the following fields on the Names and Addresses screen for the recipient:

**Name ID** - enter the name of the recipient

**First and Last Name and Title** - enter the name and title of the responsible official, if the recipient is an institution

**Phone** - enter the recipient's phone number

**Fax** - enter the recipient's fax number

**Primary Address:**
**Address 1 and 2** - enter the recipient’s address

**City/St/Zip** - enter the recipient’s city, state and zip code

**Alternate Address**
Complete these fields if the shipping address is different from the mailing address

**NPS** - enter NPS or non-NPS

**DOI** - enter DOI or non-DOI

**Recommended Deaccession (Recm Deac)**

Y/N logical field that includes a blank entry. This field maps to the deaccession form.

Select “Y” (Yes) if the curator has recommended the deaccession.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended Disposition (Recm Disp)</td>
<td>Y/N logical field that includes a blank entry. This field maps to the deaccession form. Select “Y” (Yes) if the curator has recommended the proposed disposition. Select “N” (No) if the curator has not recommended the proposed disposition. Select the blank entry if the curator has not yet made a decision.</td>
</tr>
<tr>
<td>Approved Deaccession (Appr Deac)</td>
<td>Y/N logical field that includes a blank entry. This field maps to the deaccession form. Select “Y” (Yes) if the superintendent or designated authority has approved the deaccession. Select “N” (No) if the superintendent or designated authority has not approved the deaccession. Select the blank entry if the superintendent or designated authority has not yet made a decision.</td>
</tr>
<tr>
<td>Approved Disposition (Appr Disp)</td>
<td>Y/N logical field that includes a blank entry. This field maps to the deaccession form. Select “Y” (Yes) if the superintendent or designated authority has approved the proposed disposition. Select “N” (No) if the superintendent or designated authority has not approved the proposed disposition. Select the blank entry if the superintendent or designated authority has not yet made a decision.</td>
</tr>
<tr>
<td>Directory (required to attach object catalog records to the deaccession)</td>
<td>Stacked table of directories (F5, F12 to expand) that are available on your system. Choose the directory or directories that contain(s) the catalog records for the objects in the deaccession. As you type, the directory name will complete from an authority table of available directories. Press the F5 key or click the down arrow icon to view and select a directory from the table, or press F12 for an expanded field that allows you to enter terms from the table. Note: You must choose a directory in order to attach the catalog records to the deaccession record. If the catalog records in the deaccession come from more than one directory, you can make multiple entries from the expanded field (F12). After entering the first directory, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another directory from the table. When saved, a double dash -- separates entries.</td>
</tr>
</tbody>
</table>
Click **Delete** or press Ctrl-Delete to remove unwanted entries.

**Notes**

Memo field (F12 to expand). This field maps to the deaccession form and the specialist review form.

Enter a general summary of the deaccession and additional information that would help the collections advisory committee evaluate the proposal.

Example: The curator proposes to deaccession two 1940s Windsor chairs that are outside the SOC. The date and style of the chairs do not fit within the collection. The chairs are part of an early transfer to the unit of period furnishings for the main house. The chairs have been advertised throughout the NPS, but no parks have requested them. The curator proposes an exchange with the local historical society for a pair of ladder-back chairs from the 1890s. The ladder-back chairs are similar to ones recommended in the Historic Furnishings Plan for the guest house.

**Superintendent (for NPS)**

(Superintend.)

or

**Manager (for DOI)**

Enter the name of the superintendent or designated authority for the unit.

**Deaccession Date**

(Deac Date)

Date field.

Enter the date of the deaccession. This is usually the date when the disposition documents were signed. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/9/2006

**Shipped By**

Enter the name of the person or company that shipped the deaccession.

**Ship Date**

Date field. This field maps to the transfer of property form.

Enter the date that you shipped the deaccession. The program will autofill as you type. To view a calendar and select the date, click the calendar icon and click on the day.

Example: 2/10/2006

7. **How do I complete the data fields on the Extended Information screen?**

To access the fields on the extended information screen, click on the Extended Information tab or press Ctrl-N to go to the next screen.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.
These are user-defined fields for deaccessions. Use these fields to enter unit-specific deaccession data that do not fit on the Main Information screen.

Users with appropriate security rights may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change.

8. **How do I complete the fields on the Deaccession Items tab?**

The program will automatically complete the fields on the Deaccession Items tab when you attach catalog records to the deaccession. To use this feature on a group of catalog records:

- Go to the catalog records and create a tag set of all the objects in the deaccession. See Section XI of Chapter 6 for information on creating tag sets. You can also set a filter or select multiple items in the List Pane of the catalog records.

- Go to Edit on the menu bar and select Mass Supplemental Update. Refer to Section I of Chapter 3 for further information on Mass Supplemental Update.

- You can attach the catalog records only to a pending deaccession record or create a new deaccession record during the Mass Supplemental Update. **Note:** The program will only show you pending deaccessions in the list of deaccessions table.

- The Deac Status and Deac Date will autofill from the Deaccession record when you tab out of the field. You cannot edit these fields from the Mass Supplemental Update, but you can update the Notes field for the supplemental by selecting ‘Manually update value’ from the pull down next to the field.
When you re-enter the Deaccessions associated module, the Deaccession Items tab will include the objects. The program automatically completes the Directory, Deac Status, and Deac Date columns using data from the deaccession record. The catalog number, object name, and value are filled in from the catalog record. Refer to Section B.10 below for information on how to change the data in the list.

**Note:** The program also creates a Deaccession supplemental record for each object on the list. The supplemental record attaches deaccession information to the catalog record for each object in the deaccession. The program enters “Pending” in the status column. It will automatically update the status when you click on the Approve or Disapprove links after the superintendent or designated authority approves or disapproves the deaccession. Refer to Section VII of Chapter 3 for information on the Deaccession supplemental record.

9. **Can I attach catalog records from the Deaccession Items tab of the deaccession record?**

   Yes, if there are only a few records to attach. For a large deaccession, it is much easier to use the Mass Supplemental Update from the catalog records on a tag set or group of records.

   However, you may want to make manual additions, modifications, or deletions to an existing list.

10. **How do I manually add, modify, or delete objects on the Deaccession Items tab?**

    To add, modify or delete objects from a deaccession record:

    - First, add and save a proposed deaccession record. You cannot attach objects to a deaccession record until it is saved.

    - Go to the Deaccession Items tab of the deaccession record. You can be in any mode to add, modify and delete items from the list.

    **Add an Item**

    Click on Add above the item list on the right. The Mass Supplemental Update window for the associated module will open. **Note:** You can only add items to a proposed deaccession (P number) record.

    - If you have listed more than one directory in the deaccession record’s Directory field, select the directory where the catalog record is found.
• In the Choose a catalog record field click the catalog icon or press F5 to access the list of catalog records. Type the catalog number in the Term Selector or select the record from the list. Click Select.

Note: The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data in the list. The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.

• The program automatically enters the information for the deaccession number, deaccession status and deaccession date. You can only edit the Notes field by selecting “Manually update value” from the pull down menu.
• When finished editing the field, click Next.

• On the report window of how many will be added or updated (it will only add or update 1 record at a time), click Finish to make the changes.

**Modify an Item**

On the Deaccession Items tab, select an object in the list and click Edit above the list on the right. The Mass Supplemental Update window for the associated module will appear. It will already be on the Deaccessions Supplemental data entry screen (see above). Modify the information in the Notes field as described above. Click Next and then Finish to save the modifications.

**Delete an Item**

On the Deaccession Items tab, select an object in the list and click Delete. A similar Mass Supplemental Update window will appear. Click Next and then Finish to delete the object from the list. This will remove an item from the deaccession list but not from the catalog database.

**Note:** The program also creates a Deaccessions supplemental record for each object on the list. Any changes you make on the item list screen appear in the supplemental record. If you delete an item from the list, the corresponding deaccession supplemental is also deleted. Refer to Section VII of Chapter 3 for information on the Deaccession supplemental record.

**View the Catalog Record for the Item**

On the Deaccession Items tab, select an object in the list and click View above the list or click the link icon next to the catalog number. The catalog record will open in a new window. Click the X in the upper right corner when finished viewing.

11. **Can I print the list of catalog records on the Deaccession Items tab?**

Yes, you can print the list of catalog records that appear on the Deaccession Items tab. To print the list of catalog records, click Print on the Deaccession Items tab. A print preview window will open.

To print the report, choose Print on the File menu, or click one of the print buttons on the button bar. You can also export or email this document using the options on the File menu or button bar.
C. Approving or Disapproving a Deaccession Record

Be sure to attach the objects you want to deaccession to the Deaccession Items tab before using the Approve or Disapprove links.

1. **When do I use Approve?**

Use the approve link after you have:

- entered and saved a deaccession record
- entered a “Y” in the Approved Deaccession and Approved Disposition fields
- attached the objects you want to deaccession to the Deaccession Items tab

<table>
<thead>
<tr>
<th>If…</th>
<th>Then…</th>
</tr>
</thead>
<tbody>
<tr>
<td>the superintendent or designated authority approves the deaccession</td>
<td>in Modify Mode, click on Approve and click on Yes when the program asks you if you want to approve the deaccession</td>
</tr>
</tbody>
</table>

When you click on Approve, the program will:

- ask if you’re sure you want to approve the deaccession; click “Yes” to continue
- ask you for a deaccession number. It uses the pending number and changes the P to a D. You may change the number if desired (if the deaccession number you enter already exists, you must enter another). Click OK.
- tell you that the program has updated the deaccession
- change the proposed deaccession number (P number) to an approved deaccession number (D number) on the deaccession record
- change the Status field on the deaccession record to “Deaccessioned”

When you save the record, the program will:

- tell you that it has been saved and the supplementals will now be updated. Click OK.
- open the Mass supplemental update window to update the Deaccession supplemental and the Object Status, Location and Status date for the catalog record.
• automatically complete the fields for the deaccession supplemental and catalog record fields. You may only make changes to the Notes field on the deaccession supplemental. For the catalog record, the Object Status field is updated with the appropriate deaccession type; the Location field is changed to “DEACCESSIONED”; and the Status Date is changed to the fiscal year of the deaccession. Click Next to continue.

• tell you how many deaccession supplementals will be updated. Click Finish and then OK to the successfully completed message.

2. When do I use Disapprove?

Use the disapprove link after you have:

• entered and saved a deaccession record

• entered “N” in the Approved Deaccession and Approved Disposition fields

• attached the objects you want to deaccession to the Deaccession Items tab

If…                                           Then…
the superintendent or designated authority disapproves the deaccession   in Modify Mode, click on Disapprove and click on Yes when the program asks you if you want to disapprove the deaccession.

When you click on Disapprove, the program will:

• ask if you’re sure you want to disapprove the deaccession; click “Yes” to continue

• tell you that the deaccession has been updated as “DISAPPROVED”; click OK to continue

• retain the proposed deaccession number (P number) and the record to document the deaccession proposal

• change the Status field on the deaccession record to “DISAPPROVED”
When you save the deaccession record, the program will:

- tell you that the record has been saved and the supplementals will now be updated; click OK to continue
- open the Mass Supplemental Update window to update the deaccession supplemental record for the catalog records attached to the proposed deaccession
- automatically complete the deaccession supplemental fields with the data from the deaccession record. You may only edit the Notes field on the supplemental. Click Next to continue.
- tell you how many deaccession supplementals will be updated. Click Finish and then OK to the successfully completed message.

3. When do I use Copy with Items?

   **If...**
   
   you want to change and resubmit a disapproved deaccession
   
   **Then...**
   
   in View Mode, click on Copy with Items and click on Yes when the program asks you if you want to copy the deaccession record.

When you click on Copy with Items:

- The deaccession record will open in a new window in Copy Mode.
- Enter a new proposed deaccession number (you cannot save the record with the same proposed deaccession number).
- The Status is changed to “PENDING”.
- Make any other changes as desired. Then click Save and Close.
- A new deaccession supplemental is attached to the same catalog records and the status on the Deaccession Items tab and deaccession supplemental is changed to “PENDING”.

**Note:** You cannot copy approved deaccessions using this button.
D. Printing the Deaccession Forms

1. What forms and reports can I print from the Deaccessions associated module?

You can print the following forms and reports from the Deaccessions associated module:

- Deaccession Form (10-643)
- Deaccession Form – Blank.docx (10-643)
- Deaccession Folder Cover Sheet.docx (10-644)
- Conveyance Agreement (10-99)
- Conveyance Agreement – Blank.docx (10-99)
- BOR Deaccession Folder.docx (7-2514)
- BOR Deaccession Form
- BOR Deaccession Log
- BOR Exchange Agreement
- BOR Exchange Agreement Continuation
- BOR Repatriation Agreement
- BOR Repatriation Agreement Continuation
- Transfer of Property (DI-104)
- Transfer of Property Blank Form.docx (DI-104)
- DI-3220 Notice of Potential Hazard in Museum Collections.docx
- DOI Deaccession Form
- DOI Exchange Agreement
- DOI Exchange Agreement Continuation
- DOI Repatriation Agreement
- DOI Repatriation Agreement Continuation
- Exchange Agreement.docx
- Repatriation Agreement.docx
- Specialist Review Form
- USGS Deaccession Form
- USGS Deaccession Log

You will also use the List of Objects (Form 10-417) and the Receipt for Property (DI-105) when documenting deaccessions. You must access these forms from the catalog record screen.

For additional information, refer to Chapter 5, Reports and Forms.

Note: The program will complete the forms or allow you to print blank forms. Use acid-free paper for printing forms.

2. How do I complete the NPS or DOI Unit section of the forms?

Many forms contain a section for the name and address of the unit. To have the program print this information on the forms, you must complete an entry in the Names and Addresses associated module. See Section XII of this chapter. Enter “NPS UNIT” or “UNIT” for other bureaus in all caps in the Name ID field. Enter the superintendent’s or designated authority’s name and title on this screen.

You only have to enter the NPS Unit or Unit record once. You can modify the record as needed when changes occur at the unit.

For additional information on the NPS Unit and Unit record, also see Section II.B of Chapter 5.
3. How do I print the reports and forms from the Deaccessions associated module?

To print any of the deaccession report forms:

- Go to the deaccession record in the Record Pane.
- Click on the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.
- Select the report name.
- Click Run for Current Record Only

Note: For the forms to print correctly, you must enter data in the fields in the Deaccessions associated module that are mapped to the forms. The manual and on-line help will tell you which fields map to the reports.

4. How do I print the Deaccession Form?

To print a deaccession form, in the Proficio Reports window, select the form appropriate for your unit:

- 10-642 Deaccession Form
- BOR Deaccession Form
- DOI Deaccession Form
- USGS Deaccession Form

The program will complete all sections of the form except the signature and date sections. The curator and superintendent or designated authority must sign the form. You must also manually check the box in the Collections Advisory Committee (or Curatorial) Review and Recommendations section. Check the box only if you have included attachments from the collections advisory committee.
Note: To print a blank version of this report, choose the 10-643 Deaccession Form – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

You can also click the Print Blank Report button or link for any report in the list. The program does not complete any sections of the form when using this option.

5. How do I print the Deaccession Folder Cover Sheet?

To print the deaccession folder cover sheet, in the Proficio Reports window, select the form appropriate for your unit:

10-644 Deaccession Folder Cover Sheet.docx
BOR Deaccession Folder.docx

This is a Word document. When you click Run for Current Record Only, the deaccession folder cover sheet document will open in a separate Microsoft Word window. Print the form as you would any other Word document.

Note: You can complete the form manually or on the computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

6. How do I print the Deaccession Log?

To print the deaccession log, in the Proficio Reports window, select the form appropriate for your unit:

BOR Deaccession Log
USGS Deaccession Log

Click Run for Current Record Only, or Run for All Visible Records if you have a tag set or filter active.

The program will complete all sections of the form.

7. How do I print the Exchange Agreement?

To print the exchange agreement, in the Proficio Reports window, select the form appropriate for your unit:

Exchange Agreement.docx

This is a Word document. When you click Run for Current Record Only, the exchange agreement document will open in a separate Microsoft Word window. Print the form as you would any other Word document.

Note: You can complete the form manually or on the computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use. You must obtain original signatures from the superintendent and the other party in the exchange.

BOR Exchange Agreement
DOI Exchange Agreement

The program will complete the deaccession number in the upper right corner. You will have to complete the remainder of the form manually. You will also need to print the second page of this report. After printing the DOI Exchange Agreement, select the form appropriate for your unit:
8. **How do I print the Repatriation Agreement?**

To print the repatriation agreement, in the Proficio Reports window, select the form appropriate for your unit:

**Repatriation Agreement.docx**

This is a Word document. When you click Run for Current Record Only, the repatriation agreement document will open in a separate Microsoft Word window. Print the form as you would any other Word document.

**Note:** You can complete the form manually or on the computer. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use. You must obtain original signatures from the superintendent and the other party in the repatriation.

**BOR Repatriation Agreement**

**DOI Repatriation Agreement**

The program will complete the deaccession number in the upper right corner. You will have to complete the remainder of the form manually.

You will also need to print the second page of this report. After printing the DOI Exchange Agreement, select:

**BOR Repatriation Agreement Continuation**

**DOI Repatriation Agreement Continuation**

9. **How do I print the Notice of Potential Hazard in Museum Collections?**

To print a notice of potential hazard in museum collections, in the Proficio Reports window, select:

**DI-3220 Notice of Potential Hazard in Museum Collections.docx**

This form acknowledges receipt of information on potentially toxic substances in museum collections. It is completed manually.

This is a Word document. When you click Run for Current Record Only, the notice will open in a separate Microsoft Word window. Print the form as you would any other Word document.

10. **How do I print the Conveyance Agreement?**

To print the conveyance agreement, in the Proficio Reports window, select:

**10-99 Conveyance Agreement**

The program will complete all sections of the form except the signature and date sections. You must obtain an original signature from the superintendent and the recipient. You must also manually check the box to indicate whether the recipient is a private institution or a non-Federal governmental entity.

**Note:** To print a blank version of this report, choose the 10-99 Conveyance Agreement – Blank.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.
11. **How do I print the Transfer of Property (Form DI-104)?**

You must attach catalog records to the deaccession record either using the Mass Supplemental Update function or from the Deaccession Items tab in order to print a Transfer of Property (Form DI-104).

To print a transfer of property, in the Proficio Reports window, select:

**Di-104 Transfer of Property**

The program will complete all sections of the form except the signature and date received sections. You must obtain original signatures from the superintendent or designated authority and the recipient.

**Note:** To print a blank version of this report, choose the Di-104 Transfer of Property Blank Form.docx instead. The form will open in a separate Microsoft Word window for you to print and complete manually or on your computer. The program does not complete any sections of this form. If you complete the form on the computer, save it under another name. You can then maintain a clean copy of the form for future use.

12. **How do I print a Specialist Review Form?**

To print a specialist review form, in the Proficio Reports window, select:

**Specialist Review Form**

The program will complete the form with the exception of the comments, recommendation, and signature sections. The reviewer must complete these sections manually.

13. **How do I print the List of Objects to attach to the Deaccession Form?**

To print a list of objects, you must go to the catalog records.

You can print the form for an individual catalog record or a group of catalog records by creating a tag set, filter or selecting multiple records in the List Pane.

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- In the list of reports, select the **10-417 List of Objects, BOR List of Objects** or **DOI List of Objects**.

- Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.

The program will complete all sections of the form except the number at the top right of the form (enter the deaccession number in this space).

**Note:** For the form to print correctly, you must enter data in the fields that are mapped to the form. Refer to Chapter 5, Reports and Forms, for additional information about the List of Objects (Form 10-417).

14. **How do I print the Receipt for Property (Form DI-105)?**

To print a receipt for property, you must go to the catalog records. You can print the form for an individual catalog record or a group of catalog records by creating a tag set, filter or selecting multiple records in the List Pane.

- Click the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.

- In the list of reports, select the **Di-105 Receipt for Property**.
• Click Run for Current Record Only or Run for All Visible if you have a tag set or multiple records selected.

The program will complete all sections of the form except the signature and date sections.

Note: For the form to print correctly, you must enter data in the fields that are mapped to the form. Refer to Chapter 5, Reports and Forms, for additional information about the Receipt for Property (Form DI-105).
IX. RESTRICTIONS ASSOCIATED MODULE

A. Overview

1. **When do I use the Restrictions associated module?**

   Use the Restrictions associated module to document restrictions that limit access to, or use of, an object or group of objects.

   Restrictions are most useful if they can be broadly applied to a group of objects. The program allows you to attach multiple catalog records to one restriction record in the Restrictions associated module. The program then attaches a Restrictions supplemental record to each catalog record in the group. You can enter object specific notes about the restriction in the supplemental record.

2. **Where can I find information on restrictions?**

   Refer to the Museum Handbook, Part III (MH-III), Chapter 2, Legal Issues or the DOI Museum Property Handbook, Volume II (MPH-II), Chapter 2, Accessioning, for information on access and use restrictions for museum collections. Refer to the Museum Handbook, Part II, (MH-II), Appendix D: Museum Archives and Manuscript Collections, for information on restrictions for archival and manuscript collections.

3. **Must I use the Restrictions associated module?**

   No. Use of this feature is optional but recommended. You are legally required to be aware of restrictions relating to your collection. Using this module makes your restriction information readily available and links it to your catalog data.

4. **How do I get to the Restrictions associated module?**

   To go to the Restrictions associated module records:

   - from the Home Page, select your Cultural Resources, Natural History or Archives module directory by double-clicking, then double-click Restrictions, or
   - from the Navigation Pane, expand the Cultural Resources, Natural History or Archives module directory tree and select Restrictions, or
   - from your Cultural Resources, Natural History or Archives module directory, go to View on the menu bar, select Go To at the bottom, then choose Restrictions.

5. **How can I view the restriction record attached to a catalog record?**

   To view a restriction for a specific object through the catalog record, go to the catalog record, select the Supplemental Information tab in the Record Pane and choose the Restrictions supplemental.
Select the specific Restrictions supplemental record and click View. A new window will open displaying the Restrictions supplemental information.

Click on the link icon on the Restr Nbr field and the Restrictions associated module record will open in a new window.

6. **How many screens does the Restrictions associated module have?**

The Restrictions associated module consists of 4 screens:

- Main Information
- Extended Information
- Restriction Items
- Multimedia

7. **What is the Restriction Items tab?**

The Restriction Items tab allows you to view and attach objects to a restriction record. When you attach objects, the program automatically creates a Restrictions supplemental record for each object.

8. **What is the Multimedia tab used for in the Restrictions associated module?**

The Multimedia tab is used to attach media files such as video and sound clips, legal documents for the restriction, PDF files, etc.

Refer to Appendix G in this manual for information on Multimedia.

9. **How do I add to or change information on an existing restriction record?**

From the Restrictions screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click **Save and Close** at the bottom right or press the F2 key to save the changes.

**Note:** You cannot modify the restriction number.
10. **What reports can I print from the Restrictions associated module?**

There are no reports related to the Restrictions associated module.

---

**B. Adding a Restrictions Record**

1. **How do I add a restriction record?**

From the Restrictions screen:

- click on the add icon on the button bar, *or*
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, *or*
- press the F9 key

A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

2. **How do I move through the record?**

**Within the Field**

Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

**Field to Field**

Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

**Page to Page**

Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. **How do I cancel a record?**

To cancel the record without saving the data:

- click the Cancel link on the bottom right of the screen, *or*
- click the Cancel button on the button bar, *or*
- go to File on the menu bar and select Cancel
4. **How do I save a record?**

To save the entire record:

- click the **Save and Close** link at the bottom right of the screen, *or*

- click the Save and Close icon on the button bar, *or*

- go to File on the menu bar and select Save and Close

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. **How do I delete a restriction record?**

From the Restrictions screen:

- Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.

- Choose Delete This Record.

- Click Yes when the program asks if you are sure you want to delete the record.

6. **How do I complete the Main Information screen?**

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Restriction Number (Restr Nbr)**

Straight entry field.

Enter the unique number that identifies the restriction. Choose this number locally. The unit should maintain a log of restriction numbers. **To save the record, you must complete this field.**

**Note:** Once you have saved the record and attached catalog records to it, you cannot edit this field. The catalog records (for the restricted objects) relate to the restriction record through the restriction number. You cannot change the restriction number because you would lose the relationship between the objects and the restriction. Be sure to check the restriction number and make any corrections to the number before you save the restriction record and attach any catalog records. If you save an incorrect number, you can either delete the record and add a new one, or copy the record first (changing the restriction number) and then deleting the incorrect record.

**Access**

Memo field (F12 to expand)

Enter information about restrictions that limit access to an object or group of objects. This information will appear in the Notes field of the Restrictions supplemental record.

Example: Objects are protected from access under state privacy legislation.

**Duplication**

Memo field (F12 to expand)

Enter information about duplication restrictions.

Example: The park does not have the copyright. Limited numbers of “fair use” photocopies can be provided for scholarly and criticism purposes only.
Publication

Memo field (F12 to expand)

Enter information about publication restrictions.

Example: To obtain permission to publish, the applicant must obtain permission from the holder of the original copyright, Wilmer Wilkins or his heirs, until the year 2010.

Exhibition

Memo field (F12 to expand)

Enter information about exhibition restrictions.

Example: Human remains cannot be placed on exhibit.

Donor

Memo field (F12 to expand)

Enter information about donor restrictions that are contained in the accession document.

Example: Donor restriction does not allow this object to be placed on loan outside the United States.

Note: Units should accept only unrestricted gifts; however, some early accessions may contain donor restrictions.

Legal Authority

User build, stacked table (F5, Ctrl-F5, F12 to expand).

Enter the law or legal authority that restricts access to, or use of, the museum object.

Example: Archeological Resources Protection Act

Classified Information

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field. The expanded field (F12) also allows users to add, delete, and edit.

You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

Notes

Memo field (F12 to expand).

Enter any summary notes or additional comments about the restriction.

Example: Due to its fragility, access to this type specimen is restricted.
User 1-2

These are user-defined fields for restrictions. Use these fields to enter unit-specific restriction data. See instructions for User 3-7 below.

7. How do I complete the data fields on the Extended Information screen?

To access the fields on the extended information screen, click on the Extended Information tab or press Ctrl-N to go to the next page.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.

User 3-7

These are user-defined fields for restrictions. Use these fields to enter unit-specific restriction data.

Users with appropriate security rights may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change.

C. Attaching Catalog Records to Restrictions

1. How do I attach catalog records to a restriction record in the Restrictions associated module?

Use the Mass Supplemental Update function to attach a catalog record or group of catalog records to a restriction record. To use this feature on a group of catalog records:

- Go to the catalog records and create a tag set of all the objects in the restriction. See Section XI of Chapter 6 for information on creating tag sets. You can also set a filter or select multiple items in the List Pane of the catalog records.

- Go to Edit on the menu bar and select Mass Supplemental Update. Refer to Section I of Chapter 3 for further information on Mass Supplemental Update.

- You can attach the catalog records to an existing Restriction record or create a new Restriction record during the Mass Supplemental Update.
When you re-enter the Restrictions associated module, the Restriction Items tab will include the objects. The program automatically completes the directory, catalog number, and object name.

**Note:** The program also creates a Restrictions supplemental record for each object on the list. Access restrictions carry over to the Notes field in the supplemental record. This allows you to see access restrictions without having to go to the Restrictions associated module. Refer to Section XXI of Chapter 3 for information on the Restrictions supplemental record.

2. **Can I attach catalog records from the Restriction Items tab of the restriction record?**

   Yes, if there are only a few records to attach. For a large number of catalog records, it is much easier to use the Mass Supplemental Update from the catalog records on a tag set or group of records.

3. **How do I manually add, modify, or delete objects on the Restriction Items tab?**

   To add, modify or delete objects from a restriction record:

   - First, add and save a restriction record. You cannot attach objects to a restriction record until it is saved.

   - Go to the Restriction Items tab of the restriction record. You can be in any mode to add, modify and delete items from the list.

   **Add an Item**

   Click on Add above the item list on the right. The Mass Supplemental Update window for the associated module will open.

   - Restrictions are directory specific. The directory listed is the current directory.

   - In the Choose a catalog record field click the catalog icon or press F5 to access the list of catalog records. Type the catalog number in the Term Selector or select the record from the list. Click Select.
Note: The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data in the list. **The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.**

- Click Next after you have selected the catalog record.

- The Notes for the supplemental is autofilled from the Access field of the restriction record. You can keep this automatic value and click Next. Or to add object specific information, select the “Manually update value” option on the pull down menu next to the field.

Note: The information entered in the Restrictions Supplemental Update does not transfer back to the restriction record.

- When finished editing the field, click Next.

- On the report window of how many will be added or updated (it will only add or update 1 record at a time), click Finish to make the changes.

**Modify an Item**

On the Restriction Items tab, select an object in the list and click Edit above the list on the right. The Mass Supplemental Update window for the associated module will appear. It will already be on the Restrictions Supplemental data entry screen (see above). Modify the information on the Notes field as desired. Click Next and then Finish to save the modifications.

**Delete an Item**

On the Restriction Items tab, select an object in the list and click Delete. A similar Mass Supplemental Update window will appear. Click Next and then Finish to delete the object from the list. This will remove an item from the restriction list but not from the catalog database.
**Note:** The program also creates a Restrictions supplemental record for each object on the list. Any changes you make on the item list tab appear in the supplemental record. If you delete an item from the list, the corresponding restrictions supplemental is also deleted. Refer to Section XXI of Chapter 3 for information on the Restrictions supplemental record.

**View the Catalog Record for the Item**

On the Restriction Items tab, select an object in the list and click View above the list or click the link icon next to the catalog number in the list. The catalog record will open in a new window. Click Close when finished viewing.

**4. Can I print the list of catalog records on the Restriction Items tab?**

Yes, you can print the list of catalog records that appear on the Restriction Items tab.

To print the list of catalog records, click Print on the Restriction Items tab. A print preview window will open.

![Print Preview](image)

To print the report, choose Print on the File menu, or click one of the print buttons on the button bar. You can also export or email this document using the options on the File menu or button bar.

**5. What restriction information prints on the catalog record?**

**If there is…**

information in the Restrictions supplemental record,

**Then the System…**

prints a “Y” in the Restriction field on the Form 10-254 and the DOI CR/NH Museum Catalog Record.

no information in the Restrictions supplemental record,

prints a “N” in the restriction field on the Form 10-254 and the DOI CR/NH Museum Catalog Record.
X. LOCALITY ASSOCIATED MODULE

A. Overview

1. When do I use the Locality associated module?
   
   Use the Locality associated module to enter specific locality data for natural history specimens. The module documents the surroundings of the collection site.

   Note: The Locality associated module is available from your Cultural Resources directories, but it doesn’t link to the catalog records.

2. Must I use the Locality associated module?
   
   No. You may use this module to enter data in the user-built table for the Locality field on the Natural History catalog record. To insert data in the table, you must make an entry in the Locality field in the Locality associated module. However, you can enter locality data on the catalog record without using the table.

   Refer to Sections V-VII of Chapter 2 for information on using the Locality field on the Natural History catalog record.

   Taking advantage of this feature in the program is recommended if you have information about the collection site. Using this module makes your locality information readily available and links it to your Natural History catalog data.

3. How do I get to the Locality associated module?
   
   To go to the Locality associated module records:

   • from the Home Page, select your Cultural Resources or Natural History directory by double-clicking, then double-click Locality, or

   • from the Navigation Pane, expand the Cultural Resources or Natural History directory tree and select Locality, or

   • from your Cultural Resources or Natural History directory, go to View on the menu bar, select Go To at the bottom, then choose Locality

4. How can I view the Locality record from a Natural History catalog record?
   
   You will most frequently access the Locality associated module through your Natural History catalog records. Go to the Collection Site page of the catalog record. The Locality field is the second field on the screen. Click on the Locality icon on the field. You will see the user-built table for locality. Select a Locality from the list and click View to access the Locality associated module.
The Locality field is the link between the Locality associated module and the Natural History catalog record. **Note:** There is no field link to the Locality associated module from a Cultural Resources catalog record.

5. **How many screens does the Locality associated module have?**

The Locality associated module consists of 3 screens:

- Main Information
- Images
- Multimedia

6. **What are the Images and Multimedia tabs used for in the Locality associated module?**

The Images tab allows you to attach multiple images of the collection site to the locality record. These images could include maps, on-site photos, etc.

The Multimedia tab allows you to attach other media files such as video and sound clips, documents, spreadsheets, PDF files, etc.

Refer to Appendix G in this manual for information on Imaging and Multimedia.

7. **How do I add to or change information on an existing locality record?**

From the Locality screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see “Modify Mode” in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

To modify a record in the Locality associated module through the Natural History catalog record:

- Go to the Collection Site page of the catalog record.
- Click on the Locality icon on the Locality field.
- Select the entry you wish to modify and click Edit. The locality record will open in a separate window.
- Modify and save the record.

**Edits to the Locality field are not recommended. Changes to this field require the same change in all linked records. You can use a global search and replace to find and make the same change in the linked records.**

8. **What reports can I print from the Locality associated module?**

There are no reports related to the Locality associated module.
B. Adding a Locality Record

1. How do I add a locality record?

   From the Locality screen:
   - click on the add icon on the button bar, or
   - go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
   - press the F9 key

   A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

   To add a record in the Locality associated module through the Natural History catalog record:
   - Go to the Collection Site page of the catalog record.
   - Click on the Locality icon on the Locality field.
   - From the Locality list, click Add. The locality screen will open in a separate window.
   - Add and save the record.

2. How do I move through the record?

   Within the Field
   Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

   Field to Field
   Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

   Page to Page
   Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.
3. **How do I cancel a record?**

   To cancel the record without saving the data:
   
   - click the **Cancel** link on the bottom right of the screen, *or*
   
   - click the Cancel button ✗ on the button bar, *or*
   
   - go to File on the menu bar and select ✗ Cancel

4. **How do I save a record?**

   To save the entire record:
   
   - click the **Save and Close** link at the bottom right of the screen, *or*
   
   - click the Save and Close icon on the button bar, *or*
   
   - go to File on the menu bar and select Save and Close

   **Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. **How do I delete a locality record?**

   From the Locality screen:
   
   - Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.
   
   - Choose Delete This Record.
   
   - Click Yes when the program asks if you are sure you want to delete the record.

   To delete a record in the Locality associated module through the Natural History catalog record:
   
   - Go to the Collection Site page of the catalog record.
   
   - Click on the Locality icon on the Locality field.
   
   - From the Locality list, click Delete.
   
   - The program will ask if you are sure, click Yes to delete the record.

6. **How do I complete the data fields on the Main Information screen?**

   Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

   **Locality**

   Memo field (F12 to expand) that links to the Locality field on the Natural History catalog record. **To save the record, you must complete this field.**

   Enter the locality. Most units will design specific systems for naming different localities. This field should contain unique reference to either a formal numerical scheme, for example, JDNM-480, or a less formal locality name, for example, “Bug Creek Anthills”.

   **Note:** The entries in this field appear in the table for the Locality field on the Natural History catalog record. This field serves as the link between the Locality associated module and the Natural History catalog record.
Ownership

User-built, stacked table (F5, Ctrl-F5) that links to the Names and Addresses associated module.

If the locality is administered by a governmental agency, enter the agency and district, where appropriate.

Example: Bear Creek District, Malheur National Forest

If the land is private, enter the name of the landowner.

Enter addresses and other information in the Names and Addresses associated module, which links to this field.

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. The entry you add will appear in the table. You can then select it from the table.

Note: Enter the Name ID in all caps.

Refer to Section XII of this chapter for information on the Names and Addresses associated module.

Press Ctrl-Delete to remove unwanted entries.

Note: The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

Locality Description (Local Descr)

Memo field (F12 to expand)

Enter a detailed narrative of the nature and extent of the site. Include both spatial (geographic) and temporal (stratigraphic) delimiters so that it is clear what is being included in this designated locality.

Age Geology (Age Geo)

User-built table (F5, Ctrl-F5). The program includes a table.

Enter the chronostratigraphic age of the locality and its associated geology. The entry could be an era, period, epoch, age, or stage.

Example: Pliocene
          Bajocian

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.
Press Ctrl-Delete to remove unwanted entries.

**Age Paleontology**

*User-built table (F5, Ctrl-F5). The program includes a table.*

Enter the chronostratigraphic age of the locality and its associated fossil materials. You can use North American Land Mammal Ages.

Example: Blancan
Uintan

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**GPS**

*Straight entry field.*

Do not enter anything into this field. Contact your system administrator to set up this field to enter Global Positioning System or Geographic Information System data if desired.

**Related Sites**

*Memo field (F12 to expand).*

Enter other sites that may share close physical proximity to this locality or have similar biotas or paleobiotas.

**Lithology or Stratigraphic Descriptor**

*Memo field (F12 to expand)*

Enter details of rock units, or rock units from which fossil material is recovered. Enumerate concepts such as “includes all units above the prominent ignimbrite” or “paper shales below claystones” so there is no confusion over what constitutes the actual locality.

**Locality Quadrangle**

*Straight entry field*

Enter the name of the Master USGS topographic quadrangle on which this site is marked and labeled, if available. If GIS systems have these data, enter the name of the sheet.

**Taxa**

*Memo field (F12 to expand)*

List the taxa or taxonomic members, at a suitable level, for material collected from this site. Some localities contain hundreds of taxa. In such cases, use only high-level terms, such as Class Mammalia. In other localities where only one or two species are known, list individual entries in this field.

**Other Designators**

*Memo field (F12 to expand)*

Enter the reference systems that other investigators and/or repositories used for the site. A site may have been given multiple names by multiple institutions. It
is important to enter all the names in this field to determine which names are synonyms for the same locality.

**Significance (Signif.)**

Memo field (F12 to expand).

Enter a unit-generated numerical or qualitative level of significance for the locality or locality complex. A unit-generated significance criteria permits rapid retrieval of localities based on relative importance.

**Notes**

Memo field (F12 to expand).

Use this field for entering unit-specific notes or narratives about the site.

Example: Pointers to other detailed records, such as investigator's field note pages.

**Photo Number (Photo Nbr)**

Straight entry field.

Enter the number(s) for photograph(s) of the locality. These numbers may serve as a reference to records in the Archives module.
XI. ARTIST/MAKER/EMINENT FIGURE ASSOCIATED MODULE

A. Overview

1. *When do I use the Artist/Maker/Eminent Figure associated module?*

   Use the Artist/Maker/Eminent Figure associated module to document information about:
   
   - people and companies that created an object
   - eminent figures who are associated with an object through use or possession

   Artist and makers include artists, authors, photographers, craftspeople, and factories. Eminent figures may be of international or national importance, or of local significance to your site. They may be presidents, natural history collectors, archeologists, or unit employees.

2. *Must I use the Artist/Maker/Eminent Figure associated module?*

   Yes. You must use this module to enter names in the user-built tables for the Artist/Maker and Eminent Figure fields on the catalog record. To insert names in these tables, you must make an entry in the Name field in the Artist/Maker/Eminent Figure associated module. Entering data in the other fields in the module is optional.

   You can access the Artist/Maker/Eminent Figure associated module through the catalog record. You do not have to exit the catalog record to make entries in the module.

   Refer to Chapter 2, Cataloging, for information on the Artist/Maker and Eminent Figure fields on the catalog record.

   Taking advantage of this feature in the program is recommended. It allows you to link information about the artists, makers, and eminent figures in your collection to your catalog data.

3. *How do I get to the Artist/Maker/Eminent Figure associated module?*

   To go to the Artist/Maker/Eminent Figure associated module records:
   
   - from the Home Page, select your Cultural Resources, Natural History or Archives module directory by double-clicking, then double-click Artist/Maker/Eminent Figure, *or*  
   - from the Navigation Pane, expand the Cultural Resources, Natural History or Archives module directory tree and select Artist/Maker/Eminent Figure, *or*  
   - from your Cultural Resources, Natural History or Archives module directory, go to View on the menu bar, select Go To at the bottom, then choose Artist/Maker/Eminent Figure
4. How can I view the Artist/Maker/Eminent Figure record from a catalog record?

You can access the Artist/Maker/Eminent Figure associated module through your catalog records. The Artist/Maker field for Cultural Resources records and the Creator field in the Archives module records links to this module. The Eminent Figure field for Cultural Resources and Natural History records links to this module also.

In any of these fields, press F12 to expand the field. Click the link icon next to the artist name and the Artist/Maker/Eminent Figure record will open in a separate window. Click the X to close the window.

The Name field is the link between the Artist/Maker/Eminent Figure associated module and the catalog record.

5. How many screens does the Artist/Maker/Eminent Figure associated module have?

The Artist/Maker/Eminent Figure associated module consists of 4 screens:

- Main Information
- Extended Information
- Images
- Multimedia

6. What are the Images and Multimedia tabs used for in the Artist/Maker/Eminent Figure associated module?

The Images tab allows you to attach multiple images to the Artist/Maker/Eminent Figure record. The Multimedia tab allows you to attach other media files such as video and sound clips, documents, spreadsheets, PDF files, etc.

Refer to Appendix G in this manual for information on Imaging and Multimedia.

7. How do I add to or change information on an existing Artist/Maker/Eminent Figure record?

From the Artist/Maker/Eminent Figure screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key
The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

To modify a record in the Artist/Maker/Eminent Figure associated module through the catalog record:

- Go to the Artist/Maker, Creator, or Eminent Figure field on the catalog record screen.
- Press F12 to expand the field.
- Right-click in the Artist field and choose Browse Authority Table or press Ctrl-F5 to open the table.
- Select the entry you wish to modify and click Edit. The Artist/Maker/Eminent Figure record will open in a separate window.
- Modify and save the record.

*Edits to the Name field are not recommended. Changes to this field require the same change in all linked records. You can use a global search and replace to find and make the same change in the linked records.*

8. *What reports can I print from the Artist/Maker/Eminent Figure associated module?*

There are no reports related to the Artist/Maker/Eminent Figure associated module.

B. *Adding an Artist/Maker/Eminent Figure Record*

1. *How do I add an Artist/Maker/Eminent Figure record?*

From the Artist/Maker/Eminent Figure screen:

- click on the add icon on the button bar, or
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
- press the F9 key

A new window will open and you will see “Add Mode” in the lower right corner. You can then add and save a record.

To add a record in the Artist/Maker/Eminent Figure associated module through the catalog record:

- Go to the Artist/Maker, Creator, or Eminent Figure field on the catalog record screen.
- Press F12 to expand the field.
- Right-click in the Artist field and choose Browse Authority Table or press Ctrl-F5 to open the table.
• Click Add. A blank Artist/Maker/Eminent Figure record will open in a separate window.

• Add and save the record.

2. How do I move through the record?

**Within the Field**
Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

**Field to Field**
Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

**Page to Page**
Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. How do I cancel a record?

To cancel the record without saving the data:

• click the Cancel link on the bottom right of the screen, *or*

• click the Cancel button ✗ on the button bar, *or*

• go to File on the menu bar and select ✗ Cancel

4. How do I save a record?

To save the entire record:

• click the Save and Close link at the bottom right of the screen, *or*

• click the Save and Close icon on the button bar, *or*

• go to File on the menu bar and select Save and Close

**Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and
5. How do I delete an Artist/Maker/Eminent Figure record?

From the Artist/Maker/Eminent Figure screen:

- Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.
- Choose Delete This Record
- Click Yes when the program asks if you are sure you want to delete the record.

To delete a record in the Artist/Maker/Eminent Figure associated module through the catalog record:

- Go to the Artist/Maker, Creator, or Eminent Figure field on the catalog record screen.
- Press F12 to expand the field.
- Right-click in the Artist field and choose Browse Authority Table or press Ctrl-F5 to open the table.
- From the Artist/Maker/Eminent Figure list, click Delete.
- The program will ask if you are sure; click Yes to delete the record.

6. How do I complete the data fields on the Main Information screen?

Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

**Name**

Straight entry field that links to the Artist/Maker, Creator and Eminent Figure fields on the catalog record. **To save a record, you must complete this field.**

Enter the full name, last name first, of the author, artist, or maker of an object or archive. Enter the full name, last name first, of an eminent figure who can be directly associated with the object or specimen through use or possession.

Example: Russell, James Robert
          Ford Motor Co.
          Roosevelt, Franklin Delano

**Note:** The entries in this field appear in the table for the Artist/Maker, Creator and Eminent Figure fields on the catalog record. This field serves as the link between the Artist/Maker/Eminent Figure associated module and the catalog record.

Artists and makers include artists, authors, photographers, craftspeople, and factories. Eminent figures may be of international or national importance, or of local significance to your site. They may be presidents, natural history collectors, archeologists, or unit employees. To maintain consistent entries, develop lists of artist/makers and eminent figures related to the collection.

**Title**

Memo field (F12 to expand).
Enter the title of the individual.

Example: Dr.
Rev.
Professor

**Type**

Memo field (F12 to expand).

Enter the type of name.

Example: Personal
Corporate
Pen Name

**Birth Year**

Straight entry field.

Enter the year of death for the author, artist, eminent figure, or maker. Use a four-digit year.

Example: 1956

**Death Year**

Straight entry field.

Enter the year of death for the author, artist, eminent figure, or maker. Use a four-digit year.

Example: 1826

**Productive Years**

Straight entry field.

Enter the span of years in which the author, artist, eminent figure, or maker was producing work.

Example: 1934-1976

**Dates**

Straight entry field.

Enter the life span of an individual or the dates of operation for a company. The program will complete this field for individuals if you complete the Birth Year and Death Year fields.

Example: 01/10/1926-12/15/1983

**Nationality**

(Memo field (F12).

Enter the nationality of the author, artist, eminent figure, or maker.

Example: South African
Irish

**Notes**

Memo field (F12 to expand).

Enter any notes or comments about the individual or company.

**Accomplishments**

(Memo field (F12 to expand).
Enter the accomplishments of the individual or company, particularly works for which they are well-known.

Example: a summary of Carl Sandburg’s writings, including Abraham Lincoln: The War Years, which received the 1940 Pulitzer Prize for history

the patents and inventions produced by Thomas Edison and his company

the achievements of Abraham Lincoln, including the “Gettysburg Address” and the Emancipation Proclamation

**Headings**

Memo field (F12 to expand).

Enter subject headings for the types of materials the individual or company produced. Enter subject headings for the types of work or accomplishments of eminent figures.

Example: drama

landscape painting

phonograph records

Social Security

archeology

7. **How do I complete the fields on the Extended Information screen?**

To access the fields on the extended information screen, single-click on the Extended Information tab or press Ctrl-N until the tab is selected.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.

**User 1—User 5**

These are user-defined fields for artist/maker/eminent figure records. Use these fields to enter unit-specific data that do not fit on the Main Information screen.

Users with appropriate security rights may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate...
8. **How do I add the Artist/Maker/Eminent Figure entry to the catalog record?**

To add the Artist/Maker/Eminent Figure entry to the catalog record:

- Access the Artist/Maker/Eminent Figure associated module through the catalog record (see Section B.1).

- Complete the Artist/Maker/Eminent Figure Information screen and save the record; the program returns you to the Artist/Maker/Eminent Figure table.

- Highlight the entry on the Artist/Maker/Eminent Figure table, and click **Select**.

- Click **Save and Close** or **Save** to return to the main screen.
XII. NAMES AND ADDRESSES ASSOCIATED MODULE

A. Overview

1. When do I use the Names and Addresses associated module?

Use the Names and Addresses associated module to document and track the Names and Addresses of:

- individuals associated with the collection, such as identifiers, collectors, conservators, and donors
- organizations/institutions associated with the collection, such as borrowers, lenders, and exhibit design companies
- individuals seeking access to the collection, such as researchers.

There are several fields throughout the program that link to the Names and Addresses associated module. The person icon indicates a field that links to this module. Many of these fields are stacked authority fields. When you press F12 to expand the field, you will see the person icon in the expanded field. The single entry authority fields show the icon on the main screen without expanding.

Many of the forms access the Names and Addresses associated module. Refer to Chapter 5, Reports and Forms. You can also print several visitor/researcher forms from this module. See Section C.

2. Must I use the Names and Addresses associated module?

Yes. You must use this module to enter names in the user-built authority table for the fields that link to the module. These fields appear in the catalog record, other associated modules, and the supplemental records. To insert names in the table, you must make an entry in the Name ID field in the Names and Addresses associated module.

You can access the Names and Addresses associated module through the linking field on the catalog record. You do not have to exit the catalog record to make entries in the module.

You must also use this module to enter address information that prints on many of the forms.

Using this module to register and track researchers is optional but strongly recommended. It allows you to track the objects and archival materials a researcher viewed, the researcher's interests, and requests for duplication.

3. How do I get to the Names and Addresses associated module?

To go to the Names and Addresses associated module records:

- from the Home Page, select your Cultural Resources, Natural History or Archives module directory by double-clicking, then double-click Names and Addresses, or
- from the Navigation Pane, expand the Cultural Resources, Natural History or Archives module directory tree and select Names and Addresses, or
- from your Cultural Resources, Natural History or Archives module directory, go to View on the menu bar, select Go To at the bottom, then choose Names and Addresses
4. **How can I view the Names and Addresses record from a catalog record?**

You can also access the Names and Addresses associated module through your catalog records.

In any of the fields that link to the module, press F12 to expand the field. Click the link icon next to the name and the Names and Addresses record will open in a separate window. Click the X to close the window.

The Name ID field is the link between the Names and Addresses associated module and the catalog record. See Section A.6 below for a list of the linking fields.

5. **How many screens does the Names and Addresses associated module have?**

The Names and Addresses associated module consists of 4 screens:

- Contact Information
- Extended Information
- Images
- Multimedia

6. **What are the Images and Multimedia tabs used for in the Names and Addresses associated module?**

The Images tab allows you to attach photographs of individuals or institutions to the record. The Multimedia tab allows you to attach other media files associated with the person or institution such as video and sound clips, documents, spreadsheets, PDF files, etc. Refer to Appendix G in this manual for information on Imaging and Multimedia.

7. **What fields link to the Names and Addresses associated module?**

<table>
<thead>
<tr>
<th>Location</th>
<th>Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>CR Catalog Record</td>
<td>Identified By Collector (Archeology Discipline Screen)</td>
</tr>
<tr>
<td>NH Catalog Record</td>
<td>Scientific Name</td>
</tr>
<tr>
<td></td>
<td>- Species Authority (Bio and Paleo)</td>
</tr>
<tr>
<td></td>
<td>- Subspecies Authority (Biology)</td>
</tr>
<tr>
<td></td>
<td>- Variety Authority (Biology)</td>
</tr>
<tr>
<td></td>
<td>- Forma Authority (Biology)</td>
</tr>
<tr>
<td></td>
<td>Collector</td>
</tr>
<tr>
<td></td>
<td>Identified By</td>
</tr>
</tbody>
</table>
8. **How do I add to or change information on an existing Names and Addresses record?**

From the Names and Addresses screen:

- click on the modify icon on the button bar, or
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, or
- press the F10 key

The record will open in a new window and you will see “Modify Mode” in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

To modify a record in the Names and Addresses associated module from a linking field:

- Go to the linking field.
- Press F12 to expand the field (if necessary).
- Right-click in the field and choose Browse Authority Table or press Ctrl-F5 or click Edit Authority Table in expanded stacked fields to open the table.
- Select the entry you wish to modify and click Edit. The Names and Addresses record will open in a separate window.
- Modify the record and click Save and Close.
Edits to the Name ID field are not recommended. Changes to this field require the same change in all linked records. You can use a global search and replace to find and make the same change in the linked records.

9. Can the Natural History and Cultural Resources directories share the Names and Addresses table?

Yes. You can set up file sharing for the Names and Addresses associated module. This allows the Natural History and Cultural Resources directories to share the same Names and Addresses table. Refer to Chapter 9, Section VII.B for information on setting up file sharing.

B. Adding a Name and Address Record

1. How do I add a Name and Address record?

From the Names and Addresses screen:

- click on the add icon on the button bar, or
- go to Edit on the menu bar and choose Add New Record from the pull-down menu, or
- press the F9 key

A new window will open and you will see “Add Mode” in the lower right corner. You can then add and save a record.

To add a record in the Names and Addresses associated module through the linking field:

- Go to the linking field.
- Press F12 to expand the field (if necessary).
- Right-click in the field and choose Browse Authority Table, or press Ctrl-F5, or click Edit Authority Table to open the table.
- Click Add. A blank Names and Addresses record will open in a separate window.
- Add and save the record.
2. **How do I move through the record?**

**Within the Field**
Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

**Field to Field**
Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

**Page to Page**
Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.

3. **How do I cancel a record?**

To cancel the record without saving the data:
- click the Cancel link on the bottom right of the screen, *or*
- click the Cancel button ✗ on the button bar, *or*
- go to File on the menu bar and select ✗ Cancel

4. **How do I save a record?**

To save the entire record:
- click the Save and Close link at the bottom right of the screen, *or*
- click the Save and Close icon 📝 on the button bar, *or*
- go to File on the menu bar and select 📝 Save and Close

5. **How do I delete a Names and Addresses record?**

From the Names and Addresses screen:
- Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.
- Choose Delete This Record.
- Click Yes when the program asks if you are sure you want to delete the record.

To delete a record in the Names and Addresses associated module through the linking field:
- Go to the linking field.
- Press F12 to expand the field (if necessary).
- Right-click in the linking field and choose Browse Authority Table, or press Ctrl-F5, or click Edit Authority Table in the expanded field to open the table.
- From the Names and Addresses list, click Delete.
- The program will ask if you are sure; click Yes to delete the record.
6. **How do I complete the data fields on the Contact Information screen?**

   Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record.

   **Name ID**

   Straight entry field that links to the user-built authority table for names. See Section A.6 above for a list of fields that use the authority table for names. **To save a record, you must complete this field.**

   Enter the name of the individual or institution. Enter personal names with last name first.

   Example: BIRCH, ROLAND
   JUSTIN RIGHT INSTITUTION

   **Note:** The entries in this field appear in the table for the fields linked to the Names and Addresses associate module. Make entries in all caps.

   You must complete a Names and Addresses record for the unit. The program uses the unit entry to complete various forms. Enter NPS UNIT or UNIT for other bureaus in all caps in the Name ID field for the unit entry.

   Refer to Chapter 5 for information on how to enter the NPS UNIT or UNIT record.

   **Prefix**

   Straight entry field.

   Enter a prefix for personal names, if applicable.

   Example: Dr.
   Rev.

   **First**

   Straight entry field. This field maps to the Researcher Registration Forms, the DOI Visitor Log, the DOI Archival Use Record, and the BOR Contact Information forms.

   Enter the first name of the individual. For the NPS UNIT or UNIT entry, enter the first name of the superintendent or unit manager. For institutions, enter the first name of the responsible official or contact person.

   **Last**

   Straight entry field. This field maps to the Researcher Registration Forms, the DOI Visitor Log, the DOI Archival Use Record, and the BOR Contact Information forms.

   Enter the last name of the individual. For the NPS UNIT or UNIT entry, enter the last name of the superintendent or unit manager. For institutions, enter the last name of the responsible official or contact person.

   **Title**

   Straight entry field.

   Enter the title of the individual, if applicable. For the NPS UNIT or UNIT entry, enter "Superintendent" or the appropriate title. For institutions, enter the title of the responsible official or contact person.

   Example: Director
**Division/Unit**

Straight entry field. This field maps to the Researcher Registration Forms, the DOI Visitor Log, and the DOI Archival Use Record.

Enter the name of a division or unit within an institution. For researchers, also include the name of the institution. For the NPS UNIT or UNIT entry, enter the name of the unit.

Example: Division of Costume

**Phone**

Straight entry field. This field maps to the Researcher Registration Forms, the DOI Archival Use Record, and the BOR Contact Information forms.

Enter the phone number of the individual/institution. This may be the phone number for the contact person at the institution. Include the area code.

**Note:** Phone also maps to many other forms.

**Fax**

Straight entry field. This field maps to the Researcher Registration Forms.

Enter the fax number of the individual/institution. This may be the fax number for the contact person at the institution. Include the area code.

**Note:** Fax also maps to many other forms.

**Email**

Straight entry field. This field maps to the Researcher Registration Forms and the BOR Contact Information forms.

Enter the electronic mail address of the individual or institution.

Example: Preservation@nthp.org

**Primary Address**

Use these address fields for the primary address of the individual or institution.

**Address 1**

Straight entry field. This field maps to the Researcher Registration Forms, DOI Visitor Log, and the BOR Contact Information forms.

Enter the first line of the individual’s or institution's address.

**Note:** Address lines 1 and 2 also map to many other forms.

**Address 2**

Straight entry field. This field maps to the Researcher Registration Forms, and the BOR Contact Information forms.

Enter the second line of the individual’s or institution's address.

**Note:** Address lines 1 and 2 also map to many other forms.

**Address 3**

Straight entry field.

Enter the third line of the individual’s or institution's address.
Address 4

Straight entry field.

Enter the fourth line of the individual’s or institution's address.

City/State/Zip
(City/St/Zip)

Straight entry and numeric fields. These fields map to the Researcher Registration Forms, DOI Visitor Log, and the BOR Contact Information forms.

Enter the city or town, the two-character US Postal code, and the zip code of the individual’s or institution's address. The zip code is a numeric field.

Note: City/State/Zip also maps to many other forms.

7. What is the Log Address link?

Use the Log Address link to keep a history of the previous addresses of an individual or institution if they move. To use this feature, you must be in Add, Modify or Copy Mode.

Before changing the existing address of an individual or institution, click Log Address. The primary address currently displayed in the Address 1-4, City/State/Zip, and Phone fields will be copied to the Old Address field on the Extended Information screen along with the current date. The Prefix, First, Last and Title information will be combined into the Name subfield of the Old Address field. After logging the original address, make any changes to the primary address, phone or other fields. Click Save and Close to save the record.

Alternate Address

Use the alternate address if the individual or institution has a second address, such as a shipping address.

Alternate Address 1
(Alt Address 1)

Straight entry field.

Enter the first line of the individual’s or institution's alternate address.

Alternate Address 2
(Alt Address 2)

Straight entry field.

Enter the second line of the individual’s or institution's alternate address.

Alternate Address 3
(Alt Address 3)

Straight entry field.

Enter the third line of the individual’s or institution's alternate address.

Alternate Address 4
(Alt Address 4)

Straight entry field.

Enter the fourth line of the individual’s or institution's alternate address.

Alternate City/State/Zip
(Alt City/St/Zip)

Straight entry and numeric fields.

Enter the city or town, the two-character US Postal code, and the zip code of the individual’s or institution's alternate address. The zip code is a numeric field.
Comments

Enter comments about the individual or institution. Use this field to explain the individual’s or institution's relationship to the collection.

Example: Borrower of objects in loan L.1998.5.

Type

User-built table (F5, Ctrl-F5).

Enter the type of individual or institution.

Example: Borrower
Collector
Conservator
Donor
Identifier
Lender
Researcher

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

Status

User-built table (F5, Ctrl-F5).

Use this field to enter the status of the entry. For example, enter "Pending" for entries involving transactions waiting on signatures or approval, such as gifts, deaccessions, and loans. Remember to update the status as needed.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.
NPS or DOI

Bureau controlled table (F5). You may not add to, delete, or modify terms in this table. This field maps to the Researcher Registration Forms and the DOI Archival Use Record.

For NPS directories, enter "NPS" if the individual/institution is part of the NPS. Enter "Non-NPS" if the individual/institution is not part of the NPS.

For DOI directories, enter “DOI” if the individual/institution is part of the DOI. Enter "Non-DOI" if the individual/institution is not part of the DOI.

As you type, the term will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

User 1 – User 2

User-built tables (F5, Ctrl-F5).

These fields are user-defined tables. You may modify the field label as desired. Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

8. How do I complete the fields on the Extended Information screen?

To access the fields on the extended information screen, single-click on the Extended Information tab or press Ctrl-N until the tab is selected.

Use this screen to document research access and use of the collection.
**This Access**

Formatted memo field. Press F12 or click the formatted memo icon to expand the field. The field will also expand as you begin to type. The field expands into four subfields: Date, Objects Viewed, Items Copied, and Supervised By. An underline separates the subfield entries on the screen.

Use the subfields to record information about the most recent request from the individual/institution to view or copy collection material.

**Note:** To save a researcher’s access history, highlight and copy the information in This Access field to Access History before entering new information in This Access.

**Date (date field):**

This field maps to the Researcher Registration Forms and the DOI Visitor Log.

Enter the date that the individual viewed or requested copies of material in the collection. Enter a two-digit month, a two-digit day, and the full year.

Example: 02/09/2013

**Objects Viewed (memo field):**

This field maps to the Researcher Registration Forms and DOI Visitor Log.

Enter the accession and/or catalog numbers and names of the objects or archival materials that the individual viewed or studied.

Example: WASO 9 letter
         WASO 54 - 15 pottery sherds
         WASO 33 Calcite crystal

**Items Copied (memo field):**

Enter information about requests for photographs or copies of material in the collection. Include the accession and/or catalog numbers and names of objects or archival collections.

Example: WASO 9 letter
         WASO 18 painting (photographed)
Supervised By (user-built table):

Enter the name of the staff person who supervised the individual during access to the collection.

Access History

Memo field (F12 to expand).

This field maps to the DOI Archival Use Record.

Use this field to record the history of an individual's access to the collection.

Note: You should highlight and copy the information in This Access field to this field before entering new information in This Access.

Interests

Memo field (F12 to expand).

This field maps to the DOI Visitor Log and the DOI Archival Use Record.

Enter information about the interests of the individual accessing the collection.

Example: Books and maps about Civil War battles
Vertebrate Ichnofossils

Old Address

Repeating formatted memo. Press F12 to expand or click the repeating formatted memo icon. The field expands into eight subfields. This field is used by the program to keep a history of previous addresses logged using the Log Address feature. See Section B.7 above.

When Log Address is clicked on the Primary Address section, the current information in the Address 1-4, City/State/Zip and Phone fields is copied to the corresponding subfields in the Old Address field along with the current date. The Prefix, First, Last and Title information are combined into the Name subfield of the Old Address field. You may also enter previous addresses manually if desired.

To manually add an entry, click either Insert or Append and complete the information for each subfield. All subfields are straight entry. Click Delete to remove line entries from the list. Click Save and Close when complete.

User 3

This is a user-defined field for Names and Addresses records. Use this field to enter unit-specific data that does not fit in the other fields of the record.

Users with appropriate security rights may modify the field label, field type, and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change.
C. Printing Access and Use Forms

1. What forms can I print from the Names and Addresses associated module?

You can print the following forms from the Names and Addresses associated module:

- BOR Collection Use Record
- BOR Collection Use Record Continuation
- BOR Contact Information for Accountable Officers
- BOR Contact Information for Custodial Officers
- BOR Duplication Form
- BOR Researcher Registration Form
- BOR Visitor Log†
- BOR Visitor Log Conditions†
- Copyright and privacy notice*
- DI-3220 Notice of Potential Hazard in Museum Collections.docx
- DOI Archival Use Record
- DOI Archival Use Record Continuation
- DOI Researcher Registration Form
- DOI Visitor Log†
- DOI Visitor Log Conditions†
- Duplication Form*
- Mailing Label
- Researcher Registration Form*
- Visitor Log Conditions.docx†
- Visitor Log.docx†

* These three forms are part of the MH-II, Appendix D: Archival and Manuscript Collections.

† The visitor forms are part of MH-I, Appendix G: Museum Collections Protection, or MPH-I, Appendix I: Protection of Museum Property.

For additional information, refer to Chapter 5, Reports and Forms.

2. How do I print the forms from the Names and Addresses associated module?

To print any of the forms:

- Go to the name and address record in the Record Pane.
- Click on the Proficio Reports icon on the button bar, or go to Record on the menu bar and choose Reports → Proficio Reports → Proficio Reports.
- Select the report name.
- Click Run for Current Record Only.

Note: The program will complete some sections of the forms or allow you to print blank forms.
3. **How do I print the Duplication Form?**

   To print the Duplication Form, in the Proficio Reports window, select the form appropriate for your unit:

   **BOR Duplication Form**
   **Duplication Form**

   **Note:** The program will print a blank form. This form is not mapped to fields in the Names and Addresses associated module.

4. **How do I print the Researcher Registration Form?**

   To print the Researcher Registration Form, in the Proficio Reports window, select the form appropriate for your unit:

   **BOR Researcher Registration Form**
   **DOI Researcher Registration Form**
   **Researcher Registration Form**

   The program will complete the Name, Date, Institutional Affiliation, Status, and Work Address sections on the form. You must manually complete the rest of the form.

   **Note:** For the forms to print correctly, you must enter data in the fields in the Names and Addresses associated module that are mapped to the forms. The manual and on-line help will tell you which fields map to the researcher registration form.

5. **How do I print the Copyright and Privacy Notice?**

   To print the Copyright and Privacy Notice, in the Proficio Reports window, select
Copyright Notice

Note: The program will print the notice. This form is not mapped to fields in the Names and Addresses associated module. The researcher must sign and date the form.

6. How do I print the Notice of Potential Hazard in Museum Collections?

To print the notice of potential hazard in museum collections, in the Proficio Reports window, select:

DI-3220 Notice of Potential Hazard in Museum Collections.docx

This form acknowledges receipt of information on potentially toxic substances in museum collections. It is completed manually. When you click Run for Current Record Only, the form will open in a separate Microsoft Word window. Print the form as you would any other Word document.

7. How do I print the Collection or Archival Use Record?

To print the Collection or Archival Use record, in the Proficio Reports window, select the form appropriate for your unit:

BOR Collection Use Record
DOI Archival Use Record

The program will complete the Name, Institutional Affiliation and Office Address, Phone, Research Topic or Subject or Inquiry, and Search Record sections.

If additional space is needed for Search Record information, also print:

BOR Collection Use Record Continuation
DOI Archival Use Record Continuation

The continuation page is not mapped to any fields. You will have to complete this form manually.

8. How do I print the Visitor Log?

To print the Visitor Log, in the Proficio Reports window, select the form appropriate for your unit:

BOR Visitor Log
DOI Visitor Log
Visitor Log.docx

The program will complete the fields in the BOR Visitor Log and DOI Visitor Log. For the form to print correctly, you must enter data in the fields in the Names and Addresses associated module that are mapped to the forms. The manual and on-line help will tell you which fields map to the DOI Visitor Log.

The Visitor Log.docx is a Word document. When you click Run for Current Record Only, the visitor log will open in a separate Microsoft Word window. Print the form as you would any other Word document.

9. How do I print the Visitor Log Conditions?

To print the Visitor Log Conditions, in the Proficio Reports window, select the form appropriate for your unit:

BOR Visitor Log Conditions
DOI Visitor Log Conditions
Visitor Log Conditions.docx
10. How do I print BOR contact information forms?

To print the BOR contact information forms for Accountable Officers or Custodial Officers, in the Proficio Reports window, select:

- **BOR Contact Info for Accountable Officers**
- **BOR Contact Info for Custodial Officers**

The program completes all sections of the forms.

11. Can I print mailing labels from the Names and Addresses associated module?

Yes. To print mailing labels, in the Proficio Reports window, select:

**MAILING LABEL**

You can print one record or a group of records by highlighting multiple records in the list pane, or activating a tag set or filter. The program will print the name ID, prefix, first name, last name, address lines 1 and 2 and the city, state and zip. It will print in 3 columns with a label size of 1” H x 2.5” W.
### XIII. NAGPRA ASSOCIATED MODULE

#### A. Overview

1. **What is the NAGPRA associated module?**
   
The NAGPRA associated module generates the data and reports necessary to comply with the Native American Graves Protection and Repatriation Act (NAGPRA).

   NAGPRA mandates that all Bureau sites review Native American and Native Hawaiian collections, develop inventories of human remains and associated funerary objects (called Inventory Items), develop summaries of collections that may contain unassociated funerary objects, sacred objects and objects of cultural patrimony (called Summary Items), and repatriate those human remains and items to culturally affiliated tribes as requested. The Bureau sites must also maintain a complete record of NAGPRA-related activities and actions. The Bureau has been complying with NAGPRA since the law was enacted in 1990 and NAGPRA compliance activities are ongoing.

   Previously the NAGPRA-related data was not consistently maintained service-wide. The data existed at some units in a DOS-based NAGPRA associated module that used ANCS data. Other units created Microsoft Access databases for NAGPRA information. The ICMS NAGPRA associated module is a tool that will help create an accurate record of all NPS and Bureau NAGPRA compliance activities related to NAGPRA inventory items and will allow consistent and accurate responses to NAGPRA inquiries.

2. **When do I use the NAGPRA associated module?**
   
   Use the NAGPRA associated module to document inventory data on human remains and associated funerary objects.

   **Note:** This module is available for Cultural Resources (CR) records only. Use the NAGPRA associated module only for items that appear in the unit’s NAGPRA Inventory of Human Remains and Associated Funerary Objects. **DO NOT USE** this module for unassociated funerary objects, sacred objects, and objects of cultural patrimony.

3. **Will running the NAGPRA associated module change any of my catalog or accession data?**
   
   No. Running the NAGPRA associated module doesn’t change ICMS catalog or accession data. The NAGPRA associated module extracts information from existing records, but doesn’t modify them. You cannot change your records from the NAGPRA associated module.

4. **Do I need special security rights to run the NAGPRA associated module?**
   
   No. You do not need special security rights to run the NAGPRA associated module. Access can be restricted using the “Advanced Module Permissions” within User Security setup from the Tools menu.

5. **Can I run the NAGPRA associated module for more than one unit?**
   
   Yes. You can run the module for multiple units as long as all of the ICMS catalog and accession data are in the same cultural resources directory.

6. **Must I create a NAGPRA associated module record?**
   
   You must create a NAGPRA associated module record for the catalog records of:
   
   - culturally unidentifiable human remains and associated funerary objects that you update
   - culturally affiliated human remains and associated funerary objects that you update
7. **How do I get to the NAGPRA associated module?**

To go to the NAGPRA associated module records:

- from the Home Page, select your Cultural Resources directory by double-clicking, then double-click NAGPRA, *or*
- from the Navigation Pane, expand the Cultural Resources directory tree and select NAGPRA, *or*
- from your Cultural Resources directory, go to View on the menu bar, select Go To at the bottom, then choose NAGPRA

8. **How many screens does a NAGPRA record have?**

The NAGPRA associated module consists of 3 screens:

- Main Information
- Extended Information
- Supplemental Information

9. **What is the Supplemental Information tab?**

The Supplemental Information tab allows you to attach objects to the NAGPRA record, and add information on the Administrative actions required and the Evidence references.

10. **How do I add to or change information on an existing NAGPRA record?**

From the NAGPRA screen:

- click on the modify icon on the button bar, *or*
- go to Edit on the menu bar and choose Modify This Record from the pull-down menu, *or*
- press the F10 key

The record will open in a new window and you will see Modify Mode in the lower right corner. You can then modify and save the record. Click Save and Close at the bottom right or press the F2 key to save the changes.

**Note:** You should not modify the Context ID.
11. **Can I view the deaccession records related to the NAGPRA record?**

Yes. To view the deaccession records associated with the objects and human remains in the current NAGPRA record, click the Deaccessions link just below the Synopsis field. If there is more than one deaccession record associated, the system will display a list for you to choose from. Highlight a deaccession in the list, and click View Selected Record to view the full deaccession record. When done, close the Deaccession record by clicking the X on the window to return to the NAGPRA associated module.

**B. Adding a NAGPRA Record**

1. **How do I add a NAGPRA record?**

   From the NAGPRA record screen:
   
   - click on the add icon on the button bar, *or*
   - go to Edit on the menu bar and choose Add New Record from the pull-down menu, *or*
   - press the F9 key

   A new window will open and you will see Add Mode in the lower right corner. You can then add and save a record.

2. **How do I move through the record?**

   **Within the Field**
   Press the Home key to get to the beginning of a field or the beginning of a line of text in a memo field. Press the End key to get to the end of the text in a field or the end of a line of text in a memo field.

   **Field to Field**
   Press the Tab key to go from field to field. Shift-Tab will take you back one field. You can also move the mouse pointer to the field and single click.

   **Page to Page**
   Click on the page tab or press Ctrl-N (next) or Ctrl-R (previous) to move from page to page.
3. **How do I cancel a record?**  
   To cancel the record without saving the data:
   - click the **Cancel** link on the bottom right of the screen, *or*
   - click the Cancel button on the button bar, *or*
   - go to File on the menu bar and select **Cancel**

4. **How do I save a record?**  
   To save the entire record:
   - click the **Save and Close** link at the bottom right of the screen, *or*
   - click the Save and Close icon on the button bar, *or*
   - go to File on the menu bar and select **Save and Close**
   **Note:** You can also use the Save option instead of Save and Close. Save leaves the record window open in View mode after saving while Save and Close closes the record window after saving.

5. **How do I delete a record?**  
   From the NAGPRA screen:
   - Go to Edit on the menu bar and choose Delete Record(s) from the pull-down menu.
   - Choose Delete This Record.
   - Click Yes when the program asks if you are sure you want to delete the record.

6. **How do I complete the data fields on the Main Information screen?**  
   Follow the field-by-field instructions for completing the fields on the screen. The instructions for each field are on the left side of the screen as you add or modify a record. Remember to press Tab to move out of a field.

   **Context ID**  
   Straight entry field.
   
   The first component of the Context ID Number defaults to NAGPRA. Next, enter the unit acronym and the previously assigned ID # from the unit’s NAGPRA Inventory of Human Remains and Associated Funerary Objects. If this is a new entry, enter the next number in the unit sequence.

   Example: NAGPRA.BAND.190  
             NAGPRA.BIA.022

   **Unit**  
   System generated.
   
   The system enters the full name for the unit. The program automatically supplies this information from a separate database that the Bureau maintains. You cannot edit this field.

   **Context Synopsis**  
   (Synopsis)
   Memo field (F12 to expand).
   
   Enter a written description of the unique grouping of human remains and associated funerary objects. Groupings are usually made on the basis of a combination of similar burial dates and/or burial locations.
**HR/AFO Association By**

User-built, stacked authority table (F5, Ctrl-F5, F12) that links to the Names and Addresses associated module.

Enter the name of the person, last name first, who made the decision associating the funerary objects with human remains.

Example: Jones, Sarah

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

**HR/AFO Date**

Date field.

Enter the numeric month, day, and full year when the association between human remains and funerary objects was made. As you type, the date will autofill. To select a date from a calendar, click the calendar icon.

Example: 4/30/1998

**Affiliated Tribes**

Bureau-controlled stacked authority table (F5, F12). You may not add to, delete, or modify terms in this table.

Enter the name(s) of the federally recognized tribe(s) that is affiliated with this set of human remains and associated funerary objects.

Example: Pueblo of Jemez, New Mexico

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table, or press F12 for an expanded field that allows you to enter terms from the table.

You can make multiple entries from the expanded field (F12). After entering the first term, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another term from the table. When saved, a double dash -- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.
**Affiliation Summary**

(Aff Summary)

Formatted memo. Press F12 to expand or click the formatted memo icon. The field will also expand as you start to type. The field expands into four subfields: Date, Name, Comments, Notes.

Enter the date and the name of the person who compiled the evidence and the summary of evidence used to determine affiliation.

**Date (date field)**

Enter the 2 digit month, day and full year.

**Name (straight entry)**

Enter the person’s name.

**Comments (memo field)**

Enter any comments.

**Notes (memo field)**

Enter any additional notes.

**Recommended By**

(Recommend By)

Repeating formatted memo (F12 to expand) or click the repeating formatted memo icon. The field will also expand as you begin to type. The field expands into three subfields: Title, Name, and Date. You can add multiple occurrences of each set of subfields.

**Title (user-built authority table) (F5, Ctrl-F5)**

Enter the titles of people who recommended final determination.

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table.

Users with the appropriate security rights can add, delete, or modify terms in the table. To add an entry to the table, right-click in the field and select Browse Authority Table or press Ctrl-F5, then click Add Term. After entering the term, click Save Change, then click Select to enter the term in the field.

Press Ctrl-Delete to remove unwanted entries.

**Name (simple text)**

Enter the names of people who recommended final determination.

**Date (simple text)**

Enter the dates of final determination recommendations.

To enter multiple rows in the repeating formatted memo, click Insert or Append. Insert will place a new row above the currently selected row. Append will add a new row to the bottom. To delete a selected row, click Delete. Click Save and Close when finished. Subfields are separated on the screen by an underline (___). Table entries are separated by double bars (||).
*Decision Date*

Date field.

Enter the numeric month, day, and full year when the superintendent or unit manager decided to either affiliate human remains and associated funerary objects or determine that they are culturally unidentifiable. As you type, the date will autofill or you can click the calendar icon to select a date.

Example: 4/30/1998

*Superintendent Name (Supt. Name)*

User-built stacked table (F5, Ctrl-F5, F12) that connects to the Names and Addresses associated module.

For NPS, enter the name of the Superintendent, last name first, who approved the affiliation decision.

Example: Jones, Sarah

As you type, the word will complete from an authority table of names in the Names and Addresses associated module. Press the F5 key or click the person icon to view and select names from the table, or press F12 for an expanded field that allows you to enter terms from the table.

Users with the appropriate security rights can add, delete, or modify names in the table. To add a name to the table, right click in the field, and select Browse Authority Table or press Ctrl-F5, then click Add. The Names and Addresses associated module screen will appear. Enter the name in the Name ID field and complete the other fields on the screen. You can also press F12, click on the Edit Authority Table link, and then click Add. The entry you add will appear in the table. You can then select it from the table.

You can make multiple entries from the expanded field (F12). After entering the first name, click the Add link or press the down arrow on the keyboard. An additional field appears below the first entry for you to select another name from the table. When saved, a double dash --- separates entries.

Click Delete or press Ctrl-Delete to remove unwanted entries.

**Note:** The record link icon next to the person icon allows you to view the Names and Addresses record for your entry.

*7. How do I complete the data fields on the Extended Information screen?*

To access the fields on the extended information screen, click on the Extended Information tab or press Ctrl-N to go to the next screen.
User 1 – User 5

These are user-defined fields for NAGPRA. Use these fields to enter unit-specific NAGPRA information that does not fit on the Main Information screen.

Users with appropriate security rights may modify the field label, field type and field help by right-clicking in the field and choosing Properties from the right-click menu. The field information record will open in a separate window. Click the modify icon on the button bar or from the Edit menu select Modify This Record or press F10. Click on the Default Label/Help tab and change the Label, Field Type and User Help as desired. Click Save and Close when finished. Click the refresh button on the Button bar to see the label change.

Refer to Chapter 1, System Basics, for additional information on defining user fields and a description of field types.

8. How do I access the Supplemental Information tab?

To access the supplemental information tab, click on the Supplemental Information tab or press Ctrl-N to go to the next page.

Note: You must save the NAGPRA record before you can add supplemental information.
9. **How do I complete the fields for the Administrative Action supplemental?**

To Add an Administrative Action supplemental, highlight the supplemental on the left and click **Add** on the right. A new window will open showing three fields for the supplemental.

**Action**

Bureau-controlled authority table (F5).

Locked Authority Table.

Choose from the list of legally proscribed NAGPRA actions that take place during the process of NAGPRA Compliance.

Example: DECISION TO REPATRIATE
FEDERAL REGISTER NOTICE
NONE
REPATRIATED

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table. Press Ctrl-Delete to remove unwanted entries.

**Action Date**

Date field.

Enter the date of the action. The date will autofill as you type. To select a specific date, click the calendar icon.

**Action Name**

Straight entry field.

Enter the name of the person who took the administrative action.

10. **How do I complete the fields for the Evidence supplemental?**

To Add an Evidence supplemental, highlight the supplemental on the left and click **Add** on the right. A new window will open showing three fields for the supplemental.

**Evidence Source**

**Evidence Type**

**Description**

Enter the details of the evidence related to the administrative action.
**Evidence Source**

Bureau-controlled authority table (F5).

Enter the source of evidence for the affiliation determination.

Example: CONSULTATION
FIELD NOTES
MAPS
OTHER
PHOTOGRAPHS
PUBLICATION
REPORT
TESTING

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table. Press Ctrl-Delete to remove unwanted entries.

**Evidence Type**

Bureau-controlled authority table (F5).

Enter the type of evidence used to determine affiliation.

Example: ANTHROPOLOGICAL
ARCHEOLOGICAL
BIOLOGICAL
FOLKORE
GEOGRAPHICAL
HISTORICAL
KINSHIP
LINGUISTIC
ORAL TRADITION
OTHER/EXPERT OPINION

As you type, the word will complete from an authority table of acceptable terms. Press the F5 key or click the down arrow icon to view and select terms from the table. Press Ctrl-Delete to remove unwanted entries.

**Description**

Memo field.

Enter a description of the affiliation evidence; examples include publication citations, report titles, dates and locations of consultations, etc.

11. **How do I complete the fields for the Objects supplemental?**

To Add an Objects supplemental, highlight the supplemental on the left and click Add on the right. A new window will open showing six fields for the supplemental.

**Note:** The first record you add in the Objects supplemental should be the catalog record for the human remains. You should only use the Add option for adding human remains records to the list. See B.12 below for instructions on associating objects with the human remains.
### Human Remains Number (HR Cat Nbr)

**If...**
- you are associating objects with a catalog record for human remains,
- you are entering a catalog record for human remains

**Then...**
- this field will display the catalog number for the human remains.
- this field will remain blank.

**Note:** You cannot edit this field.

### Catalog Number (Catalog Nbr)

Authority table that links to the Catalog records. Press F5 or click the catalog record icon to view the list of catalog records.

**Note:** The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data in the list. **The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.**

### Object

System generated. Automatically completes from information in the Object field of the catalog record. You cannot edit this field.

### State Site #

System generated. Automatically completes from the information in the State Site # field of the catalog record. You cannot edit this field.

### Site Name

System generated. Automatically completes from the information in the Site Name field of the catalog record. You cannot edit this field.
Within Site

System generated.

Automatically completes from the information in the Within Site field of the catalog record. You cannot edit this field.

12. How do I associate an object with a human remains catalog record?

Human remains catalog records can be associated with other objects found in the same burial. To associate an object with a human remains record, follow these steps:

- First add a human remains record to the Objects supplemental.

- Then, highlight the human remains record in the list and click Associate Object above the list.

    You can only associate objects with a catalog record that has ‘HUMAN REMAINS’ as the object name.

- The HR Cat Nbr field will automatically complete with the catalog number for the human remains you selected. Next, enter the catalog number of the object you wish to associate with these human remains. Press F5 or click the catalog record icon to view the list of catalog records. When you tab out of the catalog number field, the remaining fields in the supplemental will complete as described above.

Note: The list in the Term Selector shows only 50 records at a time. To select more records click Advanced Options and select a higher number of records up to 500 to view. By typing the catalog number in the Search field, you will be taken to that section of your data in the list. The catalog number must be typed with the correct number of spaces between the acronym and number to locate the record.

- Click Save and Close when complete. The new catalog record you selected is now associated with that human remains record.
C. Printing NAGPRA Inventory Reports

1. What reports can I print from the NAGPRA associated module?

   Two reports are available:
   - NAGPRA Inventory Report
   - NAGPRA Items Report

   Use these reports to document NAGPRA inventory updates. The program completes all sections of the reports.

2. How do I print the reports?

   To print a report:
   - Select the NAGPRA record for which you want to print.
   - There are two buttons just below the button bar for the reports: NAGPRA Items Report and NAGPRA Inventory Report. Click the button for the report you want to run.
   - A message will ask if you want to run the report on all visible records. Click Yes if you want to run it on all visible records, otherwise click No and the report will run on the current record only.
   - The report preview window will open. Click the print or print direct button on the button bar or select Print from the File menu to send the report to the printer.

   **NAGPRA Inventory Report**
   This report is based on the original report from 1995 for the Inventory of Human Remains and Associated Funerary Objects.

   The Inventory report contains the Context information, the Accession Background information, the list of Affiliated Tribes, and the list of catalog records.

   Use this report when generating updated inventories for submission to the National NAGPRA Lead and the Park NAGPRA Program Lead, IMR Office of Indian Affairs & American Culture, Denver, CO.

   **NAGPRA Items Report**
   This report has the same information as the Inventory of Human Remains and Associated Funerary Objects with the addition of the Evidence Source, Evidence Type and Evidence Description.
D. Submitting Updated Inventories

1. Do I have to print an inventory?

Yes. Print a copy of the updated inventory to be submitted to the National NAGPRA Lead and the Park NAGPRA Program Lead, IMR Office of Indian Affairs & American Culture, Denver, CO. Also print a copy to be maintained in the unit’s museum NAGPRA files.

2. Do I have to submit the inventory electronically?

Yes, for the NPS.

3. How do I create an electronic copy of the inventory for submission?

To create an electronic file of the NAGPRA Inventory and Items reports:

- Select the NAGPRA record that you want to print a report.

- Click the button just below the button bar for the report you want to run: NAGPRA Items Report or NAGPRA Inventory Report.

- A message will ask if you want to run the report on all visible records. Click Yes if you want to run it on all visible records, otherwise click No and the report will run on the current record only.

- In the report Preview window that opens, click the Export Document button on the button bar or select Export Document from the File menu.

- Select a location in the “Save in” box on the Save As window to save the report. Then, change the file name to include your unit acronym. For example, SAPU-NAGPRAInventoryReport.

- In the Save As Type box, select Rich Text Document (.rtf). Then click Save. The report will be saved in the place you selected.

- You can open the file in Microsoft Word as you would any other Word document.
